Thank you for purchasing a Panasonic Voice Processing System. Please read this manual carefully before using this product and save this manual for future use.

KX-TVA50/KX-TVA200: Version 3.0 (Main Software Version 3.00 or later)
Introduction

About this Manual
This Programming Manual is designed to serve as an overall reference for programming the Panasonic Voice Processing System using KX-TVA Maintenance Console. It explains how to use KX-TVA Maintenance Console, and obtain the most out of system administration. This manual is divided into the following sections:

Section 1 Programming Instructions
Describes how to install, start, and operate KX-TVA Maintenance Console.

Section 2 KX-TVA Maintenance Console Operating Instructions
Describes in detail each parameter that can be programmed using KX-TVA Maintenance Console.

Index
An alphabetical listing of features and terms, as well as the page numbers of related sections.

About the Other Manuals

Installation Manual
The Voice Processing System Installation Manual provides instructions for installing the VPS hardware, configuring the connected PBX for use with the VPS, and getting started with the KX-TVA Maintenance Console software. Relevant sections from the Installation Manual are listed throughout this manual for your reference.

Feature Manual
The Voice Processing System Feature Manual is an overall reference describing VPS features. It explains what the VPS can do, and how to obtain the most of its many features. Sections from the Feature Manual are listed throughout this manual for your reference.

Manager's Manual
The Voice Processing System Manager's Manual describes the programming and maintenance features available to the System Manager and Message Manager. Relevant sections from the Manager's Manual are listed throughout this manual for your reference.

Subscriber's Manual
The Voice Processing System Subscriber's Manual describes how subscribers can access commonly used VPS features and functions with their extensions and mailboxes. Relevant sections from the Subscriber's Manual are listed throughout this manual for your reference.

Glossary
The Voice Processing System Glossary is an alphabetical listing of features, terms, and abbreviations, as well as their definitions.

Note
- This manual may refer to products not available in your country/area.
- For KX-TD500, KX-TDE series, KX-TDA series, and KX-TAW series PBXs, the term "trunk (CO line)" used in this manual indicates a trunk (CO line) group.
Trademarks

- Microsoft, Windows, and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.
- All other trademarks identified herein are the property of their respective owners.
- Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.
# Table of Contents

1 Programming Instructions ................................................................. 7

1.1 Introduction to System Administration ........................................... 8
1.2 KX-TVA Maintenance Console Installation ...................................... 9
1.3 Starting KX-TVA Maintenance Console ........................................... 11
1.4 File ............................................................................................. 15
   1.4.1 File—New .............................................................................. 15
   1.4.2 File—Open ............................................................................ 15
   1.4.3 File—Close ........................................................................... 15
   1.4.4 File—Save ............................................................................ 16
   1.4.5 File—Save As ....................................................................... 16
   1.4.6 File—Exit ............................................................................ 16
1.5 Connect ....................................................................................... 17
   1.5.1 Connect—Connection Profile .................................................. 17
   1.5.2 Connect—LAN (TCP/IP) (Optional for KX-TVA50) .................... 17
   1.5.3 Connect—USB ....................................................................... 17
   1.5.4 Connect—Dial-up (Modem) (Optional) ...................................... 17
   1.5.5 Connect—Disconnect ............................................................. 18
1.6 Edit ............................................................................................. 19
   1.6.1 Edit—Undo ........................................................................... 19
   1.6.2 Edit—Cut ............................................................................. 19
   1.6.3 Edit—Copy .......................................................................... 19
   1.6.4 Edit—Paste .......................................................................... 19
   1.6.5 Edit—Select All .................................................................... 19
   1.6.6 Edit—Delete ......................................................................... 20
1.7 View ............................................................................................ 21
   1.7.1 View—Toolbar ...................................................................... 21
   1.7.2 View—Status Bar .................................................................. 21
   1.7.3 View—Shortcut Bar ............................................................... 21
   1.7.4 View—Utility Bar .................................................................. 21
   1.7.5 View—Menu Bar .................................................................. 21
1.8 Go To .......................................................................................... 23
   1.8.1 Go To—Mailbox Settings ....................................................... 23
   1.8.2 Go To—Class Of Service ....................................................... 23
   1.8.3 Go To—PORT/TRUNK Service ............................................ 23
   1.8.4 Go To—Service Settings ....................................................... 23
   1.8.5 Go To—System Parameters .................................................. 23
   1.8.6 Go To—H/W Settings ........................................................... 24
   1.8.7 Go To—Reports .................................................................... 24
   1.8.8 Go To—System Security ....................................................... 24
1.9 Utility ......................................................................................... 25
   1.9.1 Utility—Quick Setup .............................................................. 25
   1.9.2 Utility—System Back Up ....................................................... 26
   1.9.3 Utility—System Prompts Customization .................................. 28
   1.9.4 Utility—Port Status .............................................................. 30
   1.9.5 Utility—System Trace ........................................................... 30
   1.9.6 Utility—System Maintenance ................................................. 31
   1.9.7 Utility—System Initialize/Restart ......................................... 32
   1.9.8 Utility—Diagnostic ............................................................... 33
   1.9.9 Utility—Programmer Code .................................................... 33
   1.9.10 Utility—Screen Customize .................................................. 33
   1.9.11 Utility—Commands .............................................................. 34
   1.9.11.1 Changing the Mailbox No. Length Mode ............................ 34
# 2 KX-TVA Maintenance Console Operating Instructions

## 2.1 Mailbox Settings
- Mailbox Settings Screen ................................................. 42
- Default Mailbox Template .............................................. 45
- Mailbox Parameters ......................................................... 46
- Notification Parameters .................................................. 54
- Notification Schedule ..................................................... 56
- Device Notification Timer ............................................... 59
- External Message Delivery ............................................. 62
- Auto Forwarding ......................................................... 64
- Personal Distribution List ............................................. 66
- List No. 1–List No. 4 .................................................... 66
- Personal Custom Service ............................................. 68
- Remote Call FWD To CO .............................................. 71
- Automatic Login ......................................................... 73
- E-mail Option .............................................................. 76

## 2.2 Class of Service
- Class of Service .......................................................... 80
- Personal Options .......................................................... 85

## 2.3 PORT/TRUNK Service
- Service Group ............................................................. 92
- Call Service ............................................................... 94

## 2.4 Service Settings
- Caller ID/DID/PIN Call Routing ..................................... 97
- Caller ID No./DID No./PIN No. ..................................... 100
- Holiday Settings .......................................................... 102
- Holiday Service No. ..................................................... 103
- Parameters ............................................................... 107
- Automated Attendant ................................................... 107
- Operator Service No. 1, 2, and 3 ................................ 109
- Rotary Telephone Service .......................................... 113
- Name Entry ............................................................... 114
- Toll Saver ................................................................. 115
- Custom Service .......................................................... 117
- Custom Service Builder ............................................ 117
- Menu & Transfer ....................................................... 123
- Date Control .............................................................. 127
- Time Control .............................................................. 128
- Day Control ............................................................... 129
- Password ................................................................. 130

## 2.5 System Parameters
- Mailbox Group ............................................................ 133
- Extension Group .......................................................... 137
- System Caller Name Announcement ............................. 140
- Parameters ................................................................. 143
- Time Setting ............................................................... 144
- Prompt Setting ............................................................ 147
- Language 1–5 (KX-TVA200), 1–3 (KX-TVA50) ............ 148
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5.4.4 System Guidance</td>
<td>149</td>
</tr>
<tr>
<td>2.5.4.5 PBX Parameters</td>
<td>151</td>
</tr>
<tr>
<td>2.5.4.6 Dialling Parameters</td>
<td>161</td>
</tr>
<tr>
<td>2.5.4.7 Message Waiting Notification</td>
<td>163</td>
</tr>
<tr>
<td>2.5.4.8 External Message Delivery</td>
<td>166</td>
</tr>
<tr>
<td>2.5.4.9 Intercom Paging Parameters</td>
<td>169</td>
</tr>
<tr>
<td>2.5.4.10 Fax Management</td>
<td>172</td>
</tr>
<tr>
<td>2.5.4.11 Disconnect Parameters</td>
<td>175</td>
</tr>
<tr>
<td>2.5.4.12 Transfer to Outside</td>
<td>176</td>
</tr>
<tr>
<td>2.5.4.13 Long Distance Call</td>
<td>182</td>
</tr>
<tr>
<td>2.5.4.14 VM Menu</td>
<td>183</td>
</tr>
<tr>
<td>2.5.4.15 E-mail Integration</td>
<td>184</td>
</tr>
<tr>
<td>2.5.4.16 Advanced Settings</td>
<td>186</td>
</tr>
<tr>
<td>2.6 Hardware (H/W) Settings</td>
<td>189</td>
</tr>
<tr>
<td>2.7 Reports</td>
<td>192</td>
</tr>
<tr>
<td>2.7.1 Mailbox Information Report</td>
<td>193</td>
</tr>
<tr>
<td>2.7.2 Call Account Report</td>
<td>196</td>
</tr>
<tr>
<td>2.7.3 Port Usage Report</td>
<td>197</td>
</tr>
<tr>
<td>2.7.4 HDD Usage Report</td>
<td>198</td>
</tr>
<tr>
<td>2.7.5 Mailbox Usage Report</td>
<td>199</td>
</tr>
<tr>
<td>2.7.6 Fax Call Report</td>
<td>200</td>
</tr>
<tr>
<td>2.7.7 Call Handling Statistics Report</td>
<td>201</td>
</tr>
<tr>
<td>2.7.8 Custom Service Report</td>
<td>202</td>
</tr>
<tr>
<td>2.7.9 Message Status Report</td>
<td>203</td>
</tr>
<tr>
<td>2.7.10 Subscriber Setup Report</td>
<td>204</td>
</tr>
<tr>
<td>2.7.11 Security Information Report</td>
<td>205</td>
</tr>
<tr>
<td>2.7.12 Hourly Statistics Report</td>
<td>206</td>
</tr>
<tr>
<td>2.7.13 E-mail Report</td>
<td>207</td>
</tr>
<tr>
<td>2.8 System Security</td>
<td>208</td>
</tr>
<tr>
<td>2.8.1 Administrator</td>
<td>208</td>
</tr>
<tr>
<td>2.8.2 Subscriber</td>
<td>211</td>
</tr>
<tr>
<td>2.8.2.1 Default Password</td>
<td>212</td>
</tr>
<tr>
<td>Index</td>
<td>213</td>
</tr>
</tbody>
</table>
Section 1

Programming Instructions

This section describes how to install, start, and operate KX-TVA Maintenance Console.
1.1 Introduction to System Administration

VPS programming can be performed by the System Administrator, System Manager, and Message Manager. The type of programming performed by each is very different. While the System Manager and Message Manager can use their telephones to program the PBX, the System Administrator must use KX-TVA Maintenance Console and a PC.

VPS programming performed by the System Administrator is referred to as "system administration".

- System administration involves creating or changing VPS settings that control the manner in which VPS performs, and is usually done before any other programming. (The system manager can program some of these parameters with a telephone.)

- System administration can be performed by only one person at a time: a second person attempting to program the VPS will be denied access to system administration.
1.2 KX-TVA Maintenance Console Installation

System programming, diagnosis, and data upload/download can be performed with a PC using the KX-TVA Maintenance Console software.

System Requirements

Required Operating System

Minimum Hardware Requirements for Windows 2000, Windows XP
CPU: 1.2 GHz Intel® Pentium® microprocessor
HDD: 150 MB of available hard disk space
RAM: 256 MB of available RAM

Minimum Hardware Requirements for Windows Vista
CPU: 1.8 GHz Intel Pentium microprocessor
HDD: 150 MB of available hard disk space
RAM: 1 GB of available RAM

Minimum Hardware Requirements for Windows 7 (32-bit)
CPU: 1.8 GHz or faster 32-bit (x86) processor
HDD: 150 MB of available hard disk space
RAM: 1 GB of available RAM

Minimum Hardware Requirements for Windows 7 (64-bit)
CPU: 1.8 GHz or faster 64-bit (x64) processor
HDD: 150 MB of available hard disk space
RAM: 2 GB of available RAM

Password Security

To maintain system security, a password is required to perform system programming. We recommend changing the default password the first time you access the VPS via KX-TVA Maintenance Console. The default password can be changed by running the Quick Setup utility (see 1.9.1 Utility—Quick Setup) or by selecting System Security→Administrator→Password.

Warning to the Administrator regarding the system password
1. To avoid unauthorized access to VPS settings, which could result in fraudulent dialing, do not disclose the password.
2. Please inform the customer of the importance of the password and the possible dangers if it becomes known to others.
3. Please change the password periodically.
4. To prevent unauthorized access, we strongly recommend selecting a long and random password.
5. If the system password is forgotten, you have to reset the VPS to its factory defaults and reprogram it.

Note
• A Programmer Code, if set, is required to start KX-TVA Maintenance Console. You can set or delete the Programmer Code by selecting Utility→Programmer Code. If no code is set, the KX-TVA Maintenance Console can be started and used, but a password is required to connect to the VPS and change VPS settings.
1.2 KX-TVA Maintenance Console Installation

Installing KX-TVA Maintenance Console

1. Copy the KX-TVA Maintenance Console setup file to a local drive on the PC. (Its icon is shown here, on the left.)
2. Double-click the setup file to run the installer.
3. Follow the on-screen instructions provided by the installation wizard.
4. Click Yes when prompted to copy the USB drivers, specify a location, then click OK.
5. Click OK after the drivers have been copied to the local drive.
6. Click Finish.

Note

- To install or uninstall the software on a PC running Windows 2000 Professional or Windows XP Professional, you must be logged in as a user that is in either the "Administrators" or "Power Users" group.
- To install or uninstall the software on a PC running Windows Vista Business or Windows 7 Professional, you must be logged in as a user in the "Administrators" group.
- When the VPS is first connected to the PC via USB, a wizard should appear and ask you to select the appropriate USB driver. Browse for and select the KX-TVA USB driver, which is copied to the local drive during installation.
1.3 Starting KX-TVA Maintenance Console

The instructions listed below explain how to start KX-TVA Maintenance Console. These instructions are for when connecting to the VPS via USB.

**Note**

• The screenshots shown here are for reference only, and may differ from the screens displayed on your PC.

1. Click the **KX-TVA Maintenance Console** shortcut icon.

2. Select the appropriate VPS model and click **OK**.

3. The Enter Programmer Code dialog box is displayed. Enter the installer level programmer code (default: INSTALLER) and click **OK**.

**Note**

• A programmer code is required to use the KX-TVA Maintenance Console. The System Administrator can change the programmer codes (see 1.9.9 Utility—Programmer Code).

4. The Set Default Parameters window is displayed the first time you start KX-TVA Maintenance Console. Select the TVA Type, PBX Type, and Integration Mode. Change the default parameters listed in the window if necessary, then click **OK**.
5. The main window is displayed.

6. Click **Connect → USB** from the menu bar, or click **Connect** on the toolbar, select **USB** in the **Connection Mode** dialog box and click **Next**.

   **Note**
   - To connect to the VPS via USB, the KX-TVA USB driver must be installed on the PC, as explained in 1.2  KX-TVA Maintenance Console Installation.

7. Enter the installer level password (default: 1234), then click **Next**.

   **Note**
   - The installer level password (also called the administrator password) is required to access the VPS for programming. The System Administrator can change the password (see "Password" in 2.8.1  Administrator).

8. Click **Finish** when the message **Connected!** is displayed.
9. You may now begin programming the VPS. To choose the area you would like to begin programming, click the desired icon in the Shortcuts menu.

**Note**
- To connect to the VPS via LAN, first connect to the VPS via USB and set the appropriate LAN settings (see 1.9.13 Utility—LAN Settings).
- To connect to the VPS via modem, see 1.5.4 Connect—Dial-up (Modem) (Optional).
- If programming the VPS for the first time, the Quick Setup utility can help you program essential settings quickly and easily. See 1.9.1 Utility—Quick Setup for more information.
- KX-TVA Maintenance Console supports versions 1.0 and 1.1 of the KX-TVA50 and KX-TVA200. The software performs according to the version number of the connected VPS.
- Software features, design, and system requirements are subject to change.
- When connecting the KX-TVA50 with a PC running Windows 7 via USB, if the PC enters Sleep or Hybrid Sleep, the KX-TVA Maintenance Console may not be able to connect to the KX-TVA50 after it wakes from Sleep or Hybrid Sleep. If this occurs, exit the KX-TVA Maintenance Console, and then disconnect and reconnect the USB cable.

### Programmer Levels and Passwords

There are two levels of access to the KX-TVA Maintenance Console: Installer and User. Each level has a programmer code, which is required to start KX-TVA Maintenance Console, and a password, which is required to access the VPS using KX-TVA Maintenance Console.

The Installer level provides access to all VPS programming parameters and should only be used by the System Administrator.

<table>
<thead>
<tr>
<th>Level</th>
<th>Default Programmer Code</th>
<th>Default Password</th>
<th>Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installer</td>
<td>INSTALLER(^1)</td>
<td>1234(^2)</td>
<td>No restrictions</td>
</tr>
<tr>
<td>User</td>
<td>USER(^1)</td>
<td>1234(^3)</td>
<td>Access to screens and parameters can be restricted(^3)</td>
</tr>
</tbody>
</table>

\(^1\) See 1.9.9 Utility—Programmer Code to change the programmer codes.

\(^2\) See 2.8.1 Administrator to change the Installer level password.

\(^3\) See 1.9.10 Utility—Screen Customize to change the User level password and restrict User level access.
Program Mode

KX-TVA Maintenance Console has three programming modes: Initial, Batch, and Interactive. The current mode is displayed in the lower-left corner of the screen.

Initial Mode
When KX-TVA Maintenance Console is started, it enters Initial mode. From here, you can choose to enter Batch mode or Interactive mode to program the VPS.

Batch Mode
Batch mode allows you to create new system data files and make modifications to system data files saved on your PC without being connected to the VPS. Later, when you connect to the VPS, the system data stored in the PC can be uploaded to the VPS.
To enter Batch mode, select an option from the File menu (see 1.4 File).

Interactive Mode
Interactive mode allows you to directly modify the system data and settings saved in the VPS's memory from a PC that is connected to the VPS. This mode displays the system data that is currently being used by the VPS. Data can be modified and results displayed in real time.
To enter Interactive mode, select an option from the Connect menu (see 1.5 Connect).

Standard Buttons
There are several standard buttons that are displayed on many screens within KX-TVA Maintenance Console.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Accepts the settings that were made in the current screen and closes the screen.</td>
</tr>
<tr>
<td>Apply</td>
<td>Accepts the settings that were made in the current screen and leaves the screen open.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Ignores any changes made in the current screen and returns to the previous screen.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the relevant help topic for the current screen.</td>
</tr>
</tbody>
</table>
1.4 File

The File menu allows you to create, open or save a data file. If "New" or "Open..." are selected, KX-TVA Maintenance Console automatically enters Batch mode.

1.4.1 File—New

Creates a new system data file, and puts KX-TVA Maintenance Console in Batch mode. All settings are in their initial or default state. To upload the file created here to the VPS, see 1.9.2 Utility—System Back Up.

Note

• Since selecting this option creates a new system data file, uploading this new file to the VPS as is will overwrite any settings that are saved in the VPS's memory. Use with care.

To create a new system data file

From the File menu, select New.

1.4.2 File—Open...

Opens a system data file saved on the PC, and puts KX-TVA Maintenance Console in Batch mode.

When opening a file created with an older version of KX-TVA Maintenance Console (such as version 1.0), you will be asked whether you want to convert the data for use with the current version or not. Using the data without converting may result in certain data being loaded to an incorrect destination, and is not recommended. System data files for unsupported VPS models cannot be opened. Only files saved with KX-TVA Maintenance Console can be opened.

To upload the file modified here to the VPS, see 1.9.2 Utility—System Back Up.

To open a system data file

1. From the File menu, select Open....
   The Open dialog box will be displayed.
2. Navigate to the folder containing the system data file you want to open.
3. Select the file.
4. Click Open.
   If the file was created with an older version of KX-TVA Maintenance Console, you will be asked if you want to convert the data.
   a. Click Convert to convert the data for use with the current version of KX-TVA Maintenance Console.
      Enter a name for the new converted system data file.
   b. Click Start Version 1.x to open the file without converting it (not recommended).

1.4.3 File—Close

Closes currently opened system data files, and enters Initial mode. This menu is only available when using the KX-TVA Maintenance Console in Batch mode.
1.4.6 File—Exit

To enter Initial mode

- From the File menu, select Close.
  - If the system data file being modified has not been saved, a warning message will be displayed, giving you the option to save the file.
  - a. Click Yes to save the file and close system data files to enter Initial mode.
  - b. Click No to discard the changes and close system data files to enter Initial mode.

1.4.4 File—Save

Overwrites the previously saved system data file with the system data currently being modified.
To upload a file to the VPS that was saved here, see 1.9.2 Utility—System Back Up.

To save a system data file

- From the File menu, select Save.
  - If the data has never been saved, the Save dialog box will be displayed. For more details, see 1.4.5 File—Save As....

1.4.5 File—Save As...

Saves the system data file being modified with the name chosen by the user.
To upload a file saved here to the VPS, see 1.9.2 Utility—System Back Up.

To save a system data file with a new name

1. From the File menu, select Save As....
2. Navigate to the folder in which you want to save the file.
3. Enter a file name, or select a file to overwrite.
4. Click Save.
   - If choosing to overwrite another file, a warning message will be displayed.
   - a. Click Yes to overwrite.
   - b. Click No to return to the previous screen.

1.4.6 File—Exit

Closes KX-TVA Maintenance Console.

To exit KX-TVA Maintenance Console

- From the File menu, select Exit.
  - If the system data file being modified has not been saved, a warning message will be displayed, giving you the option to save the file.
  - a. Click Yes to save the file and exit KX-TVA Maintenance Console.
  - b. Click No to discard the changes and exit KX-TVA Maintenance Console.
1.5 Connect

The Connect menu allows you to directly program the VPS in Interactive mode. When connecting, you are required to enter the administrator password that corresponds to the programmer code you entered when starting KX-TVA Maintenance Console.

1.5.1 Connect—Connection Profile

If you have saved a Connection Profile (see 1.9.15 Utility—Profile Setup), you can connect to the VPS using the settings saved in the profile.

To connect using a Connection Profile
1. From the Connect menu, select Connection Profile.
2. Select the desired profile from the pull-down menu.
3. Enter the password required to connect to the VPS if it was not stored in the Connection Profile.
4. Click Next.

1.5.2 Connect—LAN (TCP/IP) (Optional for KX-TVA50)

Connects to the VPS through the LAN port of the VPS.

Note
- Before you connect to the VPS via LAN, you must first assign an IP address to the VPS. See 1.9.13 Utility—LAN Settings to assign an IP address.

To connect using a LAN
1. From the Connect menu, select LAN (TCP/IP).
2. Enter the IP address, port number, and password used to connect to the VPS.
3. Click Next, and Finish when the connection is completed.

1.5.3 Connect—USB

Connects to the VPS through the USB port on the VPS.

To connect using USB
1. From the Connect menu, select USB.
2. Enter the password used to connect to the VPS.
3. Click Next, and Finish when the connection is completed.

1.5.4 Connect—Dial-up (Modem) (Optional)

Connects to the VPS through the optional modem.
Note

- To access the VPS remotely using this feature, a KX-TVA296 Modem Card must be installed. For more details, see "2.7.5 Modem Card (KX-TVA296)" in the Installation Manual.

The following settings must be entered to match the settings of the modem and/or PC.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone No.</td>
<td>–</td>
<td>Enter the telephone number to dial into the VPS.</td>
</tr>
<tr>
<td>Port No.</td>
<td>–</td>
<td>Enter the port number used to connect to the VPS.</td>
</tr>
<tr>
<td>Password</td>
<td>–</td>
<td>Enter the password used to connect to the VPS.</td>
</tr>
</tbody>
</table>

**To connect using a modem**

1. From the Connect menu, select Dial-up (Modem).
2. Enter the administrator password and the settings as required.
3. Click Next, and Finish when the connection is completed.

**1.5.5 Connect—Disconnect**

Closes the connection between KX-TVA Maintenance Console and the VPS.

**To disconnect**

1. From the Connect menu, select Disconnect.
2. Click Yes.
1.6 Edit
The Edit menu allows you to easily edit data in KX-TVA Maintenance Console.

1.6.1 Edit—Undo
Returns the last changed setting to its previous value.

To undo
From the Edit menu, select Undo.

1.6.2 Edit—Cut
Cuts the selection and places it in the clipboard.

To cut
1. Select an area of text.
2. From the Edit menu, select Cut.

1.6.3 Edit—Copy
Copies the selection and places it in the clipboard.

To copy
1. Select an area of text.
2. From the Edit menu, select Copy.

1.6.4 Edit—Paste
Inserts the contents of the clipboard.

To paste
1. Place the cursor in the desired location.
2. From the Edit menu, select Paste.

1.6.5 Edit—Select All
Selects the entire document.

To select all
From the Edit menu, select Select All.
1.6.6 Edit—Delete

Deletes selected items.

To delete

1. Select an item to be highlighted.
2. From the Edit menu, select Delete.
1.7 View

The View menu allows you to hide/show the Toolbar, Status Bar, Shortcut Bar, Utility Bar, and Menu Bar.

1.7.1 View—Toolbar

Selects whether the toolbar, which provides icons allowing easy access to commonly used functions, is displayed or not.

To hide/show the toolbar
From the View menu, select or deselect Toolbar.

1.7.2 View—Status Bar

Selects whether the status bar, which shows the connection status at the bottom of the windows, is displayed or not.

To hide/show the status bar
From the View menu, select or deselect Status Bar.

1.7.3 View—Shortcut Bar

Selects whether the shortcut bar, which provides icons allowing easy access to each setting window, is displayed or not.

To hide/show the shortcut bar
From the View menu, select or deselect Shortcut Bar.

1.7.4 View—Utility Bar

Selects whether the utility bar, which provides icons allowing easy access to each utility command, is displayed or not.

To hide/show the utility bar
From the View menu, select or deselect Utility Bar.

1.7.5 View—Menu Bar

Selects whether the menu bar, which provides access to a variety of menus and commands, is displayed or not.
To hide/show the menu bar

- Right-click in the toolbar, shortcut bar, or utility bar, and select or deselect Menu Bar.
1.8 Go To

The Go To menu allows easy access to each setting window of KX-TVA Maintenance Console.

1.8.1 Go To—Mailbox Settings
Opens the Mailbox Settings screen.

To go to
From the Go To menu, select Mailbox Settings and the desired screen.

1.8.2 Go To—Class Of Service
Opens the Class Of Service screen.

To go to
From the Go To menu, select Class Of Service and the desired screen.

1.8.3 Go To—PORT/TRUNK Service
Opens the PORT/TRUNK Service screen.

To go to
From the Go To menu, select PORT/TRUNK Service.

1.8.4 Go To—Service Settings
Opens the Service Settings screen.

To go to
From the Go To menu, select Service Settings and the desired screen.

1.8.5 Go To—System Parameters
Opens the System Parameters screen.

To go to
From the Go To menu, select System Parameters and the desired screen.
1.8.6 Go To—H/W Settings

Opens the hardware settings screen.

To go to
From the Go To menu, select H/W Settings.

1.8.7 Go To—Reports

Opens the Reports screen.

To go to
From the Go To menu, select Reports and the desired screen.

1.8.8 Go To—System Security

Opens the System Security screen.

To go to
From the Go To menu, select System Security.
1.9 Utility

The Utility menu provides access to the following functions and utilities:

- Quick Setup
- System Back Up
- System Prompts Customization
- Port Status
- System Trace
- System Maintenance
- System Initialize/Restart
- Diagnostic
- Programmer Code
- Screen Customize
- Commands
- Software Version
- LAN Settings
- Default Parameters
- Profile Setup

To select an item from the Utility menu, click Utility in the menu bar, then select the desired function or utility. Certain Utility menu items are also available from the Toolbar (System Back Up, Port Status, Commands, System Trace, and System Initialize/Restart).

1.9.1 Utility—Quick Setup

The Quick Setup utility allows you to set essential VPS parameters quickly and easily. It is particularly useful when connecting to the VPS for the first time or after initializing the VPS. The following settings can be programmed with the Quick Setup utility:

- System Security settings
- PBX Environment settings
- Mailbox settings
- Port/Trunk settings
- Date and Time settings

**Note**

- Set the desired parameters in each screen then click Next or Back to go to the desired screen.
- The Auto Configuration utility is available from the PBX Environment screen. Click OK to start Auto Configuration, or Cancel to skip Auto Configuration and go to the next setting screen. Auto Configuration is only available in Interactive mode and with Panasonic KX-T series PBXs using APT/DPT integration.
- In the Quick Setup-Finish window, you can change system date and time. You can click Finish to save the parameters, and "Quick Setup Completed" is displayed. Click Yes to save the settings, or No if you want to modify some settings.
1.9.2 Utility—System Back Up

The System Back Up utility can be used to backup and restore system data. The Backup History utility can be used to view a record of previous backups. The following system programming data, system parameters, and voice data can be backed up or restored as individual files.

a. Program
   – System Program
   – DSP Program
b. System Parameters
c. System Prompts
   – Installed Prompt
   – Custom Service Menu
   – Company Name
   – Company Greeting
   – System Mailbox Group Voice Label
   – System Caller Name
   – Prompt Selection
   – Hold Announce Menu
   – Extension Group Voice Label
d. Mailbox Prompts
   – Owner Name
   – Personal Greetings
   – Personal Caller ID Name
   – Interview
   – Personal Group List Name
   – EMD List Member Name
e. Mailbox Messages

Note
• Mailbox data may not be backed up if the mailbox is in use during the backup process. Additionally, VPS response time may be affected when backing up data. For these reasons, we recommend backing up data when the VPS is offline.

Follow the steps below to use the System Back Up utility:

[Creating a Backup]
1. Click Utility in the menu bar.
2. Select System Back Up and Make Backup....
   (You can click the icon in the toolbar instead of step 1 and 2.)
3. Check the desired item(s) to backup.
4. Click Click to edit... next to Mailbox Prompts.
5. Check either All Mailboxes or select the mailboxes you wish to backup.
6. Click OK.
7. Click Click to edit... next to Mailbox Messages.
8. Check either All Mailboxes or select the mailboxes you wish to backup.
9. Click the folder icon.
   The Save dialog box appears.
10. Navigate to the folder where to wish to save the system backup file.
11. Click Backup.
Note

• The system will prepare the data to be backed up, and the backup will begin about 30 seconds later. The time needed to backup the data will vary depending on the connection method, communication speed, and the amount of data that is being backed up.
• Deleted messages will not be backed up when backing up Mailbox Messages.

[Restoring from Backup Data]

1. Click Utility in the menu bar.
2. Select System Back Up and Restore the backup data....
   (You can click the icon in the toolbar instead of step 1 and 2.)
3. Check the desired item to restore.
4. Click the folder icon.
   The Open dialog box appears.
5. Navigate to the folder containing the desired backup file and select the file.
6. Click Open, then click Restore.

Note

• For KX-TVA50: The built-in flash memory must have space available to accommodate the restored data. If the backed up data is larger than the space available in the flash memory, the data cannot be restored.
• A backed up message cannot be restored to the subscriber’s mailbox if the mailbox still contains a New/Old/Deleted copy of the same message.

[Scheduled Backups]

You can schedule backups in advance. The KX-TVA Maintenance Console will automatically connect to the VPS and backup the selected data to the PC at the specified times. In order to use this feature you must first create a Connection Profile (see 1.9.15 Utility—Profile Setup). If a Connection Profile used for a scheduled backup is deleted later, the data will not be backed up and an error will appear in the Backup History window. When a scheduled backup has been set, the KX-TVA Maintenance Console icon will be displayed in the PC’s task tray. When the scheduled backup is in progress, the icon will flash.

[Creating a Scheduled Backup]

1. Click Utility in the menu bar.
2. Select System Back Up and Scheduled Backup....
3. Click Add to create a new scheduled backup.
4. Enter a description for the backup.
5. Select the profile name of the Connection Profile needed to connect to the VPS in order to make the backup. You can confirm the Connection Profile settings by clicking Details.
6. Set the frequency (daily, weekly, etc.) and time of day when the backup should take place.
7. Check the desired item(s) to backup.
8. Click Click to edit... next to Mailbox Prompts.
9. Check either All Mailboxes or select the mailboxes you wish to backup.
10. Click OK.
11. Click Click to edit... next to Mailbox Messages.
12. Check either All Mailboxes or select the mailboxes you wish to backup.
13. Click the folder icon.
   The Save dialog box appears.
14. Navigate to the folder where to wish to save the system backup file.
15. Click OK.

Note

• If multiple scheduled backups overlap (i.e., if a second backup is scheduled to begin and the first scheduled backup has not finished), the second backup will not be executed.
• If a manual backup is executed and has not finished by the time a scheduled backup is set to begin, the scheduled backup will not be executed.
• Because backup data is saved to the PC, the PC must be running at the time a scheduled backup is set to begin. If the PC is turned off or is in standby mode when a scheduled backup is set to begin, the backup will not be executed.
• If you are connected to the VPS using the KX-TVA Maintenance Console at the time a scheduled backup is set to begin, you will be prompted to disconnect the programming session. If you do not disconnect, the scheduled backup will not be executed. Likewise, if you try to connect to the VPS using the KX-TVA Maintenance Console while a scheduled backup is being executed, you will be prompted to cancel the scheduled backup.

[Editing a Scheduled Backup]
1. Click Utility in the menu bar.
2. Select System Back Up and Scheduled Backup....
3. Select the backup you wish to edit.
4. Click Edit.
5. Edit the settings as desired.
6. Click OK.

[Deleting a Scheduled Backup]
1. Click Utility in the menu bar.
2. Select System Back Up and Scheduled Backup....
3. Select the backup you wish to delete.
4. Click Delete.
5. Click Yes.
6. Click OK.

[Backup History]
1. Click Utility in the menu bar.
2. Select System Back Up and Backup History.
   (You can click the icon in the toolbar instead of step 1 and 2.)
   The following status of backup history can be checked in the Backup History dialog box:
   – Description
   – Parameters
   – Completion Status (Completed/No Data/Error)
   – Date & Time
   – Total Elapsed Time (HH:MM:SS)
3. Click Close.

1.9.3 Utility—System Prompts Customization

The System Prompts Customization screen is used to view, play, add, or delete system prompts. The System Administrator can also check the prompt number and text for these prompts. The following categories of system prompts can be customized from the System Prompts Customization screen:

a. System Guidance
b. Custom Service Menus
c. Company Greetings
d. Others
   – Company Name
   – Language Select Menu
   – Hold Announce Menu
Follow the steps to customize system prompts:
1. Click Utility in the menu bar.
2. Select System Prompts Customization.
3. Select a tab in the System Prompts Customization dialog box.

[Deleting Prompts]
The System Administrator is able to delete the specific system prompt or the installed language used for system prompts.

To delete a specific system prompt:
1. Select the desired prompt number.
2. Click Delete.
3. Click OK.

To delete an installed language for system prompts:
1. Select the desired language, Guidance No.
2. Click Delete.
3. Click OK.

[Recording System Prompts]
1. Select the desired system prompt to record, and click Play/Record.
2. Select "Record from extension" or "Import from recorded file".
   When "Record from extension" is selected
   1. Specify the extension number of the telephone used for recording, then click Connect.
   2. When the specified extension rings, go off-hook.
   3. Click (record), (stop), or (play) to record or play a system prompt.
   4. Click Disconnect.
   5. Click OK.
   When "Import from recorded file" is selected
   1. Click ...
      The Open dialog box appears.
   2. Navigate to the folder containing the WAV files you wish to import. (WAV files must meet the following specifications: IMA ADPCM codec, 8.000 kHz, 4-bit, mono.)
   3. Select the desired WAV file.
   4. Click Open to import the file.
   5. Click OK.

[Starting and Stopping System Prompt Playback]
1. Select the desired system prompts.
2. Click Play/Record.
3. Click or .

[Restoring Deleted Prompts]
If you have deleted a preinstalled prompt and want to use the prompt again, you can restore it from the included CD-ROM.
1. Select the desired prompt number.
2. Click Restore.
3. When the restore dialog is displayed, click (browse).
4. Insert the included CD-ROM when prompted.
5. Browse to the desired folder, select the desired prompt, then click Open.
6. Click OK.

1.9.4 Utility—Port Status

The System Administrator can confirm the condition of each port and turn on/off VPS Call Progression Mode.

Follow the steps below to use the Port Status utility:

1. Click Utility in the menu bar.
2. Select Port Status.
   (You can click the icon in the toolbar instead of step 1 and 2.)
   The Port Status screen includes the Port Activity List which displays each port’s status and number, as well as the current setting of Port Parameters. The screen will be updated every 2 seconds. Each port’s status will be displayed as follows:
   - "Ready": The port is ready to be used.
   - "Incoming Call": The port is handling an incoming call.
   - "Outgoing Call": processing sending service
   - "DSP Reset": processing DSP reset disposition
   - "PT Connect": processing PT connect disposition
   - "Offline": Off Line Mode
   - "No Card": Available card is not installed.

   [Turning on VPS Call Progression Mode]
   1. Select the desired port and click Open Port.
   2. Select Selected Ports to turn on the selected port, or select All Ports to turn on the all ports.

   [Turning off VPS Call Progression Mode]
   1. Select the desired port and click Close Port.
   2. Select Selected Ports to turn off the selected port, or select All Ports to turn off the all ports.
   3. Click Close.

1.9.5 Utility—System Trace

The System Administrator can monitor VPS activities and log the activities into a separate file. The following data can be logged for each port or all ports:

- DTMF/Dial: DTMF signals sent and received by the VPS.
- Guidance: guidance data that the VPS played.
- Message: the VPS activity on messages such as creating, playing and deleting.
- Process Event: events occurred between the VPS processes such as Application, Call Processor and DSP.
- Caller ID: Caller ID received from the PBX.
- Error: system errors.
- DID: DID number received from the connected PBX.
- PIN: PIN received by the VPS.

There are 2 methods for System Trace.

a. Real Time Trace: monitors the trace data of the selected port. Also, it is possible to log the monitoring data as a file.

b. Internal Trace: logs the trace data of the selected port automatically in the system.
Follow the steps below to monitor or log the system trace data.
1. Click **Utility** in the menu bar.
2. Select **System Trace**.
   (You can click the icon in the toolbar instead of step 1 and 2.)
   **Real Time Trace**
   1. Select **Real Time Trace**.
   2. Check **Enable/Disable Trace Data**.
   3. Check the data and port you wish to monitor.
   4. Click ..., navigate the folder to save the monitored data as a file.
   5. Click **Apply**.

   **Note**
   - During a Real Time Trace, the following features cannot be used:
     - Other features in the Utility menu
     - Recording features on a PC connected to the VPS (for Mailbox Group, Extension Group, System Caller Name, and Custom Service)

   **Internal Trace**
   1. Select **Internal Trace**.
   2. Select **Setting**, **Display**, or **Trace Clear**.
     - **Setting**: Disables or enables the Internal Trace feature, and specifies the data and port you wish to log.
     - **Display**: Displays the trace data.
     - **Trace Clear**: Clears saved trace data.

### 1.9.6 Utility—System Maintenance

The System Administrator can maintain the VPS using System Maintenance.
Follow the steps below for System Maintenance:
1. Click **Utility** in the menu bar.
2. Select **System Maintenance**.
3. Edit parameters in the **System Maintenance** dialog box.
4. Click **OK**.

#### System Maintenance Mode
Specifies whether to enable or disable System Maintenance Mode.

- **Default**
  - Enable

- **Value Range**
  - Disable, Enable

#### System Maintenance Start Time
Specifies the System Maintenance start time.

- **Default**
  - 01:00
Value Range
HH:MM (HH: Hour, MM: Minute)

HDD Auto Stand-by Mode
Specifies whether HDD Auto Stand-by Mode is enabled or disabled. This option is only available when the connected VPS is a KX-TVA200.

Default
Enable

Value Range
Disable, Enable

HDD Auto Stand-by Delay Time
Specifies the length of time that the VPS waits before activating HDD Auto Stand-by Mode. If the HDD is not accessed for the length of time set here, the HDD goes into standby mode. This option is only available when the connected VPS is a KX-TVA200.

Default
15 min

Value Range
0 min–21 min, 30 min/60 min

1.9.7 Utility—System Initialize/Restart

The System Initialize/Restart is used to restart the VPS. There are 2 methods as follows:

a. Initialize System: clears all voice data except the installed system guidance, and returns all system parameters to their default settings. The System Administrator has to specify the following parameters before initializing the system:
   – Mailbox No. Length
   – System Manager’s Mailbox No.
   – Message Manager’s Mailbox No.

b. Restart System: restarts the system. The VPS is not initialized.

Follow the steps below to initialize or restart the VPS:

1. Click Utility in the menu bar.
2. Select System Initialize/Restart.
   Initialize System
   1. Select Initialize System.
      (You can click the icon in the toolbar instead of step 1 and 2.)
   2. Specify the mailbox number length, the System Manager’s mailbox number, and the Message Manager’s mailbox number.

   Note
   • The mailbox numbers assigned to the System Manager and Message Manager cannot begin with "0".
3. Click OK.
   • If there are active ports, the System Administrator will be asked to either continue or to cancel.
   Select OK to continue, or Cancel to abort the operation.
4. Click OK when the VPS has been initialized.

**Restart System**

1. Select Restart System.
   (You can click the icon in the toolbar instead of step 1 and 2.)
   • If there are active ports, the System Administrator will be asked to either continue or to cancel.
   Select OK to continue, or Cancel to abort the operation.
2. Click OK when prompted to restart the VPS.

---

### 1.9.8 Utility—Diagnostic

- Codec/DSP Voice Path: diagnoses whether the voice path between Codec and DSP functions properly.
- Play/Record Voice Path: diagnoses whether the voice path in the playing/recording unit functions properly.

Follow the steps below for System Diagnostic:

1. Click Utility in the menu bar.
2. Select Diagnostic.
3. Select Codec/DSP Voice Path or Play/Record Voice Path.
   • If there are active ports, the System Administrator will be asked to either continue or to cancel.
   Select OK to continue, or Cancel to abort the operation.
   • Diagnosis starts.
4. Click OK when the diagnostic is completed.

---

### 1.9.9 Utility—Programmer Code

The System Administrator can change the programmer code that is needed to use KX-TVA Maintenance Console.

Follow the steps below to change the programmer code:

1. Click Utility in the menu bar.
2. Select Programmer Code then the desired programming level (user or installer).
3. If the programmer code is already set, enter the old programmer code in Enter old programmer Code:.
4. Enter a new programmer code in Enter new programmer Code:.
5. Enter the new programmer code again in Confirm new programmer Code:.
6. Click OK.

---

### 1.9.10 Utility—Screen Customize

You can change the user level password and select which menu items are available to users when they access the KX-TVA Maintenance Console using the user level programmer code.

1. Click Utility in the menu bar.
2. Select Screen Customize and User Level.
3. Select the desired tabs, and check the items that you want to be available to users when accessing the KX-TVA Maintenance Console using the user level programmer code.
4. Click the Password tab and change the password if necessary.
5. Click OK.
To connect to the VPS using the user level, follow the instructions in 1.2.2 Starting KX-TVA Maintenance Console, and enter the user level programmer code (default: USER) and user level password (default: 1234) instead of the installer level programmer code and password.

1.9.11 Utility—Commands

The System Administrator can send commands directly to the VPS using the Commands dialog.

Follow the steps below to open the Commands dialog:
1. Click Utility in the menu bar.
2. Select Commands.
3. Enter the desired command, then press ENTER.
4. When finished, select Close from the File menu.

Note
• Select Log... from the File menu to save the current command session in a text file for later reference.

1.9.11.1 Changing the Mailbox No. Length Mode

By default, if both 3-digit and 4-digit extension numbers are used by the PBX, the VPS will use 4-digit mailbox numbers. When creating mailbox numbers for 3-digit extensions, a “0” will be added to the end of each mailbox number. However, it is possible to program the VPS to allow mailbox numbers of mixed length by entering a special command using the Commands dialog in the KX-TVA Maintenance Console.

To change the Mailbox No. Length Mode, follow the procedure below.

1. After you have started the KX-TVA Maintenance Console and connected to the VPS, select Utility in the menu bar.
2. Select Commands.
(You can click the icon in the tool bar instead of step 1 and 2.)
3. Enter "MBXM 1" (the quotation marks are not needed), then press ENTER.
4. Once the VPS reports that the mode has been changed to "Flexible", disconnect the VPS by clicking Disconnect.
You should now run Quick Setup and Auto Configuration to configure the mailboxes (see 1.9.1 Utility—Quick Setup).

Note
• This command can only be used once. To change the Mailbox No. Length Mode from "Flexible" to "Fixed", you must initialize the VPS (see 8.1 Initializing the VPS in the Installation Manual).

1.9.11.2 Changing the Maximum Length of Mailbox Numbers

The maximum number of digits that can be used for mailbox numbers is set using the Set Default Parameters utility in the KX-TVA Maintenance Console or when you initialize the system. However, it is possible to change this setting by entering a special command using the Commands dialog in the KX-TVA Maintenance Console.

To change the maximum length of mailbox numbers, follow the procedure below.

1. After you have started the KX-TVA Maintenance Console and connected to the VPS, select Utility in the menu bar.
2. Select **Commands**.
   (You can click the icon in the tool bar instead of step 1 and 2.)
3. Enter "MAXL" (the quotation marks are not needed) and the desired value (e.g., **MAXL 8**), then press **ENTER**.
   • The maximum length of mailbox numbers can be changed to 2–8 digits.
4. Once the VPS reports that the maximum length of mailbox numbers has been changed, disconnect the VPS by clicking **Disconnect**.

**Note**

• You cannot change the maximum length of mailbox numbers to a number that is less than the length of the current mailbox numbers.
• To change the maximum length of mailbox numbers, you must first change the Mailbox No. Length Mode to "Flexible" (see 1.9.11.1 Changing the Mailbox No. Length Mode). You cannot set the maximum length of mailbox number to 6 or more digits when the Mailbox No. Length Mode is "Fixed".

### 1.9.11.3 Two-way Recording Save Mode

By default, conversations recorded using the Two-way Recording feature are saved in the subscriber’s mailbox as old messages. However, it is possible to program the VPS to save these conversations as new messages, rather than old, by entering a special command using the Commands dialog in the KX-TVA Maintenance Console.

The Two-way Recording Save Mode setting is applied to a COS; all mailboxes assigned to the same COS will have the same setting ("old" or "new"). To change the Two-way Recording Save Mode, follow the procedure below.

1. After you have started the KX-TVA Maintenance Console and connected to the VPS, select **Utility** in the menu bar.
2. Select **Commands**.
   (You can click the icon in the tool bar instead of step 1 and 2.)
3. Enter "TWRN" (the quotation marks are not needed), followed by the COS no. and "1" (e.g., **TWRN 5,1**), then press **ENTER**.
   • Enter "1" after the COS no. to save conversations as new messages, and "0" to save conversations as old messages (default).
4. Once the VPS reports that the mode has been changed, disconnect the VPS by clicking **Disconnect**.

### 1.9.12 Utility—Software Version

Software Version is used to display the version of main software and DSP software for reference.

Follow the steps below to display the software version:

1. Click **Utility** in the menu bar.
2. Select **Software Version**.
3. Click **OK**.

### 1.9.13 Utility—LAN Settings

The System Administrator can set the IP address and Port Number for the VPS. To program the VPS over LAN connection or to use E-mail Integration features, the VPS must first be connected to the LAN and programmed accordingly.
Follow the steps below for LAN Settings:

1. Click **Utility** in the menu bar.
2. Select **LAN Settings**.
3. Edit parameters in the **LAN Settings** dialog box.
4. To change the port number, click **Advanced Settings**, otherwise click **OK** to finish.
5. Enter the port number that will be used when connecting to the VPS via the KX-TVA Maintenance Console, then click **OK**.
6. Click **OK**.

**Note**
- The port number setting is used for both LAN and modem connections to the VPS.
- Consult the LAN administrator for the appropriate settings.
- The VPS must be restarted after these settings are changed in order for them to take effect.

**Automatic or manual IP address assignment**

If the VPS is connected to a network with a DHCP server, you can program the VPS to receive an IP address automatically.

**Obtain an IP address automatically**

Check this item to have the VPS obtain an IP address automatically from the local network’s DHCP server.

**Default**
Not checked

**Use the following IP address:**

Check this item if you want to assign a specific IP address, subnet mask, and default gateway to the VPS.

**Default**
Checked

**IP Address**

Specifies the IP Address for the VPS. You can program this setting only if **Use the following IP address:** is selected.

**Default**
192.168.1.11

**Subnet Mask**

Specifies the Subnet Mask for IP Address. You can program this setting only if **Use the following IP address:** is selected.

**Default**
255.255.255.0
Default Gateway

Specifies the IP Address for Default Gateway. You can program this setting only if Use the following IP address: is selected.

**Default**
192.168.1.1

**Automatic or manual DNS server assignment**

The VPS can use the default DNS server used by the network, or you can assign the VPS to use a specific DNS server.

**Obtain DNS server address automatically**

Check this item to have the VPS obtain a DNS server address automatically.

**Default**
Checked

**Use the following DNS server addresses:**

Check this item if you want the VPS to use a specific DNS server. Up to 2 servers can be assigned.

**Default**
Not checked

**Preferred DNS Server**

Specifies the Preferred DNS Server.

**Default**
None

**Alternate DNS Server**

Specifies the Alternate DNS Server.

**Default**
None

**TVA Device Port No.**

Specifies the Port No. for the VPS.

**Default**
10000

**Value Range**

1–65534
1.9.14 Utility—Default Parameters

Specifies TVA Type, Mailbox No. Length, System Manager’s Mailbox No., Message Manager’s Mailbox No., PBX Type, Integration Mode, and other parameters as the default settings.

Follow the steps below for Default Parameters:
1. Click Utility in the menu bar.
2. Select Default Parameters.
   Set Default
   1. Select "Set Default".
   2. Specify TVA Type, PBX Type, Integration Mode, and set parameters.

   Note
   • The mailbox numbers assigned to the System Manager and Message Manager cannot begin with "0".
3. Click OK.
   Load Default: Loads the parameters programmed in "Set Default" to the VPS.
   1. Select "Load Default".
   2. Click OK.

1.9.15 Utility—Profile Setup

The settings required to connect to the VPS (LAN settings, dial-up settings, etc.) can be stored as a Connection Profile, allowing you to connect to the VPS quickly. This feature is also useful if you have several customers, because you can save a Connection Profile for each customer’s VPS without having to enter connection settings manually each time.

[Creating a New Connection Profile]
1. Click Utility in the menu bar.
2. Select Profile Setup....
3. Click New.
4. Enter a name for the profile, and the password required to connect to the VPS.
   • If you do not enter a password here, you will need to enter the password manually each time you connect to the VPS using this profile.
5. Select the desired connection protocol.
6. For LAN connections, enter the IP address and port number of the VPS used for KX-TVA Maintenance Console programming sessions. For Modem connections, select the PC’s modem, the telephone number used to connect to the VPS modem, and the port number of the VPS used for KX-TVA Maintenance Console programming sessions. You may also edit the modem initialize command if necessary.
7. Click Save.

[Editing a Connection Profile]
1. Click Utility in the menu bar.
2. Select Profile Setup....
3. Select the desired profile, then click Edit.
4. Change the settings as necessary.
5. Click Save.
[Deleting a Connection Profile]

1. Click Utility in the menu bar.
2. Select Profile Setup....
3. Select the desired profile, then click Delete.
4. Click Yes.
   
   If the selected Connection Profile is used for a scheduled backup, you will be asked again to confirm your decision to delete the profile.
Section 2

KX-TVA Maintenance Console Operating Instructions

This section describes how to program the VPS using the KX-TVA Maintenance Console software.
2.1 Mailbox Settings

A maximum of 62 (KX-TVA50) or 1022 (KX-TVA200) subscriber mailboxes can be created. Although the System Manager can use a telephone to create or edit mailboxes, the System Administrator can create several mailboxes at once using KX-TVA Maintenance Console.

Mailbox parameters are divided into the following categories:

- Mailbox Parameters
- Notification Parameters
- External Message Delivery
- Auto Forwarding
- Personal Distribution List
- Personal Custom Service
- Remote Call FWD To CO
- Automatic Login
- E-mail Option

Click each tab at the bottom of the Mailbox Settings screen to specify the desired parameters.

2.1.1 Mailbox Settings Screen

This screen allows the System Administrator to visually browse and edit all mailboxes in the VPS. There are two screens for editing mailboxes; one screen allows you to view and edit a single mailbox, and the other allows you to view and edit all mailboxes.
Single Mailbox Screen

When you click **Mailbox Settings**, you can edit the parameters of the mailbox that is displayed. The lowest numbered mailbox, or the Message Manager's mailbox if there are no other mailboxes created, is displayed.

When you click **Manage All Mailboxes In The System**, or click OK in the "Mailbox" dialog box, the list of all mailboxes is displayed.

[Editing a Mailbox]

**Editing the current mailbox**

1. Edit each parameter in the "Mailbox" dialog box.
   (Click **Save As Default Mailbox** to use edited mailbox as the default mailbox settings for subsequently created mailboxes.)

2. Click OK.

**To select a different mailbox for editing**

1. Click **Manage All Mailboxes In The System**, or click OK in the "Mailbox" dialog box.
2. Select the desired mailbox, then click **Edit Mailbox**....
### List of All Mailboxes

This screen provides a list of all mailboxes. From this screen you can add new mailboxes, edit mailboxes, delete existing mailboxes, and copy mailbox settings to other mailboxes. Mailboxes can be sorted in ascending or descending order by parameter (mailbox number, first name, last name, etc.) by clicking the parameter name.

When you click **Add Mailbox**... or **Edit Mailbox**, the "Mailbox" dialog box is displayed.

#### [Adding a Mailbox]

1. **Click Add Mailbox**....
2. Edit each parameter in the "Mailbox" dialog box.
   - (Click **Save As Default Mailbox** to use added mailbox as the default mailbox settings for subsequently created mailboxes.)
3. **Click OK**.

#### [Editing a Mailbox]

1. Select the desired mailbox, then click **Edit Mailbox**..., or you can also double-click the cell on the screen to edit the specified parameter.
2. **Edit each parameter.**

#### [Deleting a Mailbox]

1. Select a mailbox you want to delete.
2. **Click Delete Mailbox.**
3. **Click Yes.**

#### [Copying a Mailbox Setting to Other Mailboxes]

1. Click the desired mailbox to copy, and press **Copy Mailbox**....
2. The **Copy Mailbox** dialog box is displayed. Check the items to copy, and select the destination mailbox number. (Ctrl/Shift Key is available to choose several mailbox numbers.)
3. **Click Copy.**
2.1.2 Default Mailbox Template

The default mailbox template is applied to new mailboxes when they are created with the Add Range... button. This allows you to create similar mailboxes easily, with one command.

Follow the steps below to edit the default mailbox.

1. Click Add Range....
2. Specify a range of mailbox (From:/To:).
   (Check "Use the same number for Mailbox and Extension" depending on your needs.)
3. Enter the number of mailboxes to create next to Number of Mailboxes:
4. Click Edit Default Mailbox....
5. Edit parameters in the Default Mailbox dialog box.

6. Click OK to return to the Add Range Of Mailboxes dialog box.
7. Click OK.

Feature Manual References
2.4.3 Default Mailbox Template
2.1.3 Mailbox Parameters

Each mailbox can be edited based upon the needs of the subscriber.

Mailbox Number

Specifies the subscriber’s mailbox number. The maximum number of digits that can be used for mailbox numbers is set by using the Set Default Parameters utility in the KX-TVA Maintenance Console or when you initialize the system. You can also change the maximum number of digits that can be used for mailbox numbers by entering a special command using the Commands dialog in the KX-TVA Maintenance Console (see 1.9.11.2 Changing the Maximum Length of Mailbox Numbers).

Note

- The mailbox number can only be set when adding a mailbox; when editing a mailbox, you cannot change the assigned mailbox number.

Default
None

Value Range
2–5 digits

Feature Manual References
2.3.16 Mailbox
### Extension

Specifies the extension number of the mailbox’s subscriber. Any valid extension number including an Extension Group number can be assigned.

**Note**

- If an Extension Group number is assigned to a mailbox, all group members are able to access the messages stored in the mailbox.

**Default**

None

**Value Range**

2–5 digits

**Feature Manual References**

2.3.16 Mailbox

### First Name

Specifies the first name of the subscriber. If there are non-alphabetical characters in the first 4 letters of the first name, the mailbox is not included in the directory.

**Default**

None

**Value Range**

Max. 20 characters (",", "^", "`" and "~" cannot be used.)

**Programming Manual References**

"Directory Listing" in 2.2.2 Personal Options

**Feature Manual References**

2.2.18 Dialing by Name

### Last Name

Specifies the last name of the subscriber. If there are non-alphabetical characters in the first 4 letters of the last name, the mailbox is not included in the directory.

**Default**

None

**Value Range**

Max. 20 characters (",", "^", "`" and "~" cannot be used.)
Password

Specifies the password needed to access the mailbox. If a default password is programmed by the System Administrator, that password will be assigned automatically when creating all mailboxes. The System Administrator can change and delete the password.

Follow the steps below to edit the password.

1. Click **Click to change password**....
2. Set the new password, or delete the current password.
   
   **To set a new password:**
   a. Enter the new password, then re-enter the password for confirmation.
   b. Click **OK**, then click **OK** to close the **Mailbox** window.

   **To delete the current password:**
   a. Click **OK** without entering a password.
   b. Click **Yes** when the warning is displayed, then click **OK** to close the **Mailbox** window.

**Note**
- Each subscriber can change his or her mailbox password.
2.1.3 Mailbox Parameters

Default
None

Value Range
Max. 16 digits

Programming Manual References
2.8.2 Subscriber

Subscriber’s Manual References
2.4 Changing Your Password

Class of Service
Determines the set of services available to the subscriber.

Note
• We recommend that parameters for each COS number be defined before assigning a Class of Service (COS) to each mailbox or creating new mailboxes.
• COS No. 63 and 64 are assigned by default to the Message Manager and to the System Manager, respectively. No other mailboxes can be assigned to COS No. 63 and 64.

Default
1

Value Range
COS No. 1–62

Programming Manual References
2.2 Class of Service

Feature Manual References
2.2.12 Class of Service (COS)

Covering Extension
Forwards calls to a second extension when the first extension’s subscriber is not available to take the call. The Covering Extension is one of the Incomplete Call Handling options that can be enabled or disabled by the subscriber. The caller can also be transferred the Covering Extension by pressing [0] while a Personal Greeting is being played, or while leaving a message.

Note
• Extension Groups or Logical Extensions (extensions whose calls are set to always be directed their mailboxes) cannot be assigned as covering extensions.

Default
None
2.1.3 Mailbox Parameters

Value Range
2–5 digits

Feature Manual References
2.2.15 Covering Extension

Subscriber’s Manual References
5.3 Assigning Your Covering Extension

Interview Mailbox
Assigns an interview mailbox to the subscriber’s mailbox. In order for it to function properly, the interview mailbox number must not be the same number as an existing mailbox and an existing mailbox group.

Note
• Each caller’s replies to an interview session are saved as one message.

Default
None

Value Range
2–5 digits

Feature Manual References
2.2.26 Interview Service

Subscriber’s Manual References
5.4 Interview Mailbox

All Calls Transfer to Mailbox
If this parameter is set to "Yes", the extension is considered to be a Logical Extension and therefore calls directed to the extension via Automated Attendant service are automatically forwarded to the extension mailbox. The extension does not ring when a call is received.

Note
• When this feature has been set to "Yes", the mailbox subscriber’s extension does not necessarily need to exist as an extension of the PBX.

Default
No

Value Range
No, Yes

Feature Manual References
2.2.3 Automated Attendant
Call Transfer Sequence

Specifies the Call Transfer Sequence used by the mailbox. Allows each mailbox to be assigned its own Call Transfer Sequence (Personal Transfer Sequence).

Note
- When "System" is selected, the VPS follows the "Extension Transfer Sequence" preprogrammed for the VPS in "System Parameters→Parameters→PBX Parameters→PBX Environment".
- This sequence has higher priority than "Alternate Extension Transfer Sequence" in 2.5.4.5 PBX Parameters.

Default
System

Value Range
System
Max. 16 characters consisting of 0–9, *, # and special codes:
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,: Dial Pause (default 1 s)
; : Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code

Programming Manual References
"Extension Transfer Sequence" in 2.5.4.5 PBX Parameters

Feature Manual References
2.3.5 Call Transfer Status

No Answer Time

Specifies the length of time that the VPS waits before handling unanswered calls to the extension.

Note
- When "System" is selected, the VPS follows the "Call Transfer No Answer Time" preprogrammed for the VPS in the "System Parameters→Parameters→Dialling Parameters".

Default
System

Value Range
System, 10 s – 60 s

Programming Manual References
"Call Transfer No Answer Time" in 2.5.4.5 PBX Parameters
2.1.3 Mailbox Parameters

Call Transfer Status

Determines how the VPS handles a call when it reaches the subscriber's extension.

Note

• This setting can be changed by subscribers.

Default

None

Value Range

None: rings the subscriber’s extension
Call blocking: handles the call according to the Incomplete Call Handling for No Answer setting for the subscriber’s extension. The subscriber’s extension will not ring.
Call screening: the caller is prompted to record his or her name. The VPS then calls the subscriber and plays back the caller name. The subscriber can choose whether to answer the call.
Intercom paging: pages the subscriber by intercom.
Calling a beeper: notifies the subscriber via a beeper.
Transfer to mailbox: transfers the caller to the mailbox.
Transfer to specified custom service menu: transfers the caller to the specified Custom Service.
Transfer to specified telephone number: transfers the caller to the specified telephone number.

Feature Manual References

2.3.5 Call Transfer Status

Subscriber’s Manual References

5.1 Call Transfer

Incomplete Call Handling for No Answer

Specifies how the VPS handles a call when there is no answer.

Note

• This setting can be changed by subscribers.
• More than one option can be selected.

Default

Leave a message/Transfer to operator/Return to top menu

Value Range

Leave a message: allows the caller to record a message.
Transfer to a covering extension: transfers the caller to a covering extension.
Page the mailbox owner by intercom paging: pages the subscriber by intercom.
Notify the mailbox owner via a beeper: notifies the subscriber via a beeper.
Transfer to operator: transfers the caller to an operator.
Return to top menu: lets the caller return to top menu and try another extension.
Transfer to specified custom service menu: transfers the caller to the specified Custom Service.

Feature Manual References

2.3.14 Incomplete Call Handling Service
Incomplete Call Handling for Busy

Specifies how the VPS handles a call when the extension is busy.

**Note**
- This setting can be changed by subscribers.
- More than one option can be selected.

**Default**
Leave a message/Transfer to operator/Return to top menu

**Value Range**
- **Leave a message**: allows the caller to record a message.
- **Transfer to a covering extension**: transfers the caller to a covering extension.
- **Page the mailbox owner by intercom paging**: pages the subscriber by intercom.
- **Notify the mailbox owner via a beeper**: notifies the subscriber via a beeper.
- **Transfer to operator**: transfers the caller to an operator.
- **Return to top menu**: lets the caller return to top menu and try another extension.
- **Transfer to specified custom service menu**: transfers the caller to the specified Custom Service.

**Feature Manual References**
2.3.14 Incomplete Call Handling Service

**Subscriber’s Manual References**
5.2 Incomplete Call Handling
2.1.4 Notification Parameters

The VPS is able to notify a subscriber when a new message is recorded in his or her mailbox. There are 2 methods that the VPS can use for Message Waiting Notification:

- Lighting the Message Waiting Lamp on the subscriber's extension telephone.
- Calling a preprogrammed device (i.e., external telephone or beeper). A maximum of 3 devices (Device 1, 2, 3) can be programmed per mailbox.

Message Waiting Lamp

If set to "Enable", the Message Waiting Lamp of the subscriber’s telephone turns on when a new message is recorded.

**Default**
Enable

**Value Range**
Disable, Enable

**Feature Manual References**
2.2.33 Message Waiting Notification—Lamp
Beeper Callback No. Entry Mode

This feature allows a caller to dial his or her own telephone number, which the VPS then sends to the subscriber’s beeper.

Note

• To use this feature, the callback number entry code "X" must be programmed along with the subscriber’s beeper number. If the caller does not enter a callback number, or if this feature is set to "Disable", the "System Callback No." (set in "System Parameters → Parameters → Message Waiting Notification") will be displayed on the beeper’s display instead. In either of these cases, if a caller’s telephone number is received through the telephone company’s Caller ID service, the VPS will send the caller’s number to the beeper instead of the "System Callback No."

Default

Disable

Value Range

Caller Select: After recording a message, the caller is asked whether or not he or she wishes to enter a callback number.
Without: Without recording a message, the caller is asked to enter a callback number.
Before: Before recording a message, the VPS asks the caller to enter a callback number.
After: After recording a message, the VPS asks the caller to enter a callback number.
Disable: Disables the Callback Number Entry feature. Either the caller’s telephone number received through the telephone company’s Caller ID service or the "System Callback No." will be sent to the beeper.

Programming Manual References

"System Callback No." in 2.5.4.5 PBX Parameters

Feature Manual References

2.3.8 Calling a Beeper

Device Notification for Unreceived Message

This parameter determines what happens if Message Waiting Notification—Device begins but is interrupted for some reason (i.e., the subscriber hangs up without listening to all new messages, the subscriber’s mobile phone disconnects while listening to messages, etc.). If this parameter is set to "Yes", the VPS will try to call the lowest numbered device again. If this parameter is set to "No", the VPS will call the lowest numbered device only after another new message is recorded in the mailbox.

Default

No

Value Range

No, Yes

Feature Manual References

2.2.32 Message Waiting Notification—Device
2.1.4.1 Notification Schedule

Specifies the Message Waiting Notification schedule for each device. The following parameters can be specified per device.

Follow the steps below to edit the notification schedule.
1. Click Click to edit....
2. Select a device (Device No. 1, Device No. 2, Device No. 3) tab.
3. Edit parameters.
4. Click OK.

Notification Type

Specifies the type of message for which notification is sent. Notification can be sent for all messages, or urgent messages only.

Default
All Messages

Value Range
All Messages, Only Urgent Messages

Feature Manual References
2.2.32 Message Waiting Notification—Device
Dial Number

Assigns a telephone or beeper number to Device 1, 2, or 3. The subscriber can also specify the number to be dialed by entering it from his or her telephone, allowing the subscriber to set this feature on a case by case basis.

**Note**

- The callback number entry code "X" must be included in the number to be called if the "Beeper Callback No. Entry Mode" is set to any value other than "Disable" and "Type of Device" is set to "Beeper". The proper number of dialing pauses must be inserted before the callback entry code.
- When the VPS calls a trunk (CO line) via a PRI (ISDN Primary Rate Access Interface) card of a Panasonic PBX, please be sure to add "#" after the telephone number (1112223333 in the example here):
  
  Example: 9P1112223333#PP123PP456PPX# (P: Dial Pause)

**Default**

None

**Value Range**

Max. 32 digits consisting of 0–9, *, # and special codes:

- : Dial Pause (default 1 s)
- ;: Dial Pause (default 3 s)
- T: Dial Tone Detection
- X: Callback Number Entry Code
- 0–9, *, #: Dial Codes

**Programming Manual References**

"Beeper Callback No. Entry Mode" in 2.1.4 Notification Parameters

**Feature Manual References**

2.2.32 Message Waiting Notification—Device

Type of Device

Specifies the type of device telephone or beeper that will receive message notification. The subscriber can also specify the type of device from his or her telephone.

**Default**

Telephone

**Value Range**

Telephone, Beeper

**Feature Manual References**

2.2.32 Message Waiting Notification—Device

No. of Retries

Specifies the number of times the VPS will try to send notification if the device is busy or if there is no answer.
2.1.4 Notification Parameters

Default
0

Value Range
0–9 times

Note
• The value range varies depending upon country/area.

Feature Manual References
2.2.32 Message Waiting Notification—Device

Busy Delay Time
Specifies the time (in minutes) the VPS waits before retrying message notification when the called device is busy.

Default
3 min

Value Range
0 min–120 min

Note
• The value range varies depending upon country/area.

Feature Manual References
2.2.32 Message Waiting Notification—Device

No Answer Delay Time
Specifies the time (in minutes) the VPS waits before retrying message notification when the called device does not answer.

Default
60 min

Value Range
60 min–120 min

Note
• The value range varies depending upon country/area.

Feature Manual References
2.2.32 Message Waiting Notification—Device
Use Mode

Specifies if and how each device is used for message notification. The subscriber can also specify the use mode from his or her telephone.

Default
Continuously

Value Range
Not Use: The selected device is not used for message notification.
Continuously: The device is called whenever a message is recorded in the mailbox. If "Notification Type" is set to "Only Urgent Messages", the device is called whenever an urgent message is recorded in the mailbox.
Scheduled: The selected device is called only during the selected times.

Feature Manual References
2.2.32 Message Waiting Notification—Device

Time Frame 1, 2 (SUN–SAT)

Specifies the schedule (time frame) of Message Waiting Notification by the selected device for each day of the week when "Scheduled" is set in "Use Mode". Notification will be sent for messages received during the time frame set here. For messages received during times outside of the time frame, notification will be sent at the beginning of the next time frame.

Follow the steps below to edit the time frame.
1. Click a day (Sunday – Saturday) tab.
2. Click Time Frame 1 or Time Frame 2.
3. Enter the start and end times in the "Start At:" and "End At:" fields, or drag the edges of the time frame to mark the start and end times.
   To copy the schedule of one day to another day
   1. Select a time frame in the desired "copy from" day.
   2. Click Copy.
   3. Select a time frame in the desired "copy to" day.
   4. Click Paste.
4. Click OK.

Default
Time Frame 1: 02:00-11:00
Time Frame 2: 13:00-22:00

Value Range
00:00–24:00

Feature Manual References
2.2.32 Message Waiting Notification—Device

2.1.4.2 Device Notification Timer

Specifies the delay time for Message Waiting Notification per device.
Device Start Delay Time

Specifies the length of time the VPS waits after a new message is received before sending message waiting notification.

**Default**
0 min

**Value Range**
0 min–120 min

**Feature Manual References**
2.2.32 Message Waiting Notification—Device

Device Interval Time between Device1 and Next Device

Specifies how long the PBX waits after sending Message Waiting Notification to Device 1 before sending notification to the next device.

**Default**
0 min

**Value Range**
0 min–120 min

**Feature Manual References**
2.2.32 Message Waiting Notification—Device

Device Interval Time between Device2 and Next Device

Specifies how long the PBX waits after sending Message Waiting Notification to Device 2 before sending notification to the next device.

**Default**
0 min

**Value Range**
0 min–120 min

**Feature Manual References**
2.2.32 Message Waiting Notification—Device

Device Interval Time between Device3 and Next Device

Specifies how long the PBX waits after sending Message Waiting Notification to Device 3 before sending notification to the next device.

**Default**
0 min
2.1.4 Notification Parameters

Value Range
0 min–120 min

Feature Manual References
2.2.32 Message Waiting Notification—Device
2.1.5 External Message Delivery

Allows a subscriber to send a message to several subscribers and non-subscribers (including outside parties) immediately or at a specified time.

Active

If set to “Yes”, subscribers are able to utilize the External Message Delivery feature.

Default

No

Value Range

No, Yes

Feature Manual References

2.3.11 External Message Delivery Service

Subscriber’s Manual References

5.7 External Message Delivery Lists
Prompt Mode

When an external message is delivered, the receiver will be greeted by the VPS in the specified language. If set to "Primary", the default language will be used. If set to "Selective", the receiver has a choice of prompts. See related explanation in "Incoming Call Service Prompt" in 2.3.1.1 Call Service.

Note

• If set to "Selective" and the receiver uses a rotary telephone, the no-entry selection is specified by "Prompt for Rotary Callers" in 2.3.1.1 Call Service.

Default

Primary

Value Range

Primary, Selective, Selection from all installed languages (KX-TVA50: 3 languages, KX-TVA200: 10 languages)

Programming Manual References

"Incoming Call Service Prompt" in 2.3.1.1 Call Service

Feature Manual References

2.2.45 System Prompts
2.1.6 Auto Forwarding

Moves or copies unplayed messages from one mailbox to another, after a specified period of time. This service is only available to subscribers; you cannot auto forward messages to a Mailbox Group.

Active

If set to "Yes", the VPS automatically forwards messages that have not been played for a specified length of time to another mailbox.

Default

No

Value Range

No, Yes

Feature Manual References

2.2.2 Auto Forwarding

Mailbox Number

Specifies the mailbox to which the messages will be forwarded.

Note

• A Mailbox Group number cannot be specified as a destination.
Default
None

Value Range
2–5 digits

Feature Manual References
2.2.2 Auto Forwarding

Delay Time
Specifies the length of time in hours and minutes that the VPS waits before forwarding unplayed messages. The maximum delay time is 99 h, 59 min.

Note
• The delay time must be shorter than the New Message Retention Time, or else messages will be deleted before being forwarded.

Default
00:30

Value Range
00:05–99:59

Feature Manual References
2.2.2 Auto Forwarding

Forwarding Mode
Specifies if forwarded messages are to be retained in the original mailbox. When set to "Copy", copies of the messages are retained in the original mailbox after forwarding. When set to "Move", messages are forwarded to the receiving mailbox and are not retained in the original mailbox.

Default
Move

Value Range
Copy, Move

Feature Manual References
2.2.2 Auto Forwarding
2.1.7 Personal Distribution List

Personal Distribution Lists are used to send the same messages to several mailboxes in a single operation. A maximum of 4 lists can be maintained with each list containing a maximum of 40 mailboxes.

2.1.7.1 List No. 1–List No. 4

List Name

Specifies a list name.

Default

None

Value Range

Max. 32 characters

Feature Manual References

2.3.12 Group Distribution List—Personal

List Members

Specifies the mailbox numbers that belong to the list. Follow the steps below to edit list members.
1. Click Click to edit....

[Adding List Members]
1. Enter a mailbox number next to the Quick Search Mailbox: field or select the mailbox number in the Subscribers to add table.
2. Click Add >>.

[Deleting List Members]
1. Enter a mailbox number next to the Quick Search Mailbox: field or select the mailbox number in the Distribution table.
2. Click Delete <<.

[Searching for Subscribers]
1. Click Search Subscribers....
2. Enter the Mailbox No., Extension No., First Name, or Last Name of the desired subscriber.
3. Click OK.

Default
None

Value Range
Max. 40 mailboxes

Feature Manual References
2.3.12 Group Distribution List—Personal

Subscriber's Manual References
5.6 Personal Group Distribution Lists
2.1.8 Personal Custom Service

Personal Custom Service

Specifies the Personal Custom Service. The System Administrator can assign an operation to each key.

**Note**

- These settings can be changed by subscribers.
- Make sure to add a trunk (CO line) access number when you store an outside telephone number.
- When the VPS calls a trunk (CO line) via a PRI (ISDN Primary Rate Access Interface) card of a Panasonic PBX, please be sure to add "#" after the telephone number (1112223333 in the example here):
  
  Example: 9P1112223333#PP123PP456PPX# (P: Dial Pause)

Follow the steps below to edit a Personal Custom Service.
1. Click Click to edit....

### Key Assignment

1. Select the desired key.
2. Select the desired operation under **Assigned Operation** and enter the setting under **Value** as necessary.

#### Outside Numbers

1. Enter the outside telephone numbers that can be used for the “Transfer to outside (specified number)” operation.
2. Select "Recording", "Disconnect (All Day)", or "Disconnect (Only After Hours)" for **No DTMF Input Operation**.

2. Click **OK**.

### Default

**<Key Assignment>**

0: None
3–9: None

**<Outside Numbers>**

Outside Number #1–#4: None
No DTMF Input Operation: Recording
Value Range

<Key Assignment>

Key: 3–9, 0

Assigned Operation:

**Transfer to specified mailbox**: Allow the caller to leave messages in a specified mailbox.

**Transfer to specified extension**: Transfers the caller to a specified extension.

**Transfer to Voice Mail Service**: Allows the caller to access Voice Mail Service.

**Transfer to Automated Attendant Service**: Allows the caller to access Automated Attendant Service.

**Transfer to specified Custom Service Menu**: Transfers the caller to the Custom Service specified here.

**Transfer to operator**: Connects the caller to an operator.

**Transfer to outside (specified number)**: Transfers the caller to a specified outside telephone number. Enter the PBX trunk (CO line) access number, such as 9.

**Page the party**: Pages the subscriber.

**Repeat greeting**: Repeats the greeting.

**None**: No operation assigned

<Outside Numbers>

Outside Number #1–#4: Max. 32 digits consisting of 0–9, *, #, and special codes

**T**: Dial Tone Detection

,: Dial Pause (default 1 s)

;: Dial Pause (default 3 s)

0–9, *, #: Dial Code

No DTMF Input Operation: Recording, Disconnect (All Day), Disconnect (Only After Hours)

Feature Manual References

2.3.20 Personal Custom Service

Subscriber’s Manual References

5.18 Personal Custom Service
2.1.9 Remote Call FWD To CO

Specifies the telephone numbers of destinations to which callers are forwarded when the subscriber sets Remote Call Forwarding. 2 telephone numbers can be specified per mailbox.

**Note**
- Class of Service programming determines if the subscriber is able to use this feature.
- This feature is only available when the VPS is connected to a Panasonic KX-T series PBX using DPT Integration.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailbox Parameters</td>
<td></td>
</tr>
<tr>
<td>Notification Parameters</td>
<td></td>
</tr>
<tr>
<td>External Message Delivery</td>
<td></td>
</tr>
<tr>
<td>Auto Forwarding</td>
<td></td>
</tr>
<tr>
<td>Personal Distribution List</td>
<td></td>
</tr>
<tr>
<td>Personal Custom Service</td>
<td></td>
</tr>
<tr>
<td>Remote Call FWD To CO</td>
<td></td>
</tr>
<tr>
<td>Telephone Number 1</td>
<td></td>
</tr>
<tr>
<td>Telephone Number 2</td>
<td></td>
</tr>
<tr>
<td>Automatic Login</td>
<td></td>
</tr>
<tr>
<td>E-mail Option</td>
<td></td>
</tr>
</tbody>
</table>

**Telephone Number 1, Telephone Number 2**

Specifies the telephone numbers of destinations to which callers are forwarded when the subscriber sets Remote Call Forwarding. Telephone numbers can contain the digits "0–9" and "x". These telephone numbers should begin with a trunk (CO line) access number.

**Default**
None

**Value Range**
Max. 24 digits (With the KX-TD500 and KX-TDE/KX-TDA/KX-TAW series)
Max. 16 digits (With other KX-T series PBXs)

**Programming Manual References**
"Remote Call Forward to CO" in 2.2.2 Personal Options
2.1.9 Remote Call FWD To CO

Feature Manual References
2.3.27 Remote Call Forwarding Set (DPT Integration Only)

Subscriber’s Manual References
5.15 Remote Call Forwarding
2.1.10 Automatic Login

Allows subscribers to access their mailbox directly without entering the mailbox number. Subscribers can automatically log in from their extensions, by calling from an outside telephone whose number is stored as a Caller ID number, or by dialing a telephone number assigned to a specified DID number or trunk (CO line). When logging in from outside telephones, the Toll Saver feature is also available.

Extension

If set to "Enable", subscribers are able to access their mailbox directly without entering the mailbox number.

Default

Enable

Value Range

Disable, Enable

Feature Manual References

2.3.2 Automatic Login (APT/DPT Integration Only)

Caller ID 1, Caller ID 2

Specifies the telephone number from which the subscriber can automatically be logged in from. When Caller ID information is received that matches one of these numbers, the caller (subscriber) is automatically logged in to the mailbox. Note that this telephone number must be unique for each mailbox.
2.1.10 Automatic Login

**Default**
None

**Value Range**
Max. 20 digits

**Feature Manual References**
2.3.2 Automatic Login (APT/DPT Integration Only)

**Subscriber’s Manual References**
5.17 Assigning Your Telephone Numbers for Remote Automatic Log-in and Toll Saver

**DID**
Specifies the DID number for Automatic Login. When the VPS receives this DID number from the PBX, the caller (subscriber) is automatically logged in to the mailbox. Note that this number must be unique for each mailbox.

**Note**
- Automatic Login via DID number is only available when the VPS is connected to one of the following PBXs using DPT Integration.
  - KX-TD816 (P311Q or higher)
  - KX-TD1232 (P211Q or higher)
  - KX-TD500 (V4M or higher)
  - KX-TDE series
  - KX-TDA series*1 (MPR Version 1.1 or higher)

*1 except KX-TDA50

**Default**
None

**Value Range**
Max. 20 digits

**Feature Manual References**
2.3.2 Automatic Login (APT/DPT Integration Only)

**Subscriber’s Manual References**
5.17 Assigning Your Telephone Numbers for Remote Automatic Log-in and Toll Saver

**Trunk**
Specifies the trunk (CO line) number for Automatic Login. When the VPS receives a call on this trunk (CO line), the caller (subscriber) is automatically logged in to the mailbox. Note that this number must be unique for each mailbox.
**Default**
None

**Value Range**
1–64

**Feature Manual References**
2.3.2 Automatic Login (APT/DPT Integration Only)

**Toll Saver**

Allows subscribers to call the VPS and know whether or not new messages have been recorded in their mailboxes by the number of rings they hear before the VPS answers their calls. Toll Saver is available under the same conditions as Automatic Login; subscribers can use Toll Saver when calling from an outside telephone whose number is stored as a Caller ID number, or by dialing a telephone number assigned to a specified DID number or trunk (CO line).

**Default**
Disable

**Value Range**
- **Disable**: Disables the Toll Saver feature.
- **DID**: Toll Saver functions when the VPS receives the preprogrammed DID number from the PBX.
- **Caller ID**: Toll Saver functions when Caller ID information is received that matches one of the preprogrammed numbers (Caller ID 1 or 2)
- **Trunk**: Toll Saver functions when the VPS receives a call on the preprogrammed trunk (CO line).

**Feature Manual References**
2.3.2 Automatic Login (APT/DPT Integration Only)
2.1.11 E-mail Option

Enables subscribers to receive notification by e-mail when they receive new messages.

Follow the steps below to edit e-mail parameters:

1. Click Add Mailbox... or select a mailbox and click Edit Mailbox....
2. Enter the username for the subscriber's e-mail account next to Username.
3. Enter the subscriber's e-mail address next to E-mail Address. Up to 3 addresses can be set by inserting a comma between each address.
   Example: address1@___.com, address2@___.com, address3@___.com
4. Set Send E-mail with New Messages to Enable to allow the subscriber to receive e-mail notifications.
5. Set Attach Voice File to Enable to allow the subscriber to receive voice messages as e-mail file attachments.
6. Click Click to edit... next to E-mail Schedule to determine when e-mail messages are sent, and make the appropriate settings.
7. Click OK when finished.

Username

Specifies a subscriber's username for e-mail option.

Default
None

Value Range
Max. 64 characters
E-mail Address
Specifies the subscriber's e-mail address. Up to 3 addresses can be set (with a comma inserted between addresses).

Default
None

Value Range
Max. 128 characters

Send E-mail with New Messages
If set to "Enable", the subscriber is able to receive notification by e-mail.

Default
Disable

Value Range
Disable, Enable

Attach Voice File
If set to "Enable", the subscriber is able to receive voice messages by e-mail (messages are sent as file attachments).

Default
Disable

Value Range
Disable, Enable

E-mail Schedule
Specifies the schedule (time frame) for notification by e-mail for each day of the week, and specifies whether to delete the original message in a mailbox after the message is sent by e-mail. Notification will be sent for
messages received during the time frame set here. For messages received during times outside of the time frame, notification will be sent at the beginning of the next time frame.
You can also set the schedule to "Not Use" or "All Day".

Follow the steps below to edit the time frame.
1. Click a day (Sunday – Saturday) tab.
2. Uncheck "Not Use" or "All Day" if checked.
3. Click "Time Frame".
4. Enter the start and end times in the "Start At:" and "End At:" fields, or drag the edges of the time frame to mark the start and end times.

*To copy the schedule of one day to another day*
1. Select a time frame in the desired "copy from" day.
2. Click **Copy**.
3. Select a time frame in the desired "copy to" day.
4. Click **Paste**.
5. Check "Reversal" to enable notification during the times of day that are not specified.
   For example, to enable notification from midnight to 9:00 AM and from 5:00 PM to midnight, set the time frame from 9:00 AM to 5:00 PM, then check "Reversal".
6. Check "Delete After Send" if needed.
7. Click **OK**.

**Default**
All Day

**Value Range**
00:00–24:00

**Feature Manual References**
2.2.20 E-mail Integration
2.2 Class of Service

Each mailbox is assigned a Class of Service (COS) that determines the set of services that are available to its subscriber. There are 64 classes. Mailboxes can be assigned to their own or to the same COS as needed. COS No. 63 and 64 are assigned by default to the Message Manager and to the System Manager, respectively. No other mailboxes can be assigned to COS No. 63 and 64.

Follow the steps below to edit a Class of Service.

[Editing a COS]
1. Select the desired COS No. from the Class of Service Number pull-down menu.
2. Edit each parameter in the dialog box.
3. Click OK.

[Copying Settings from One COS to Another COS]
1. Select the desired COS No. to copy, and press Copy.
2. The Copy Class of Service window is displayed. Check the items to copy, and select the destination COS number. (Ctrl/Shift key is available to choose several mailbox COS numbers.)
3. Click Copy.

[Viewing all COS Settings (Report View)]
1. Select the desired COS No.
2. Click Report View.

All parameters for all Classes of Service are displayed. Classes of Service can be sorted in ascending or descending order by parameter by clicking the parameter name.

From this screen, you cannot edit any parameters: to edit each setting, click the desired COS No., then click Edit COS.

### 2.2.1 Class of Service

Specifies the parameters for each Class of Service.

**Class of Service Name**

Specifies the Class of Service's name.

**Default**

None

**Value Range**

Max. 32 characters

**Feature Manual References**

2.2.12 Class of Service (COS)

**Personal Greeting Length**

Defines the maximum length (in seconds) of the Personal Greeting.

**Default**

60 s
Value Range
1 s–360 s

Feature Manual References
2.3.22 Personal Greetings

Message Length
Defines the maximum recording time for messages. If set to "Unlimited", the maximum recording time is 60 minutes, and the maximum recording time for two-way conversations (Two-way Record and Two-way Transfer) is unlimited.

Default
COS 1-62: 3 min
COS 63-64: 10 min (KX-TVA50), 60 min (KX-TVA200)

Value Range
1 min–60 min, Unlimited

Feature Manual References
2.3.32 Two-way Record (APT/DPT Integration Only)
2.3.33 Two-way Transfer (APT/DPT Integration Only)

Subscriber's Manual References
5.13 Recording Your Conversations

Mailbox Capacity Maximum Message Time
Specifies the total number of available minutes for storing messages (both new and saved) in each mailbox.

Default
COS 1-62: 10 min (KX-TVA50), 100 min (KX-TVA200)
COS 63-64: 120 min (KX-TVA50), 600 min (KX-TVA200)

Value Range
For KX-TVA50: 1 min–120 min, Unlimited
For KX-TVA200: 1 min–600 min, Unlimited

New Message Retention Time
Defines the number of days that a new message will remain in the mailbox. The storage period begins the day after the message reception. If "Unlimited" is selected, the saved message will remain in the mailbox until erased by the subscriber.

Default
30 days

Value Range
1–30 days, Unlimited
Saved Message Retention Time
Defines the number of days that a played message will remain in the mailbox. If "Unlimited" is selected, the saved message will remain in the mailbox until erased by the subscriber.

**Default**
30 days

**Value Range**
1–30 days, Unlimited

Message Retrieval Order
Specifies the order in which messages will be retrieved (played back for listening).

**Default**
LIFO

**Value Range**

- **LIFO**: Messages are retrieved starting with the most recent (Last In First Out).
- **FIFO**: Messages are retrieved starting with the oldest (First In First Out).

Intercom Paging Group
Specifies the Intercom Paging group number available to the subscriber.

**Note**
- The Intercom Paging feature is only available when the VPS is connected to a Panasonic KX-T series PBX using APT/DPT Integration.
- Intercom paging parameters can be edited by clicking Edit System Parameters/Parameters/Intercom Paging Parameters at the bottom of the dialog box.

**Default**
1

**Value Range**
1–32, All

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Prompt Mode
Specifies the language used for system prompts played for the subscriber during Subscriber Service. If set to "Primary", the default language which is selected from all installed languages will be used.

**Note**
- If a certain prompt is not recorded in the language selected by the subscriber, the English version of that prompt will be used.

**Default**
Primary
Value Range
Primary, Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: No. 1-10)

Feature Manual References
2.2.34 Multilingual Service
2.2.45 System Prompts

Number of ClIDs for Caller Name Announcement
Specifies the maximum number of telephone numbers that subscribers can assign for the Personal Caller Name Announcement feature.

Default
30

Value Range
None, 1–30

Feature Manual References
2.2.10 Caller Name Announcement—Personal (APT/DPT Integration Only)

Subscriber’s Manual References
5.11 Personal Caller Name Announcement

Message Envelope Setting
Specifies when message envelopes (message date and time, name of the person who recorded or transferred the message, telephone number of the caller) are announced.

Note
• If you want to skip this information, press [6] while listening to it.

Default
After

Value Range
Before: The VPS announces the message envelope before playing the recorded message.
After: The VPS announces the message envelope after playing the recorded message.
Require: The VPS announces the message envelope when the user presses the appropriate dial key as prompted when listening to the message.

Number of New Messages Announcement
Specifies the position of the Number of New Messages Announcement.

Default
Subscriber Service
Value Range

None: Not announced

Subscriber Service: The VPS announces the number of new messages at the beginning of Subscriber Service (i.e., after the subscriber has logged in to his or her mailbox).

Receiving Message: The VPS announces the number of new messages when the subscriber selects to listen to messages while accessing his or her mailbox.

Total Number of Message Announcement

Specifies the position of the Total Number of Messages Announcement.

Note

• When the same position is set for the Number of New Messages Announcement and the Total Number of Message Announcement, the VPS announces the number of new messages then the total number of messages.

Default

Receiving Message

Value Range

None: Not announced

Subscriber Service: The VPS announces the total number of messages at the beginning of Subscriber Service (i.e., after the subscriber has logged in to his or her mailbox).

Receiving Message: The VPS announces the total number of messages when the subscriber selects to listen to messages while accessing his or her mailbox.

Mailbox Capacity Warning

Specifies if and when the VPS alerts mailbox subscribers that the programmable recording time for mailboxes is reaching its set amount of message storage time. If set to "None", the warning will not be announced. All other settings indicate the remaining recording time capacity threshold for when the announcement is heard.

Default

3 min (KX-TVA50), 10 min (KX-TVA200)

Value Range

None, 1–60 min

Feature Manual References

2.3.17 Mailbox Capacity Warning

Subscriber’s Manual References

5.22 Mailbox Capacity Warning
### 2.2.2 Personal Options

The following parameters determine the utilization of features in each mailbox based on the COS.

#### VM Menu

If set to "Yes", the subscriber can use the VM Menu feature.

**Default**
Yes

**Value Range**
No, Yes

#### Feature Manual References

2.3.36 VM Menu (DPT Integration Only)

#### Subscriber’s Manual References

1.1 Introduction to the VPS

#### Play System Prompt after Personal Greeting

If set to "Yes", directions for recording a message are given to the caller immediately after the personal greeting has been played.

**Default**
No

**Value Range**
No, Yes
2.2.2 Personal Options

Use Call Waiting on Busy
If set to "Yes", the VPS signals the subscriber when he or she is on a call and another call is received.

**Note**
- The Call Waiting Sequence can be edited by clicking *Edit System Parameters/Parameters/Call Waiting Sequence* at the bottom of the dialog box.

**Default**
No

**Value Range**
No, Yes

Message Cancel for Live Call Screening
If set to "Yes", the caller’s message will be deleted when the subscriber answers a call via Live Call Screening while the caller is leaving a message.

**Note**
- The Live Call Screening feature is only available when the VPS is connected to a Panasonic KX-T series PBX using APT/DPT Integration.

**Default**
Yes

**Value Range**
No, Yes

**Feature Manual References**
2.3.15 Live Call Screening (APT/DPT Integration Only)

**Subscriber’s Manual References**
5.12 Live Call Screening (LCS)

Remote Call Forward to CO
If set to "Yes", the subscriber can use the Remote Call Forwarding feature. This feature allows the subscriber to program his or her extension remotely to forward calls to an outside telephone number. This telephone number can be "Telephone Number 1" or "Telephone Number 2" (see 2.1.9 Remote Call FWD To CO), or any other telephone number.

**Note**
- This feature is only available when the VPS is connected to a Panasonic KX-T series PBX using DPT Integration.
- This feature may be prohibited by the PBX; PBX programming may also be necessary to enable calls to forwarded to an outside telephone number for the COS of the extensions who will use this feature.

**Default**
No
2.2.2 Personal Options

Value Range
No, Yes

Programming Manual References
2.1.9 Remote Call FWD To CO

Feature Manual References
2.3.27 Remote Call Forwarding Set (DPT Integration Only)

Subscriber’s Manual References
5.15 Remote Call Forwarding

Delete Message Confirmation
If set to "Yes", the VPS requests confirmation from the subscriber before erasing a message in the mailbox. If set to "No", the message is erased immediately.

Default
No

Value Range
No, Yes

Feature Manual References
2.3.9 Delete Message Confirmation

Personal Greeting for Caller ID
If set to "Yes", subscribers can record personal greetings that are played for specific callers only (Personal Greeting for Caller ID).

Default
Yes

Value Range
No, Yes

Feature Manual References
2.3.21 Personal Greeting for Caller ID (APT/DPT Integration Only)

Subscriber’s Manual References
5.10 Personal Greetings for Caller ID
2.2.2 Personal Options

**Caller ID Screen**
If set to "Yes", subscribers can hear the prerecorded names of callers when they receive calls (Caller ID Screening).

**Default**
Yes

**Value Range**
No, Yes

**Feature Manual References**
2.2.9 Caller ID Screening (APT/DPT Integration Only)

**Caller ID Callback**
If set to "Yes", the subscriber can call the caller back while listening to the caller's message (Caller ID Callback).

**Default**
No

**Value Range**
No, Yes

**Feature Manual References**
2.3.7 Caller ID Callback (APT/DPT Integration Only)

**Notify of Transfer**
If set to "Yes", subscribers will hear "You have a call." when they answer transferred calls.

**Default**
No

**Value Range**
No, Yes

**Directory Listing**
If set to "Yes", the subscriber's name and extension number will be listed in the directory (Dialing by Name).

**Default**
Yes

**Value Range**
No, Yes

**Feature Manual References**
2.2.18 Dialing by Name
Tutorial
If set to "Yes", subscribers are guided to set the following basic mailbox settings when they access their mailboxes for the first time:
- Password
- Mailbox Owner Name
- No Answer Greeting

Default
Yes

Value Range
No, Yes

Feature Manual References
2.3.28 Subscriber Tutorial

Subscriber's Manual References
2.2 Subscriber Tutorial (Easy Mailbox Configuration)

Auto Receipt
If set to "Yes", the subscriber can request to receive confirmation when his or her message has been listened to by the message recipient.

Default
No

Value Range
No, Yes

Feature Manual References
2.3.1 Auto Receipt

Autoplay New Message
If set to "Yes", the VPS plays new messages automatically when the subscriber logs into his or her mailbox.

Default
No

Value Range
No, Yes

Feature Manual References
2.3.3 Autoplay New Message
First Playback Urgent Messages
If set to "Yes", the VPS plays urgent messages before regular messages.

Default
Yes

Value Range
No, Yes

Feature Manual References
2.3.35 Urgent Message

Announce Message Transferred Information
If set to "Yes", the VPS plays the information of transferred messages to a subscriber before playing the messages.

Default
No

Value Range
No, Yes

Caller ID Number Announcement
Specifies whether or not the VPS announces the Caller ID number when the subscriber plays a message left by a caller whose name has not been recorded for the Caller Name Announcement feature. If the name has been recorded, it will be announced regardless of this setting.

Note
• If "Caller ID Callback" is set to "Yes", Caller ID numbers will be announced regardless of this setting (see "Caller ID Callback" in 2.2.2 Personal Options).

Default
Yes

Value Range
No, Yes

Announce Option Menu After Erasing Messages
If set to "Yes", the VPS plays the option menu after erasing a message. If set to "No", the VPS plays the next message automatically without playing the option menu.

Default
No

Value Range
No, Yes
Call Transfer to Outside
If set to "Yes", the VPS allows calls to be transferred to a trunk (CO line) via the following features: Caller ID Callback, Call Transfer Service, and Personal Custom Service.

Default
No

Value Range
No, Yes

Feature Manual References
2.2.7 Call Transfer to Outside

New Message Length Announcement
If set to "Yes", the VPS announces the total length of new messages when the number of new messages is announced.

Default
No

Value Range
No, Yes
2.3 PORT/TRUNK Service

When a call is received from an outside party, the following call services can determine how the call is handled:
- Automatic Login (Toll Saver)
- Holiday Service
- Caller ID Call Routing
- DID Call Routing
- Trunk Service
- Port Service

The service with the highest priority will handle the call. The order of priority is:
Automatic Login (Toll Saver) > Holiday Service > Caller ID Call Routing> DID Call Routing > Trunk Service > Port Service.

2.3.1 Service Group

A Service Group is a group of parameters that determine how incoming calls will be handled by the VPS. 48 different Service Groups can be configured; one Service Group can be assigned to each VPS port and PBX trunk (CO line), and each Service Group can be applied to more than one trunk (CO line) group or port as needed.

Follow the steps below to configure each Service Group.

[Editing a Service Group]
1. Select the desired Service Group Number (1–48) in the Service Groups list.
2. Edit each parameter in the Group Parameters list.
[Assigning Ports or Trunks to a Service Group]

1. Select a Service Group Number (1–48) from the pull-down menu under Assign Group To.
   
   To assign to a single port or a range of ports
   
   1. Click Port.
   
   2. Check Single Port or Range of Ports.
   
   3. Specify the desired port number or a range of port numbers (From:/To:).

To assign to a single trunk (CO line) or a range of trunks (CO lines)

1. Click Trunk.

2. Check Single Trunk or Range of Trunks.

3. Specify the desired trunk (CO line) number or a range of trunk (CO line) numbers (From:/To:).

2. Click Assign.

[Default Port/Trunk assignment]

Port 1-24 (KX-TVA200), 1-6 (KX-TVA50): Service Group No. 1

Trunk 1-64: None

Service Mode

Assigns one of 6 Service Modes to the Service Group.

Note

- Once the Service Mode has been changed, it is retained unless the System Manager or System Administrator changes it again, even after the power is turned off.
- PBX Control mode is only available when the VPS is connected to a Panasonic KX-T series PBX using APT/DPT Integration. If PBX Control mode is selected but cannot be used, the VPS will operate in Automatic mode.
- In Automatic mode, services have this order of priority:
  - Automatic Login (Toll Saver) > Holiday Service > Caller ID Call Routing> DID Call Routing > Trunk Service> Port Service
- In Manual modes (Day, Night, Lunch, or Break), services have this order of priority:
  - Automatic Login (Toll Saver) > Caller ID Call Routing> DID Call Routing >Trunk Service > Port Service (Holiday Service is disregarded.)

Default

Automatic

Value Range

Automatic: The current Call Service used by the Service Group is determined by the settings made for the current time mode (day, night, lunch, break).

Manual Day: The Call Service programmed for day mode is used, regardless of the current time mode.

Manual Night: The Call Service programmed for night mode is used, regardless of the current time mode.

Manual Lunch: The Call Service programmed for lunch mode is used, regardless of the current time mode.

Manual Break: The Call Service programmed for break mode is used, regardless of the current time mode.

PBX Control: The current Call Service used by the Service Group is determined by the settings made for the current time mode (day, night, lunch, break). The VPS will change time modes according to when the PBX changes time modes (APT/DPT Integration only).

Feature Manual References

2.4.6 Service Mode
2.3.1 Service Group

2.3.1.1 Call Service

Call Service for Day, Night, Lunch, and Break

A call service is a group of parameters that determine how calls are handled throughout the day. Each Service Group (therefore each port and trunk [CO line]) can have a different call service for each time mode (day, night, lunch, break). One of 4 incoming call services (Voice Mail, Automated Attendant, Interview, or Custom Service) can be assigned to each call service.

Company Greeting No.

Specifies the company greeting to be heard by callers. The System Greeting is "Good morning/Good afternoon/Good evening. Welcome to the Voice Processing System.". Each call service can have its own setting.

Default
None

Value Range
None, 1–32, System

Feature Manual References
2.2.13 Company Greeting

Incoming Call Service

Specifies the incoming call service used to handle calls.

Note
• When you select "Interview Mailbox", an Interview Mailbox number should also be specified.
• When you select "Custom Service Menu", a Custom Service number should also be specified.
• The System Manager can change the "Incoming Call Service" after logging in to his or her mailbox (see 2.6 Changing the Company Greeting and Incoming Call Service Setting in the Manager’s Manual.)

Default
Automated Attendant Service

Value Range
Voice Mail Service, Automated Attendant Service, Interview Mailbox, Custom Service Menu

Feature Manual References
2.2.6 Call Services
2.2.40 Port Service
2.2.47 Trunk Service (Universal Port) (APT/DPT Integration Only)

Manager’s Manual References
2.6 Changing the Company Greeting and Incoming Call Service Setting
Incoming Call Service Prompt

Specifies the language of system prompts used by this call service. If set to "Primary", the default language which is selected from all installed languages will be used. When set to "Selective", the caller can select the language of his or her choice, provided the System Administrator or the Message Manager has recorded the Multilingual Selection Menu. To specify Prompt Selection Number, see 2.5.4.2 Prompt Setting.

Note
- If "Selective" is specified, you will need to select a prompt available for rotary callers. See "Prompt for Rotary Callers" below.

Default
Primary

Value Range
Primary, Selective, Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: 1-10)

Programming Manual References
2.5.4.2 Prompt Setting

Feature Manual References
2.2.45 System Prompts

Prompt for Rotary Callers

Specifies which language a rotary caller or an External Delivery Message receiver hears when he or she cannot enter any digits to select a language after the Multilingual Selection Menu has been played. If set to "Primary", the default language which is selected from all installed languages will be used.

Note
- "Prompt for Rotary Callers" is only available when "Incoming Call Service Prompt" is set to "Selective".

Default
Primary

Value Range
Primary, Selective, Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: No. 1-10)

Feature Manual References
2.2.45 System Prompts

Delayed Answer Time

Specifies whether the VPS answers calls on the port or trunk (CO line) immediately (0) or after a delay (1 s – 60 s).

Default
0 s
Value Range
0 s–60 s

Time Frame
Specifies the start and end times for each time mode for each day of the week. Each day of the week can have 1 lunch mode, up to 2 night modes (1 at the beginning and end of the day) and up to 3 break modes. Lunch and break modes can only be inserted into a day mode.
Follow the steps below to edit the time frame.
1. Click Click to edit...
2. Select a time mode, then enter the start and end times in the "Start At:" and "End At:" fields or drag the edges of the time mode to mark the start and end times.
   To copy the time mode schedule of one day to another day
   1. Select a time mode in the desired "copy from" day, and click Copy.
   2. Select a time mode in the desired "copy to" day, then click Paste.
   To insert a break or lunch mode
   1. Right-click the desired day mode.
   2. Select "Insert Break" or "Insert Lunch".
3. Click OK.

Note
• This setting is only available when "Automatic" is selected in "Service Mode".

Default
Day: 09:00-17:00
Night: 00:00-09:00, 17:00-24:00
Lunch: None
Break: None

Value Range
00:00–24:00

Feature Manual References
2.2.46 Time Service

Caller ID/DID Call Routing
Enables or disables the Caller ID/DID Call Routing feature.

Default
Enable

Value Range
Disable, Enable

Feature Manual References
2.2.8 Caller ID Call Routing (APT/DPT Integration Only)
2.2.19 DID Call Routing (DPT Integration Only)
2.4 Service Settings

Service settings are divided into the following screens:
- Caller ID/DID/PIN Call Routing
- Holiday Settings
- Parameters
- Custom Service

Click each tab at the bottom of Service Settings screen to edit the parameters.

2.4.1 Caller ID/DID/PIN Call Routing

A maximum of 200 Caller ID/DID/PIN numbers can be assigned so that callers are automatically forwarded to a preprogrammed destination. A different destination can be set for each time mode (day, night, lunch, break). PIN Call Routing is only available when the “Call Transfer Anytime” of a Custom Service is set to “PIN”.

Note

• Note that if Automatic Login or Holiday Service is used, these will take priority over Caller ID and DID Call Routing settings. Also note that Caller ID and DID Call Routing take priority over the Trunk Service and Port Service.
• The wild card, “*”, can be used as a substitute for any numbers in the following ways.
  a. When Caller ID/DID/PIN numbers include one “*”: “*” matches any number, regardless of the actual numbers of digits. For example, registering “*” by itself matches all numbers, and registering “201 *” matches any number that starts with “201”.
  b. When Caller ID/DID/PIN numbers include more than one “*”: Each “*” matches a single digit. For example, registering “* * * * *” matches any 10-digit number, and registering “201 * * * * *” matches any 10-digit number that starts with “201”.
• There are 2 methods to edit the parameters for Caller ID/DID/PIN Call Routing.
  a. Double-click a cell in the table of the screen, and edit the selected parameter.
  b. Click the desired Caller ID/DID/PIN number, then, click Edit... and edit each parameter in the Edit Parameters dialog box.
• Received Caller ID/DID/PIN numbers are searched for in each service setting table in order from the first registered number to last. When programming Caller ID/DID/PIN routing, note the order of registration, and remember that wild card entries should be entered after any specific routing entries. Refer to the following examples.
[Routing Example 1]

1. The VPS routes any calls with a 10-digit number (************) to extension 301. The VPS will not route any calls to extension 196.

[Routing Example 2]

1. The VPS routes all calls (*) to extension 301.
2. No calls are routed to extension 196 using the entry "201744*".
1. The VPS routes any calls with a number starting with "201744" to extension 196.
2. The VPS routes any numbers other than numbers matching "201744 x" to extension 301.

Follow the steps below to edit a call routing service.
1. Select the desired mode (Caller-ID Mode, DID Mode, PIN Mode) from the **Mode**: pull-down menu.

**[Adding a Call Routing Service]**
1. Click **Add**.
2. Edit parameters in the **Edit Parameters** dialog box.
3. Click OK.

[Deleting a Call Routing Service]
1. Select the desired Caller ID/DID/PIN number.
2. Click Delete.
3. Click Yes.

[Editing a Call Routing Service]
1. Select the desired Caller ID/DID/PIN number.
2. Click Edit....
3. Edit parameters in the Edit Parameters dialog box.
4. Click OK.

Note
- DID setting is only available when the VPS is connected to one of the following PBXs using DPT Integration.
  - KX-TD816 (P311Q or higher)
  - KX-TD1232 (P211Q or higher)
  - KX-TD500 (V4M or higher)
  - KX-TDE series
  - KX-TDA series*1 (MPR Version 1.1 or higher)

  *1 except KX-TDA50

2.4.1.1 Caller ID No./DID No./PIN No.

Caller ID No./DID No./PIN No.
Specifies Caller ID/DID/PIN numbers so that callers are automatically forwarded to a preprogrammed destination. The wild card "*" can also be entered (see 2.4.1 Caller ID/DID/PIN Call Routing for examples). For Caller ID numbers, "Private" and "Out of Area" callers can be specified.

Default
None

Value Range
Max. 20 digits consisting of 0–9 and "*"
"Private" and "Out of Area" can also be assigned for Caller ID numbers

Feature Manual References
2.2.8 Caller ID Call Routing (APT/DPT Integration Only)
2.2.19 DID Call Routing (DPT Integration Only)
2.2.38 PIN Call Routing

Description
Specifies a name and/or description of the Caller ID/DID/PIN number.

Note
- When no data is specified in this parameter, the caller's name will be automatically entered here if the caller's name is received from the telephone company.
2.4.1 Caller ID/DID/PIN Call Routing

Default
None

Value Range
Max. 20 characters

Feature Manual References
2.2.8 Caller ID Call Routing (APT/DPT Integration Only)
2.2.19 DID Call Routing (DPT Integration Only)
2.2.38 PIN Call Routing

Call Transfer for Day, Night, Lunch, and Break service
Specifies the destination to which the call from an assigned Caller ID/DID/PIN number is automatically forwarded. A destination can be set for each time mode. To disable the setting, select "None". A Mailbox Group number can be entered here instead of a mailbox number.

Default
None

Value Range
None: disables this feature.
Custom Service Menu: forwards callers to the specified Custom Service menu.
Extension: forwards callers to the specified extension.
Mailbox: forwards callers to the specified mailbox.

Feature Manual References
2.2.8 Caller ID Call Routing (APT/DPT Integration Only)
2.2.19 DID Call Routing (DPT Integration Only)
2.2.38 PIN Call Routing
2.4.2 Holiday Settings

You can program a maximum of 20 Holiday Services. On days specified as holidays, the holiday settings have priority over Service Group settings and Caller ID/DID/PIN Call Routing. Note that if Automatic Login is used, it will take priority over Holiday Service settings. Also note that Holiday Service takes priority over Caller ID and DID Call Routing settings, Trunk Service, and Port Service. Additionally, Holiday Service does not function when a manual time mode (Manual Day, Manual Night, etc.) is active.

Note

- Each parameter setting can be sorted in either ascending or descending order by clicking the header in "Holiday Settings" table.
- There are 2 methods to edit the parameters for "Holiday Settings".
  a. Double-click a cell in the table of the screen, and edit the selected parameter.
  b. Click the desired Holiday Service number, then, click Edit... and edit each parameter in the Edit Parameters dialog box.

Follow the steps below to edit a Holiday service.

[Adding a Holiday Service]
1. Click Add....
2. Edit parameters in the Edit Parameters dialog box.
3. Click OK.

[Deleting a Holiday Service]
1. Select the desired Holiday Service number.
2. Click Delete.
3. Click Yes.

[Editing a Holiday Service]
1. Select the desired Holiday Service number.
2. Click **Edit...**

![Edit Parameters dialog box](image)

3. Edit parameters in the **Edit Parameters** dialog box.

4. Click **OK**.

**Note**
- To provide a special message to callers on a holiday (for example, “Today is New Year’s Day and our office is closed. If you wish to record a message, please press 1 now.”), you can create a Custom Service menu. Use a Holiday service to direct calls to this Custom Service on Jan. 1st. Use foreign languages where appropriate.

### 2.4.2.1 Holiday Service No.

**Name of Holiday**

Specify a name or description for the holiday.

**Default**

None

**Value Range**

Max. 32 characters

**Feature Manual References**

2.2.24 Holiday Service

**Start Date**

Specifies the start date of the holiday.

**Default**

None

**Value Range**

MM/DD (MM: Month, DD: Day)
2.4.2 Holiday Settings

**Feature Manual References**
2.2.24 Holiday Service

**Start Time**
Specifies the start time of the holiday.

**Default**
None

**Value Range**
HH:MM (HH: Hour, MM: Minute)

**Feature Manual References**
2.2.24 Holiday Service

**End Date**
Specifies the end date of the holiday.

**Note**
- When the start date and time are specified and the end date and time are "Not Set", the Holiday will end at "00:00".

**Default**
None

**Value Range**
MM/DD (MM: Month, DD: Day)

**Feature Manual References**
2.2.24 Holiday Service

**End Time**
Specifies the end time of the holiday.

**Note**
- When the start date and time are specified and the end date and time are "Not Set", the Holiday will end at "00:00".

**Default**
None

**Value Range**
HH:MM (HH: Hour, MM: Minute)

**Feature Manual References**
2.2.24 Holiday Service
Retain Holiday
Stores the Holiday Service setting for future use. If set to "Yes", the same setting will function automatically on the same day every year. If set to "No", the setting will be canceled automatically after the holiday is over.

Default
No

Value Range
No, Yes

Feature Manual References
2.2.24 Holiday Service

Company Greeting No.
Specifies the Company Greeting to be played on the holiday. When "System" is selected, "Good morning/Good afternoon/Good evening. Welcome to the Voice Processing System." will be heard. (However, the System Administrator and the Message Manager can change this.)

Default
None

Value Range
None, 1–32, System

Feature Manual References
2.2.13 Company Greeting
2.2.24 Holiday Service

Service
Specifies which incoming call service handles calls on the holiday.

Note
- When "Interview Mailbox" is selected, a subscriber's Interview Mailbox number should also be specified. When "Custom Service Menu" is selected, a Custom Service number (1-100) should also be specified.

Default
Automated Attendant Service

Value Range
Voice Mail Service, Automated Attendant Service, Interview Mailbox, Custom Service Menu

Feature Manual References
2.2.6 Call Services
2.2.24 Holiday Service
2.4.2 Holiday Settings

Port Affected

Specifies the port numbers for which the Holiday Service setting is activated. Ports not specified here are handled by the incoming call service assigned to those ports in the PORT/TRUNK Service screen. The maximum number of ports depends on the VPS model.

Default
1-24 (KX-TVA200)
1-6 (KX-TVA50)

Value Range
1–24 (KX-TVA200)
1–6 (KX-TVA50)

Feature Manual References
2.2.24 Holiday Service

Trunk Affected

Specifies the trunks (CO lines) for which the Holiday Service setting is activated. Trunks (CO lines) not specified here are handled by the incoming call service assigned to those trunks (CO lines) in the PORT/TRUNK Service screen.

Default
1–64

Value Range
1–64

Feature Manual References
2.2.24 Holiday Service
2.4.3 Parameters

The following parameters can be specified in Parameters screen.
- Automated Attendant
- Rotary Telephone Service
- Name Entry
- Toll Saver

### 2.4.3.1 Automated Attendant

Specifies the parameters of functions for Automated Attendant Service.

#### Wait Time for First Digit

Specifies the length of time the VPS waits for the caller to dial a digit before assuming the caller is using a rotary telephone and therefore activates Rotary Telephone Service.

**Default**

6 s
2.4.3 Parameters

Value Range
0 s–20 s

Feature Manual References
2.2.3 Automated Attendant

Menu Repeat Cycle
Specifies the number of times the VPS will play the Automated Attendant top menu if the caller does not make a selection.

Default
3 times

Value Range
1–5 times

Play Owner’s Name during Transfer
Determines whether “Transferring you to (name).” is announced to the caller before transferring the caller to an extension.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.2.3 Automated Attendant

Operator Service
These parameters specify the extension numbers and mailbox numbers for operators 1, 2, and 3, as well as calls are treated when they are directed to and operator. Operator parameters can be set individually for day, night, lunch, and break modes.

Note
• All non-touch input calls in Automated Attendant Service will be transferred to the General Delivery Mailbox when the Operator Service is disabled.

Operator Service For Day, Night, Lunch, and Break
Determines the settings for each operator in each time mode. Note that the extension assigned as Operator 1 for day mode is automatically designated as the Message Manager. When operator calls are made, calls are connected to the lowest-numbered operator that is available. To enable/disable the operator setting for each time mode, check/unchecked it.
Note

- Because the extension number assigned for Operator Service No. 1 in the Day Mode is for the Message Manager, you cannot assign this extension to any other mailbox.
- Extensions assigned as operators can be called by dialing [0], however, when setting features such as Message Waiting Notification and Remote Call Forwarding, the extension number (not "0") must be specified.

Default
Enable (checked)

Value Range
Disable (unchecked), Enable (checked)

Feature Manual References
2.2.37  Operator Service

2.4.3.2 Operator Service No. 1, 2, and 3

Operator's Extension
Specifies the extension number for Operator 1, 2, and 3.

Note
- The default extension number of Operator 1 in day mode cannot be used with the Message Waiting Notification Lamp feature.
- Because the extension number assigned as Day Mode Operator 1 is automatically designated as the Message Manager, do not assign this extension number to a mailbox. This extension number is automatically assigned to mailbox number 998.

Default
0 for Operator 1, None for Operator 2 and Operator 3

Value Range
1–5 digits

Feature Manual References
2.2.37  Operator Service

Operator's Mailbox No.
Specifies the mailbox number for Operator 1, 2, and 3. Callers to Operator 1, 2, or 3 are prompted to leave a message in this mailbox depending upon how the Busy Coverage or No Answer Coverage modes are set.

Default
998 for Operator 1, None for Operator 2 and Operator 3

Value Range
2–5 digits
Busy Coverage Mode

Specifies how to handle calls when the operator is busy.

**Default**
Hold

**Value Range**
- **Hold**: Automatically places the caller on hold and the operator is called again.
- **No Answer Coverage**: Offers the option specified by the No Answer Coverage Mode to the caller.
- **Call Waiting**: Signals the operator when another call is waiting using the Call Waiting feature of PBX.
- **Disconnect Message**: Disconnects the caller after playing "Thank you for calling".

Feature Manual References
2.2.37 Operator Service

No Answer Coverage Mode

Specifies how to handle operator calls when they are not answered within the time period set in "Operator No Answer Time".

**Default**
Caller Select

**Value Range**
- **Caller Select**: Allows the caller to leave a message or call another extension. In the following cases, the caller cannot call another extension.
  a. No input to Automated Attendant.
  b. When the "No DTMF Input Operation" setting of a Custom Service is set to "Operator".
- **Leave Message**: Instructs the caller to leave a message in the operator's mailbox.
- **Disconnect Message**: Disconnects the caller after playing "Thank you for calling.".
- **Next Operator**: Transfers the caller to the next operator.

Feature Manual References
2.2.5 Busy Coverage Mode

Operator No Answer Time

When a call to an operator is not answered within the time set, the VPS will offer other options as defined by the "No Answer Coverage Mode".

**Note**
- This time applies to Operator 1, 2, and 3
- If more than one operator is assigned, we recommend to reducing the "Operator No Answer Time" to 15 s.
2.4.3 Parameters

**Call Hold Mode**

**Call Hold Mode**
If set to "Enable" (checked), the VPS gives callers the option of either holding for a specific extension or selecting one of several Incomplete Call Handling Service options. While on hold, the VPS periodically gives callers the choice to either continue to hold or select one of the Incomplete Call Handling Service options. If set to "Disable" (unchecked), the VPS immediately offers callers the Incomplete Call Handling Service and callers are not put on hold. To enable/disable this feature, check/uncheck it.

**Default**
Enable (checked)

**Value Range**
Disable (unchecked), Enable (checked)

**Feature Manual References**
2.2.35 No Answer Coverage Mode

**Call Queuing Announcement Mode**
If set to "Enable", callers on hold are informed of their current position in the call hold queue.

**Example:** "One other person is waiting to connect."

**Default**
Enable

**Value Range**
Disable, Enable

**Feature Manual References**
2.2.23 Hold

**Call Retrieval Announcement Timing**
Specifies the interval between the voice guidance message that asks whether or not calls are to be retrieved during call holding.

**Example:** "To cancel holding, press [2] now. Otherwise, I'll try your party again."
2.4.3 Parameters

Default
10 s

Value Range
1 s–30 s

Feature Manual References
2.2.23 Hold

Redial Cancel Timing
Specifies the interval between the voice guidance messages that ask if continuous redials are to be attempted during call holding.

Example: "To continue holding, press [1]. Otherwise, press [2]."

Default
30 s

Value Range
15 s, 30 s, 45 s, 60 s

Feature Manual References
2.2.23 Hold

Hold Recall Mode
Specifies how the VPS handles a call when the call transfer sequence is Call Transfer without Announcement and the transferred call is not answered.

Default
Return to Top Menu

Value Range
Return to Top Menu, Message Recording

Feature Manual References
2.2.23 Hold

Alternate Extension
Specifies extensions that require a different transfer sequence than normal. Calls to these extensions will be transferred according with the setting for "Alternate Extension Transfer Sequence" in 2.5.4.5 PBX Parameters.
Follow the steps below to edit an alternate extension.
1. Click Click to edit...

[Adding an Alternate Extension]
1. Click the "new" icon.
2. Enter an extension number.
3. Click OK.

[Editing an Alternate Extension]
1. Select the desired alternate extension.
2. Click the edit icon.
3. Edit the extension number.
4. Click OK.

[Deleting an Alternate Extension]
1. Select the desired alternate extension.
2. Click the delete icon.
3. Click Yes.

Note
• Extension Groups and Logical Extensions cannot be assigned.

Default
None

Value Range
Max. 32 extensions (max. 5 digits per extension)

Feature Manual References
2.2.1 Alternate Extension Group

List All Names
If set to "Enable", callers can listen to all subscriber names and extension numbers in Automated Attendant Service or Custom Service.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.2.27 List All Names

2.4.3.3 Rotary Telephone Service
Determines how calls are handled when callers do not dial any numbers in response to VPS guidance (often because they are rotary telephone users).
2.4.3 Parameters

Rotary Telephone Call Coverage for Day, Night, Lunch, and Break service

Determines how calls are handled when callers do not dial any numbers in response to VPS guidance (often because they are rotary telephone users). Callers can be transferred to a preprogrammed extension or mailbox, including an operator or the General Delivery Mailbox.

Default

G.D.M.

Value Range

G.D.M.: The caller is transferred to the General Delivery Mailbox.
Operator: The caller is transferred to an operator.
Mbx: The caller is transferred to the mailbox specified here.
Extn: The caller is transferred to the extension specified here.

Feature Manual References

2.2.41  Rotary Telephone Service

2.4.3.4 Name Entry

Specifies the parameters relating to the Dial by Name feature, which allows to connect themselves with the desired party by entering the first 3 or 4 letters of the party’s name.

Number of Digits to Entry Name

Specifies the number of digits (letters) that must be entered when using the Dial by Name feature.

Default

4

Value Range

3–4 digits

Feature Manual References

2.2.18  Dialing by Name

Name Entry Time Out

Specifies the length of time that the VPS waits for the caller to enter the first 3 digits (letters) of the desired party’s name. If the required number of digits are not dialed within this time, the previous menu will be played again for the caller.

Default

6 s

Value Range

1 s–10 s
Key Mode

Default
North American Standard

Value Range
North American Standard, Australasian Standard

Name Directory Mode
Specifies one of Last Name, First Name, or Both to be used when entering the name.

Default
Last

Value Range
Last, First, Both

2.4.3.5 Toll Saver
Delayed Answer Time for New Message
Specifies the time period before the VPS answers the call when there are new messages.

Default
12

Value Range
5 s–60 s

Delayed Answer Time for No New Messages
Specifies the time period before the VPS answers the call when there is no new messages.
2.4.3 Parameters

Default
24

Value Range
5 s–60 s

Programming Manual References
2.1.10 Automatic Login

Feature Manual References
2.3.31 Toll Saver (APT/DPT Integration Only)
2.4.4 Custom Service

Allows callers to perform specific functions by pressing dial buttons on their telephones while listening to voice guidance (Custom Service Menu). Custom Services allow callers to connect themselves to an extension, mailbox, Mailbox Group, operator, fax machine, etc., without the assistance of an operator. Custom Service Menu ("Press 1 for Sales, press 2 for Service...", etc.) can be recorded by the System Administrator or the Message Manager, and can be recorded in several languages if needed. The System Administrator can create a maximum of 100 Custom Services.

Common uses for Custom Services include:
– callers press a button to connect themselves with the desired destination
– callers press buttons to navigate through a series of other Custom Services before being connected with the desired destination
– callers enter PIN numbers to connect themselves with the desired destination (PIN Call Routing)
– callers enter the first few letters of the desired parties (Dial by Name) to connect themselves with the desired destination

2.4.4.1 Custom Service Builder

The Custom Service Builder is a utility that allows the System Administrator to create Custom Services visually. Each Custom Service and its functions can be edited, arranged using a familiar drag-and-drop interface.

The following Custom Service types are available:
– Menu & Transfer
– Date Control
– Time Control
– Day Control
– Password
**2.4.4 Custom Service**

[Creating a Custom Service]

1. Click the desired Custom Service type under **Custom Service Type**.
2. Drop the Custom Service icon.
   - The Custom Service parameters dialog box will open.
3. Edit the parameters in the Custom Service parameters dialog box.
4. Click **OK**.
[Editing a Custom Service]

Custom Services parameters can be connected to other Custom Services. To connect a parameter to another Custom Service, click and hold the parameter’s blue handle, drag it to the desired Custom Service, then release the mouse button.

You can edit each Custom Service in the following ways.

[From the Custom Service List]
1. Enter the desired Custom Service number under Quick Search: and click Edit Custom....
2. Edit the parameters in the Custom Service parameters dialog box.
3. Click OK.

[From the Custom Service Diagram]
1. Double-click the desired Custom Service icon in the diagram, or right-click on the desired icon and select **Edit**.

2. Edit the parameters in the Custom Service parameters dialog box.

3. Click **OK**.

Example: Setting "Menu & Transfer"

1. Click **Menu & Transfer** under **Custom Service Type**: and drag it to the right side of the screen. The cursor will change to .

2. Drop **Menu & Transfer** on where it should be in the Custom Service diagram. The parameters dialog box for the Custom Service opens.

![Diagram of the Custom Service parameters dialog box](image-url)
3. Enter or select a value for each item.
   For each parameter, refer to the description in the following section.

4. Click **Record A Prompt For This Custom Service**...
   This feature is only available when setting "Menu & Transfer" or "Password". You can also skip this step, and go to step 7.

5. Select "Record from extension" or "Import from recorded file".
   *When "Record from extension" is selected*
   1. Specify the extension number of the telephone used for recording, then click **Connect**.
   2. When the specified extension rings, go off-hook.
3. Click (record), (stop), or (play) to record or play a voice label through the extension.
4. Click Disconnect.
5. Click OK.

When "Import from recorded file" is selected
1. Click the folder icon.
   The Open dialog box appears.
2. Navigate to the folder containing the WAV files you want to open.
   (WAV files must meet the following specifications: IMA ADPCM codec, 8.000 kHz, 4 bit, mono.)
3. Select the desired WAV file.
4. Click Open to import the file.

Note
   • The Message Manager can also use his or her telephone to record a prompt for this Custom Service (see 3.6 Recording Messages in the Manager’s Manual).

6. Click OK.
7. Click OK.

Feature Manual References
2.4.2 Custom Service Builder

2.4.4.2 Menu & Transfer

This Custom Service type guides callers to press certain buttons to connect themselves with the designated party. The prompt for this service can be recorded in the CS No. dialog box.

Description
The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.16 Custom Service

Prompt Mode
Specifies the language for prompts used by this Custom Service.

Note
   • This parameter overrides "Incoming Call Service Prompt".
   • If "Primary" is selected, the default language which is selected from all installed languages will be used.
   • If "None" is selected, the prompt mode of previous process will be continued, or "Primary" language will be selected.
**Default**
Primary

**Value Range**
None, Primary, Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: No. 1-10)

**Programming Manual References**
"Incoming Call Service Prompt" in 2.3.1.1 Call Service

**Feature Manual References**
2.2.16 Custom Service

**Menu Repeat Cycle**
Specifies the number of times the Custom Service menu message will be repeated for the caller.

**Default**
3

**Value Range**
1–3 times

**Feature Manual References**
2.2.16 Custom Service

**Call Transfer Anytime**
Specifies the type of dialing that the VPS accepts during the Custom Service in addition to the single-digit Custom Service options. This setting allows callers to dial numbers to connect themselves to an extension or mailbox or enter a PIN.

**Note**
- If you only need to allow callers to dial single-digit Custom Service option numbers, set this parameter to "No". When set to a value other than "No", the VPS always waits for the amount determined by the "Wait for Second Digit" setting before handling the call. This will cause a delay between the time the caller dials a single-digit Custom Service option number and when the call is actually handled.

**Default**
Extn

**Value Range**
- **Extn**: enables callers to be transferred directly to their intended party by dialing the extension number.
- **Mbx**: enables callers to leave messages in a mailbox by entering the mailbox number.
- **PIN**: enables callers to be transferred directly to the specified party according to the setting for PIN Call Routing Service by dialing PIN.
- **No**: disables extension transfer and mailbox transfer; only 1-digit entries will function (following the Custom Service menu)
2.4.4 Custom Service

Feature Manual References
2.2.16 Custom Service

Wait for First Digit
Specifies the length of time that the VPS waits for the caller to dial the first digit after a Custom Service menu is played for the caller. If this time expires, the No DTMF Operation settings determines how the call is then handled. If this parameter is set to "0", No DTMF Input Operation handles the call immediately after the menu is played for the caller.

Default
6 s

Value Range
0 s–10 s

Feature Manual References
2.2.16 Custom Service

Wait for Second Digit
This parameter is only valid when "Call Transfer Anytime" is set to a value other than "No". After the caller dials a digit (the first digit) after listening to a Custom Service menu, the VPS waits for a second digit to be dialed. This gives the caller time to continue dialing a mailbox number, extension number, or PIN. If this time expires without a second digit being entered, the VPS assumes the caller has selected a Custom Service menu option and handles the call according to the digit dialed by the caller.

Default
1 s

Value Range
1 s–5 s

Feature Manual References
2.2.16 Custom Service

No DTMF Input Operation
Determines how calls are handled when callers do not dial any numbers after listening to the menu message (most likely because they are using rotary telephones) The default setting is "Operator", which allows the caller to be automatically connected to an operator after the menu message plays back ("Press the desired number, or stay on the line to be connected to an operator.").

Default
Operator

Value Range
Trf to Mbx: Allows the caller to leave messages in a specified mailbox.
Trf to Extn: Transfers the caller to a specified extension.
Operator: Connects the caller to an operator.
**Trf to Out**: Transfers the caller to a specified outside telephone number. Enter the trunk (CO line) access number of the PBX then the destination telephone number.

**Exit**: Plays the Custom Service exit prompt and disconnects the caller.

**Prev Menu**: Returns the caller to the previous menu (if there was a previous menu).

**Cust Serv**: Transfers the caller to the Custom Service specified here.

**Feature Manual References**

2.2.16 Custom Service

**Keypad Assignment 0–9, *, #**

Any of the 16 operations listed below can be assigned to the 0 through 9, *, and # keys on the telephone keypad. Callers are able to access these operations by pressing the corresponding keys on their telephones.

**Default**

* : Exit
0: Operator
Others: None

**Value Range**

**Trf to Mbx**: Allows the caller to leave messages in a specified mailbox.

**Trf to Extn**: Transfers the caller to a specified extension.

**Operator**: Connects the caller to an operator.

**Trf to Out**: Transfers the caller to a specified outside telephone number. Enter the trunk (CO line) access number of the PBX then the destination telephone number.

**Exit**: Plays the Custom Service exit prompt and disconnects the caller.

**Prev Menu**: Returns the caller to the previous menu (not available if there was no previous menu).

**Cust Serv**: Transfers the caller to the Custom Service specified here.

**VM Serv**: Allows the caller to access Voice Mail Service.

**Call Trf Serv**: Allows the caller to access Automated Attendant Service.

**Subscr Serv**: Allows the caller to access the Subscriber Service. The caller needs to press the assigned key followed by the mailbox number that he or she wants to log in. If this option is enabled, it is strongly recommended that each subscriber set a password for his or her mailbox; this will prevent unauthorized callers from accidentally or intentionally accessing subscribers' mailboxes.

**Dial by Name**: Requests the caller to enter the first 3 or 4 letters of a first or last name of the person the caller wishes to reach, then transfers the caller to the corresponding extension.

**Repeat Menu**: Repeats the Custom Service menu.

**Main Menu**: Returns the caller to the Custom Service top menu.

**Fax Trf**: Allows the caller to send fax messages to an extension specified as the fax extension. Fax Management must also be configured (see 2.5.4.10 Fax Management).

**List All Names**: The VPS will announce the names and extensions numbers of all subscribers (except those whose Class of Service "Directory Listing" parameter is set to "No").

**None**: No operation assigned.

**Example: Assigning key [1] to transfer to extension 101**

<table>
<thead>
<tr>
<th>Key</th>
<th>Assigned Operation</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Operator</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Trf to Extn</td>
<td>101</td>
</tr>
</tbody>
</table>

1. Click the check box next to key [1].
2. Select "Trf to Extn" in the "Assigned Operation" column.
3. Enter "101" in the "Value" column.
Example: Canceling the setting for key [1]

<table>
<thead>
<tr>
<th>Key</th>
<th>Assigned Operation</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Operator</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Trf to Extn</td>
<td>101</td>
</tr>
</tbody>
</table>

1. Clear the check box next to key [1].

Feature Manual References
2.2.16 Custom Service

2.4.4.3 Date Control

This service allows you to assign a different operation for up to 5 time periods. The caller makes no selection and no menu is announced.

Description
The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.16 Custom Service

Period 1–5, Outside

<Period 1–5>
Specifies the name of date period for reference, start and end date, and an operation.

<Outside>
Allows you to specify an operation that is enabled on all other dates not included in the set periods.

Default
None

Value Range

<Period 1–5>
Name: Max. 16 characters
Date: MM/DD (MM: Month, DD: Day)
Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see "Keypad Assignment 0–9, *, #" in 2.4.4.2 Menu & Transfer)

<Outside>
Name: Max. 16 characters
Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see "Keypad Assignment 0–9, *, #" in 2.4.4.2 Menu & Transfer)

Feature Manual References
2.2.16 Custom Service

2.4.4.4 Time Control

This service allows you to assign a different operation for up to 5 blocks of time during the day. The caller makes no selection and no menu is announced.

Description
The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.16 Custom Service

Period 1, Outside

<Period 1–5>
Specifies the name of time period for reference, start and end time, and an operation.

Note
• When the start time is specified and the end time is "Not set", the period will end at "00:00".

<Outside>
Allows you to specify an operation that is enabled for all other times not included in the set time periods.

Default
None

Value Range

<Period 1–5>
Name: Max. 16 characters
Time: HH:MM (HH: Hour, MM: Minute)
Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see "Keypad Assignment 0–9, *, #" in 2.4.4.2 Menu & Transfer)

<Outside>
Name: Max. 16 characters
2.4.4 Custom Service

Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see "Keypad Assignment 0–9, *, #" in 2.4.4.2 Menu & Transfer)

Feature Manual References
2.2.16 Custom Service

2.4.4.5 Day Control

This service allows you to assign a different operation for each day of the week, and for all holidays. The caller makes no selection and no menu is announced.

Description

The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Feature Manual References
2.2.16 Custom Service

Sunday–Saturday, Holiday

Specifies a service for each day of the week and for all holidays.

Note

- If an operation is assigned to "Holiday" here, either one of the following settings is required in order to activate the operation for "Holiday" Custom Service:
  a. In "Service Settings" → "Holiday Settings" → the desired "Holiday Service" → "Service", select "Custom Service Menu" and specify the number of this Date Control—"Holiday" Custom Service, or the number of its higher layered Custom Service.
  b. Assign the desired Date Control—"Holiday" Custom Service or its higher layered Custom Service to the desired Port/Trunk (see 2.3.1 Service Group).
    In "Service Settings" → "Holiday Settings" → the desired "Holiday Service" → "Port Affected/Trunk Affected", exclude the Port/Trunk numbers that are assigned to the Date Control—"Holiday" Custom Service or the number of its higher layered Custom Service.

Default
None

Value Range
Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see "Keypad Assignment 0–9, *, #" in 2.4.4.2 Menu & Transfer)
2.4.4.6 Password

This service requires that callers enter a password, followed by "]". Each password is assigned an operation. If a password is entered correctly, the caller is handled by the password’s preprogrammed operation. The prompt for this service can be recorded in the CS No. dialog box.

Description

The information typed in this field is for reference only.

Default
None

Value Range
Max. 32 characters

Menu Repeat Cycle

Specifies the number of times the Custom Service menu message will be repeated to the caller.

Default
1

Value Range
1–3 times

Wait for First Digit

Specifies the length of time that the VPS waits for the caller to dial the first digit after a Custom Service menu is played for the caller. If this time expires, the No DTMF Operation setting determines how the call is then handled.

Default
6 s

Value Range
1 s–10 s
Feature Manual References
2.2.16 Custom Service

Maximum Number of Invalid Entry
Specifies the number of times an invalid password is entered before the operation assigned for "Entry Failure" is executed.

Default
3

Value Range
1–10 times

Feature Manual References
2.2.16 Custom Service

No DTMF Input Operation
Determines how calls are handled when callers do not dial any numbers in response to VPS guidance (often because they are rotary telephone users). The default setting is "Operator", which allows the caller to be automatically connected to an operator after the message is played.

Default
Operator

Value Range
Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv (see "No DTMF Input Operation" in 2.4.4.2 Menu & Transfer)

Feature Manual References
2.2.16 Custom Service

Entry Failure
Determines what operation is activated when a caller enters an invalid password X times. (X= the value set for "Maximum Number of Invalid Entry")

Default
Exit

Value Range
Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names (see "Keypad Assignment 0–9, *, #" in 2.4.4.2 Menu & Transfer)

Feature Manual References
2.2.16 Custom Service
Pass1–5, Cancel

<Password 1-5>
Specifies a password and an operation for the specified password.

<Cancel>
Determines the operation that is activated when a caller presses "#" to cancel password entry.

Default
None

Value Range

<Pass1–5>
Password: Max. 12 digits
Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see "Keypad Assignment 0–9, *, #" in 2.4.4.2 Menu & Transfer)

<Cancel>
Operation: Trf to Mbx, Trf to Extn, Operator, Trf to Out, Exit, Prev Menu, Cust Serv, VM Serv, Call Trf Serv, Subscr Serv, Dial by Name, Repeat Menu, Main Menu, Fax Trf, List All Names, None (see "Keypad Assignment 0–9, *, #" in 2.4.4.2 Menu & Transfer)

Feature Manual References
2.2.16 Custom Service
2.5 System Parameters

System Parameters are divided into the following screens:

- Mailbox Group
- Extension Group
- System Caller Name Announcement
- Parameters

Click each tab at the bottom of the System Parameters screen to edit the parameters.
Each parameter setting can be sorted in either ascending or descending by clicking the header. Sorting is not available for the "Parameters" tab.

2.5.1 Mailbox Group

Also called System Group Distribution Lists.
Mailbox Groups allow a caller or subscriber to record a message and have it sent to several mailboxes.
Messages sent to a Mailbox Group are sent to all subscribers in the group. The VPS can maintain a maximum of 20 Mailbox Groups. Each group can have a maximum of 62 members for KX-TVA50 or 100 members for KX-TVA200. Only the System Administrator can create or edit Mailbox Groups. (Each subscriber can create and edit his or her own Personal Group Distribution Lists.)

Follow the steps below to edit a Mailbox Group.
[Adding a Group]
1. Click Add....
2. Enter a group number and a group name.
3. Click OK.

[Deleting a Group]
1. Select the desired group number.
2. Click Delete.
3. Click Yes.

[Editing a Group]
1. Select the desired group number.
2. Click Edit....
4. Click OK.

[Adding Mailboxes to a Group]
1. Select the desired group number.
2. Click Add....
3. Enter a mailbox number in **Quick Search Mailbox**: or select the mailbox number in **Subscribers to add** table.

4. Click **Add >>**.
5. Click **OK**.

**[Deleting Mailboxes from a Group]**
1. Select the desired mailbox number.
2. Click **Delete**.
3. Click **Yes**.

**[Searching for Subscribers]**
1. Click **Search Subscribers...**.
2. Enter the Mailbox No., Extension No., First Name, or Last Name of the desired subscriber.
3. Click **OK**.

**[Recording a Name for the Group in the Edit Mailbox Group dialog box]**
1. Select the desired Mailbox Group and click **Edit....**
   - Before you can record, confirm that there is at least 1 member in the group and that you have clicked “Apply” since adding members to the group.
2. Select "Record from extension" or "Import from recorded file".
   **When "Record from extension" is selected**
   1. Specify the extension number of the telephone used for recording, then click **Connect**.
   2. When the specified extension rings, go off-hook.
   3. Click (record), (stop), or (play) to record or play a voice label through the extension.
   4. Click **Disconnect**.
   5. Click **OK**.
   **When "Import from recorded file" is selected**
1. Click the folder icon. The Open dialog box appears.
2. Navigate to the folder containing the WAV files you want to open.
   (WAV files must meet the following specifications: IMA ADPCM codec, 8.000 kHz, 4 bit, mono.)
3. Select the desired WAV file.
4. Click Open to import the file.
3. Click OK.

**Group List No.**

Specifies the Mailbox Group number. This number is similar to a mailbox number and is used to send a message to all subscribers of the group. It must be a unique number; no other group or mailbox can be assigned this number.

**Default**

None

**Value Range**

2–5 digits

**Feature Manual References**

2.3.13 Group Distribution List—System

**Group Name**

Specifies the group name.

**Default**

None

**Value Range**

Max. 32 characters

**Feature Manual References**

2.3.13 Group Distribution List—System
2.5.2 Extension Group

An Extension Group is a group of extensions that share a common mailbox. Each group has an Extension Group number. If the group number is assigned as the owner of a mailbox, then all members cannot be assigned their own personal mailboxes. Up to 20 Extension Groups can be created, and each group can consist of 100 extensions (members). You can add, delete, and review the extensions. Members of an Extension Group are able to share the same mailbox and be notified by the Message Waiting Notification–Lamp feature when a message is received.

Follow the steps below to edit an Extension Group.

[Adding a Group]
1. Click Add....
2. Enter a group number and a group name.
3. Click OK.

[Deleting a Group]
1. Select the desired group number.
2. Click Delete.
3. Click Yes.
[Editing a Group]
1. Select the desired group number.
2. Click Edit....
4. Click OK.

[Adding Extensions to a Group]
1. Select the desired group number.
2. Click Add....
3. Enter an extension number in Extension Number:.
4. Click OK.

[Deleting Extensions from a Group]
1. Select the desired extension number.
2. Click Delete.
3. Click Yes.

[Recording a Name for the Group in the Edit Extension Group dialog box]
1. Select the desired Extension Group and click Edit....
   • Before you can record, confirm that there is at least 1 member in the group and that you have clicked "Apply" since adding members to the group.
2. Select "Record from extension" or "Import from recorded file".
   When "Record from extension" is selected
   1. Specify the extension number of the telephone used for recording, then click Connect.
   2. When the specified extension rings, go off-hook.
3. Click [record], [stop], or [play] to record or play a voice label through the extension.

4. Click Disconnect.

5. Click OK.

When "Import from recorded file" is selected

1. Click the folder icon.
   The Open dialog box appears.

2. Navigate to the folder containing the WAV files you want to open.
   (WAV files must meet the following specifications: IMA ADPCM codec, 8.000 kHz, 4 bit, mono.)

3. Select the desired WAV file.

4. Click Open to import the file.

3. Click OK.

Group List No.

Specifies the Extension Group number.

Note

• In order to configure an Extension Group, set a group number here, then assign the group number as the owner of a mailbox. The Extension Group number is effectively the extension number that is the owner of the group’s mailbox.

Default

None

Value Range

2–5 digits

Feature Manual References

2.2.21 Extension Group

Group Name

Specify the group name.

Default

None

Value Range

Max. 32 characters

Feature Manual References

2.2.21 Extension Group
2.5.3 System Caller Name Announcement

Allows the System Administrator to store a maximum of 200 telephone numbers and record a caller name for each telephone number. The caller name is announced when playing a message in their mailbox from one of the preprogrammed callers, when the VPS transfers a call to the subscriber from one of the preprogrammed callers (Caller ID Screening), and when the VPS pages the subscriber by intercom (Intercom Paging).

Caller ID Screening feature is only available when the "Caller ID Screen" parameter of the subscriber’s Class of Service is set to "Yes". This feature is also enabled when subscribers select "Call Screening" as the Call Transfer method (see 5.1 Call Transfer in the Subscriber’s Manual).

The Intercom Paging feature is enabled by selecting "Intercom Paging" as the Call Transfer method (see 5.1 Call Transfer and/or 5.2 Incomplete Call Handling in the Subscriber’s Manual).

Follow the steps below to edit System Caller Name Announcements.

[Adding a Caller ID No.]
1. Click Add...
2. Enter a Caller ID number and description.
3. Click OK.

[Deleting a Caller ID No.]
1. Select the desired Caller ID number.
2. Click Delete.
3. Click Yes.

[Editing a Caller ID No.]
1. Select the desired Caller ID number.
2. Click Edit....
3. Edit parameters in the Caller Information dialog box.
4. Click OK.

[Recording the Caller's Name in the Caller Information dialog box]
1. Select the desired Caller ID number and click Edit....
   • Before you can record, confirm that you have clicked "Apply" since you added the Caller ID No.
2. Select "Record from extension" or "Import from recorded file".
   When "Record from extension" is selected
   1. Specify the extension number of the telephone used for recording, then click Connect.
   2. When the specified extension rings, go off-hook.
   3. Click (record), (stop), or (play) to record or play a voice label through the extension.
   4. Click Disconnect.
   5. Click OK.
When "Import from recorded file" is selected
1. Click the folder icon.
   The Open dialog box appears.
2. Navigate to the folder containing the WAV files you want to open.
   (WAV files must meet the following specifications: IMA ADPCM codec, 8.000 kHz, 4 bit, mono.)
3. Select a file to import.
4. Click Open to import the file.
3. Click OK.

Caller-ID No.
Assigns the telephone number for which the VPS announces the prerecorded caller name to extension users.

Default
None

Value Range
Max. 20 digits consisting of 0–9

Feature Manual References
2.2.11 Caller Name Announcement—System (APT/DPT Integration Only)

Description
Enters a name and/or description of the Caller ID number.

Default
None

Value Range
Max. 20 characters
Feature Manual References

2.2.11 Caller Name Announcement—System (APT/DPT Integration Only)
2.5.4 Parameters

The following settings can be made in the Parameters tab of the System Parameters screen:
– Time Setting
– Prompt Setting
– PBX Parameters
– Dialling Parameters
– Message Waiting Notification
– External Message Delivery
– Intercom Paging Parameters
– Fax Management
– Disconnect Parameters
– Transfer to Outside
– VM Menu
– E-mail Integration
## 2.5.4.1 Time Setting

Adjusts the internal clock of the VPS.

### System Clock

Specifies the system date, time, and related features.

### System Date/Time

Specifies the system date and time.

**Value Range**

Date: MM/DD/YYYY (MM: Month, DD: Day, YYYY: Year)

Time: HH:MM (HH: Hour, MM: Minute)
Feature Manual References

2.2.44  System Clock

**Format**

Specifies the time format (12-hour or 24-hour).

**Note**

- The selected time format (12-hour or 24-hour) affects the time format of reports, the VM Menu feature, as well as the time that appears in e-mail notifications for new messages.

**Default**

12 H

**Value Range**

12 H, 24 H

**PBX Synchronization**

Specifies whether to synchronize the VPS clock with the clock of the PBX.

**Note**

- Time Synchronization is only available when the VPS is connected to a Panasonic KX-T series PBX using DPT Integration.

**Default**

Synchronize

**Value Range**

Synchronize, Not Synchronize

Feature Manual References

2.4.10  Time Synchronization (DPT Integration Only)

**Daily Hours Setting**

Specifies the starting time of the morning, afternoon and evening greetings used for the Company Greeting.

**Morning Hours Start Time**

Specifies the starting time of the morning greeting.

**Default**

03:00

**Value Range**

HH:MM (HH: Hour, MM: Minute)
Afternoon Hours Start Time

Specifies the starting time of the afternoon greeting.

Default
12:00

Value Range
HH:MM (HH: Hour, MM: Minute)

Feature Manual References
2.2.13  Company Greeting

Evening Hours Start Time

Specifies the starting time of the evening greeting.

Default
18:00

Value Range
HH:MM (HH: Hour, MM: Minute)

Feature Manual References
2.2.13  Company Greeting

Daylight Saving Time

Specifies whether to use daylight saving time. If "Enter Time Frame" is selected, both the starting date and ending date must be set. The same date cannot be used for both settings. The clock adjusts itself from 2 am to 3 am on the starting date, and adjusts itself from 2 am to 1 am on the ending date.

IMPORTANT
If the VPS clock is synchronized with the PBX clock (see "2.4.10  Time Synchronization (DPT Integration Only)" in the Feature Manual), the daylight saving time setting of the VPS is not used. Adjust the PBX for daylight saving time as necessary.

Default
None

Value Range
None
Enter Time Frame (Start Date, End Date): MM/DD (MM: Month, DD: Day)

Feature Manual References
2.2.17  Daylight Saving Time Assignment
2.5.4.2 Prompt Setting

This setting is required when Multilingual Service is enabled.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Setting</td>
<td></td>
</tr>
<tr>
<td>Prompt Setting</td>
<td></td>
</tr>
<tr>
<td>Primary Language</td>
<td>Guidance No. 1 [English (US)]</td>
</tr>
<tr>
<td>Language 1</td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>None</td>
</tr>
<tr>
<td>DTMF</td>
<td>None</td>
</tr>
<tr>
<td>Language 2</td>
<td></td>
</tr>
<tr>
<td>Language 3</td>
<td></td>
</tr>
<tr>
<td>Language 4</td>
<td></td>
</tr>
<tr>
<td>Language 5</td>
<td></td>
</tr>
<tr>
<td>Selection Menu Wait Time (0.20 s)</td>
<td>6</td>
</tr>
<tr>
<td>Selection Menu Repeat Cycle (1-3 times)</td>
<td>1</td>
</tr>
<tr>
<td>Delay Time After Connected Received for Incoming (0-10 s)</td>
<td>0</td>
</tr>
<tr>
<td>Delay Time After Connected Received for Outgoing (0-10 s)</td>
<td>1</td>
</tr>
<tr>
<td>System Guidance (1-10)</td>
<td>Click to edit...</td>
</tr>
<tr>
<td>PBX Parameters</td>
<td></td>
</tr>
<tr>
<td>Dialling Parameters</td>
<td></td>
</tr>
<tr>
<td>Message Waiting Notification</td>
<td></td>
</tr>
<tr>
<td>External Message Delivery</td>
<td></td>
</tr>
<tr>
<td>Intercom Paging Parameters</td>
<td></td>
</tr>
<tr>
<td>Fax Management</td>
<td></td>
</tr>
<tr>
<td>Disconnect Parameters</td>
<td></td>
</tr>
<tr>
<td>Transfer to Outside</td>
<td></td>
</tr>
<tr>
<td>VM Menu</td>
<td></td>
</tr>
<tr>
<td>Number of ports for VM Menu Service (0-24)</td>
<td>12</td>
</tr>
<tr>
<td>E-mail Integration</td>
<td></td>
</tr>
</tbody>
</table>

Primary Language

Specifies the default language to be used when another language is not selected in the Multilingual Selection Menu.

Default

English (US)

Value Range

Guidance No. (KX-TVA50: No. 1-3, KX-TVA200: No. 1-10)
2.5.4 Parameters

Feature Manual References
2.2.34 Multilingual Service
2.2.45 System Prompts

2.5.4.3 Language 1–5 (KX-TVA200), 1–3 (KX-TVA50)
Assigns a selection number (1–9) to each language. Callers use the numbers to select the desired languages for their message prompts. This setting is required when either one or both of the following parameters are set to "Selective":

a. "Prompt Mode" (see 2.1.5 External Message Delivery)
b. "Incoming Call Service Prompt", "Prompt for Rotary Callers" (see 2.3.1.1 Call Service)

Language
Specifies a language.

Default
None

Value Range
Selection from all installed languages (KX-TVA50: 3 languages, KX-TVA200: 10 languages)

Feature Manual References
2.2.45 System Prompts

DTMF
Specifies a selection number.

Default
None

Value Range
1–9/None

Selection Menu Wait Time
Specifies the length of time that the VPS waits for the caller to select a language by pressing the appropriate dial key. If this time period expires without the selection number being entered, the VPS uses the Primary Language.

Default
6 s

Value Range
0 s–20 s

Feature Manual References
2.2.45 System Prompts
Selection Menu Repeat Cycle
Specifies the number of times the VPS will play the Multilingual Selection Menu.

Default
1

Value Range
1–3 times

Feature Manual References
2.2.34 Multilingual Service

Delay Time After Connected Received for Incoming
Specifies the length of time (in seconds) that the VPS waits after the line is connected for incoming calls before playing the prompt.

Default
0 s

Value Range
0 s–10 s

Feature Manual References
2.2.45 System Prompts

Delay Time After Connected Received for Outgoing
Specifies the length of time (in seconds) that the VPS waits after the line is connected for outgoing calls before playing the prompt.

Default
1 s

Value Range
0 s–10 s

Feature Manual References
2.2.45 System Prompts

2.5.4.4 System Guidance
Specifies the parameters which vary depending on the language assigned as the System Guidance language. Follow the steps below to edit System Guidance.

1. Click Click to edit....
2. Select the desired Guidance No.
3. Edit each parameter.
4. Click OK.
Select Language

Position of "AM/PM" in Time Stamp

Specifies the position of the "AM/PM" announcement.

**Default**

After (when the "Primary Language" is set to "English (US)")

**Value Range**

- **Before**: the VPS announces "AM/PM" before the time, such as P.M. 3:42.
- **After**: the VPS announces "AM/PM" after the time, such as 3:42 P.M.
- **24-h**: the VPS announces the time in 24-h format, such as 15:42.

"O’clock" Prompt

Specifies when and if "O’clock" is announced.

**Default**

When 0 min (when the "Primary Language" is set to "English (US)")

**Value Range**

- **When 0 min**: the VPS announces "O’clock" only on the hour, such as "one o’clock".
- **Always**: the VPS announces "O’clock" always.
- **None**: No announcement

Month/Day Prompt

Specifies the order of the month and day for date announcements.

**Default**

MM:DD (when the "Primary Language" is set to "English (US)")

**Value Range**

- **MM:DD**: Month and Day
- **DD:MM**: Day and Month

# Announcement Mode

Specifies the way of announcement for the "#" character when "English (US)" or "English (UK)" is selected as System Guidance.

**Default**

POUND (when the "Primary Language" is set to "English (US)")

**Value Range**

POUND, HASH
2.5.4.5 PBX Parameters

Specifies the parameters used to program the VPS for optimal signaling and performance with the PBX.

### PBX Environment

Specifies how the VPS will initiate and control call transfers, setup outgoing calls, and control message waiting lamps on extensions. For KX-TVA50, the procedure for verifying the correct code sequences for non-Panasonic KX-T series PBX is to manually execute the sequences from a single line telephone (SLT) with the PBX.

### PBX Type

Specifies the type of PBX connected to the VPS.

**Default**

KX-TDA/TAW/TDE
2.5.4 Parameters

Value Range
KX-TDA/TAW/TDE, KX-TD1232/TD816/TA1232, KX-TD308, KX-TD500, KX-TA624/824, Other PBX

*1 The value range varies depending upon country/area and the VPS model (KX-TVA50/KX-TVA200). Consult your dealer for more details.

Integration Mode

Specifies the method of integrating the VPS with the PBX.
Note that DPT Integration is the only available integration mode for KX-TVA200.

Default
DPT

Value Range

Inband: The PBX sends DTMF signals to the VPS to indicate the status of calls (busy, answered, disconnect, etc.). The DTMF code for each status must be set in the Inband Signaling Parameters; the settings of the PBX and VPS must match. If the PBX type is set to a KX-T series PBX, the Inband Signaling Parameters will automatically default to the proper codes. This is available with any of the following Panasonic KX-T series PBXs: KX-TDA/TAW/TDE, KX-TD816, KX-TD1232/TA1232, KX-TA624, KX-TA824, KX-TD500, and KX-TD308.

DPT: The VPS communicates with the PBX via the DPT interface. This is available with any of the following Panasonic KX-T series PBXs: KX-TDA/TAW/TDE, KX-TD816, KX-TD1232/TA1232, KX-TD500, and KX-TD308.

APT: The VPS communicates with the PBX via the APT Interface. This is available with any of the following Panasonic KX-T series PBXs: KX-TA624 and KX-TA824.

Feature Manual References

APT Integration (KX-TVA50 only)
DPT Integration
Inband Integration (KX-TVA50 only)

Maximum Extension Number Length

Set this parameter to match the maximum number of digits which the connected PBX recognizes as an extension number.

Default
3

Value Range

2–8 digits

Extension Number of VPS Port

Specifies the PBX extension number of the port connected to the VPS. When configuring the VPS via the Auto Configuration feature, this parameter is set automatically.

Default
None
Value Range
2–5 digits

Feature Manual References
2.4.1 Auto Configuration (APT/DPT Integration Only)

Operator Transfer Sequence
Specifies the sequence for transferring calls to an operator’s extension.

Default
FX

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,,: Dial Pause (default 1 s)
;;: Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code

Extension Transfer Sequence
Specifies the sequence for transferring calls to any extension except an operator’s extension.

Default
FX

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,,: Dial Pause (default 1 s)
;;: Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code

Alternate Extension Transfer Sequence
Specifies the sequence for transferring calls to extensions in the Alternate Extension Group.

Default
FX

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
### Reconnect Sequence on Busy

Specifies the sequence for reconnecting to the caller if the called extension is busy.

**Default**

F

**Value Range**

Max. 16 digits consisting of 0–9, *, # and special codes

D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
;: Dial Pause (default 1 s)
:: Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code

### Reconnect Sequence on No Answer

Specifies the sequence for reconnecting to the caller if the called extension does not answer.

**Default**

F

**Value Range**

Max. 16 digits consisting of 0–9, *, # and special codes

D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
;: Dial Pause (default 1 s)
:: Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code

### Reconnect Sequence on Refuse Call

 Specifies the sequence for retrieving a call placed on hold after the extension (in Call Screening mode) has refused to accept it.
2.5.4 Parameters

Default
F

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,: Dial Pause (default 1 s)
;: Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code

Light-On Sequence for Message Waiting Lamp
Specifies the sequence for turning on the Message Waiting Lamp at an extension.

Default
None

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,: Dial Pause (default 1 s)
;: Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code

Feature Manual References
2.2.33 Message Waiting Notification—Lamp

Light-Off Sequence for Message Waiting Lamp
Specifies the sequence for turning off the Message Waiting Lamp at an extension.

Default
None

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,: Dial Pause (default 1 s)
;: Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code
2.5.4 Parameters

Feature Manual References
2.2.33 Message Waiting Notification—Lamp

Message Waiting Lamp Retry Time
Specifies the number of times the VPS will retry turning on/off the Message Waiting Lamp of an extension. This parameter is enabled only when the integration mode is None or Inband mode.

Default
2

Value Range
0–5 times

Feature Manual References
2.2.33 Message Waiting Notification—Lamp

Message Waiting Lamp Interval Time
Specifies the time between retries when the VPS retries turning on/off the Message Waiting Lamp of an extension. This parameter is enabled only when the integration mode is None or Inband mode.

Default
1

Value Range
1 min–60 min

Feature Manual References
2.2.33 Message Waiting Notification—Lamp

Call Waiting Sequence
Specifies the sequence for performing Call Waiting if the called extension is busy.

Default
1

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,: Dial Pause (default 1 s)
;; Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code
Release Sequence for Call Waiting

Specifies the sequence for releasing Call Waiting.

**Default**
F

**Value Range**
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,: Dial Pause (default 1 s)
:: Dial Pause (default 3 s)
X: Extension Dialing
0–9, *, #: Dial Code

Receiving Caller ID

Enables or disables the VPS to receive Caller ID from the PBX while receiving a call.

**Default**
Enable

**Value Range**
Disable, Enable

Waiting Time for Receiving Caller ID

Specifies the length of time that the VPS waits before receiving Caller ID from the PBX. This parameter is needed only when "Enable" is selected in "Receiving Caller ID".

**Default**
0 s

**Value Range**
0 s–10 s

Inband Signaling

Set these parameters only if the Integration Mode is set to "Inband" under "PBX Environment". If the PBX type is set to a KX-T series PBX, the Inband Signaling parameters will be automatically set to the default codes for the KX-T series PBX.

**Note**
- Default values below vary depending on the setting of "PBX Type" in "PBX Environment".

Ringback

Specifies the DTMF signal used to indicate a ringback tone. Sent to the VPS when the extension dialed is ringing.
2.5.4 Parameters

**Default**

1

**Value Range**

Max. 16 digits consisting of 0–9, *, #, and A–D

**Busy**

Specifies the DTMF signal used to indicate a busy tone. Sent to the VPS when the called extension is busy.

**Default**

2

**Value Range**

Max. 16 digits consisting of 0–9, *, #, and A–D

**Reorder**

Specifies the DTMF signal used to indicate a reorder tone. Sent to the VPS when the VPS dials an invalid extension number or when the VPS dials a port number of the PBX that is connected to the VPS (i.e., the VPS calls itself).

**Default**

3

**Value Range**

Max. 16 digits consisting of 0–9, *, #, and A–D

**DND**

Specifies the DTMF signal used to indicate a Do Not Disturb tone. Sent to the VPS when the dialed extension is in Do Not Disturb mode.

**Default**

4

**Value Range**

Max. 16 digits consisting of 0–9, *, #, and A–D

**Answer**

Sent to the VPS when the called extension answers the call.

**Default**

5

**Value Range**

Max. 16 digits consisting of 0–9, *, #, and A–D
2.5.4 Parameters

Forward to VM Ringing
   Specifies the DTMF signal used to indicate a Forward to VM Ring tone. Sent to the VPS when the dialed extension has set calls to be forwarded to the VPS and a VPS port is available to handle the call.
   Default
   6
   Value Range
   Max. 16 digits consisting of 0–9, *, #, and A–D

Forward to VM Busy
   Specifies the DTMF signal used to indicate a Forward to VM Busy tone. Sent to the VPS when the dialed extension has set calls to be forwarded to the VPS but no VPS ports are available to handle the call.
   Default
   7
   Value Range
   Max. 16 digits consisting of 0–9, *, #, and A–D

Forward to Other Extension
   Specifies the DTMF signal used to indicate a Forward to Other Extension tone. Sent to the VPS when the dialed extension has set calls to be forwarded to another extension.
   Default
   8
   Value Range
   Max. 16 digits consisting of 0–9, *, #, and A–D

Confirmation
   Specifies the DTMF signal used to indicate a confirmation tone. Sent to the VPS when the Message Waiting Lamp was successfully turned on or off.
   Default
   9
   Value Range
   Max. 16 digits consisting of 0–9, *, #, and A–D

Disconnect
   Specifies the DTMF signal used to indicate a disconnect tone. Sent to the VPS when the other party goes on-hook.
   Default
   #9
Value Range
Max. 16 digits consisting of 0–9, *, #, and A–D

Digit Translation Table
Use the Digit Translation Table to translate Follow On ID Signals received from the PBX into the codes needed by the VPS. This translation table is only effective for incoming signals. Settings made here should correspond to the Follow On ID settings of the PBX.

Inter-Digit Timeout
Defines the maximum length between the digits of a Follow On ID signal. If this time expires, the VPS will stop detecting Follow On ID for the call.

Default
1 s

Value Range
1 s–4 s

Translation Table 1–8
Follow the steps below to edit the Translation Table.
1. Click Click to edit...
2. Enter the digits sent from the PBX under "Input Digit" and the corresponding digits received by the VPS under "Output Digit" in the Translation Table dialog box.
3. Click OK.

Input Digit/Output Digit
Defines the input and output digits that are translated by the Digit Translation Table. Do not assign the same sequence of Input digits more than once; if this occurs, the VPS will use the first assignment.

Note
- The number of "K" signals assigned for a sequence of Input digits must be the same as the number entered in the sequence of Output digits.

Default
None

Value Range
Max. 20 digits consisting of 0–9, *, #, A–D, S (Input digit only), and K
- S: Skips (ignore) the code; cannot be used as the first character entered.
- K: Keeps the code as it is; cannot be entered as the first character under "Input Digit".
2.5.4.6 Dialling Parameters

Number of Digits to Access Outside Line
This parameter should match the number of digits of the trunk (CO line) access number required by the PBX when making outside calls.

Example:
If the PBX requires callers to dial "9" to access a trunk (CO line), this parameter should be set as "1". This enables the VPS to recognize that an outgoing call setup sequence is completed once the initial "9" has been dialed (9-123-4567).

Default
1

Value Range
0–8 digits

Call Transfer No Answer Time
Specifies the length of time that the VPS waits before retrieving the transferred call when there is no answer at the destination extension.
Note

- Make sure that the duration of Call Transfer No Answer Time is longer than the duration of Call Forwarding No Answer Time at the PBX. Otherwise, the PBX may forward the call immediately to the extension’s Intercept Routing destination according to PBX programming, rather than return the call to the VPS.

Default
20 s

Value Range
10 s–60 s

Outgoing Call No Answer Time

Specifies the length of time that the VPS waits before concluding that there is no answer at the outside number called.

Default
30 s

Value Range
10 s–90 s

Pause Time for ",,"

Specifies the pause time for ",," used in call sequences.

Default
1000 ms

Value Range
100 ms–9900 ms, units 100 ms

Pause Time for ";;"

Specifies the pause time for ";;" used in call sequences.

Default
3000 ms

Value Range
100 ms–9900 ms, units 100 ms

Outside Call Setup Sequence

Specifies the sequence of codes used by the VPS when calling a trunk (CO line). You can set a maximum of 16 digits. The default value is "T". "T" indicates that the VPS will dial the telephone number only after detecting a dial tone.

Example:
9, = (9) – 1 s wait – dial telephone number. "9" is the trunk (CO line) access number.
2.5.4 Parameters

Default

T

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,: Dial Pause for 1 s (default)
,:,: Dial Pause for 3 s (default)
0–9, *, #: Dial Codes

2.5.4.7 Message Waiting Notification

Determines how essential Message Waiting Notification features are carried out.

<table>
<thead>
<tr>
<th>System Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>Time Setting</td>
</tr>
<tr>
<td>Prompt Setting</td>
</tr>
<tr>
<td>PBX Parameters</td>
</tr>
<tr>
<td>Dialing Parameters</td>
</tr>
<tr>
<td>Message Waiting Notification</td>
</tr>
<tr>
<td>Outgoing Call Ports [1 - 24]</td>
</tr>
<tr>
<td>Message Waiting Lamp Ports [1 - 24]</td>
</tr>
<tr>
<td>Message Waiting Lamp for Every Message</td>
</tr>
<tr>
<td>Max Digits for Callback No. (1-48 digits)</td>
</tr>
<tr>
<td>Callback No. Entry Interdigit Time Out [1-10 s]</td>
</tr>
<tr>
<td>System Callback No. (Up to 32 digits)</td>
</tr>
<tr>
<td>External Message Delivery</td>
</tr>
<tr>
<td>Intercom Paging Parameters</td>
</tr>
<tr>
<td>Fax Management</td>
</tr>
<tr>
<td>Disconnect Parameters</td>
</tr>
<tr>
<td>Transfer to Outside</td>
</tr>
<tr>
<td>VM Menu</td>
</tr>
<tr>
<td>Email Integration</td>
</tr>
</tbody>
</table>

Outgoing Call Ports

Specifies the port numbers used for Message Waiting Notification Device feature. The VPS makes outgoing calls using the port specified in this parameter. At least 1 port must be specified.

Note

- The maximum number of ports depends on the VPS model.
Default
1-6 (KX-TVA50), 1-24 (KX-TVA200)

Value Range
1–6 (KX-TVA50), 1–24 (KX-TVA200)

Feature Manual References
2.2.32  Message Waiting Notification—Device

Message Waiting Lamp Ports
Specifies the port numbers used for Message Waiting Notification Lamp feature. The VPS turns on the Message Waiting Lamp of the extension using the port specified in this parameter. At least 1 port must be specified.

Note
• The maximum number of ports depends on the VPS model.

Default
1-6 (KX-TVA50), 1-24 (KX-TVA200)

Value Range
1–6 (KX-TVA50), 1–24 (KX-TVA200)

Feature Manual References
2.2.33  Message Waiting Notification—Lamp

Message Waiting Lamp for Every Message
If set to “Yes”, the VPS will turn on the Message Waiting Lamp of the extension each time a new message is recorded in the mailbox. This will occur even if the Message Waiting Lamp was not turned off from a previous message. This setting is useful when the first attempt is unsuccessful. If set to “No”, the VPS will turn on the Message Waiting Lamp for the first message only. The VPS will not turn on the lamp for subsequent messages until the subscriber has accessed the VPS to retrieve the messages stored there.

Default
Yes

Value Range
No, Yes

Feature Manual References
2.2.33  Message Waiting Notification—Lamp

Max. Digits for Callback No.
Specifies the maximum number of digits the caller can enter as a callback number. This callback number will be displayed on beepers if “Beeper Callback No. Entry Mode” set to any value other than “Disable” (see “Beeper Callback No. Entry Mode” in 2.1.4 Notification Parameters).
Default
20

**Value Range**
1–48 digits

**Feature Manual References**
2.2.32 Message Waiting Notification—Device

### Callback No. Entry Interdigit Time-out

Specifies the length of time the VPS will wait for the caller to press another dial key during Beeper Callback No. Entry. If the caller does not enter any digits within the specified time, the VPS will accept the digits already dialed by the caller as the Beeper Callback Number, then announce the dialed digits to the caller for confirmation.

**Default**
5 s

**Value Range**
1 s–10 s

**Feature Manual References**
2.2.32 Message Waiting Notification—Device

### System Callback No.

Specifies the telephone number that will be displayed on the subscriber’s beeper to indicate the telephone number the subscriber should call back. The system callback number is displayed when "Beeper Callback No. Entry Mode" is set to "Disable", or when the caller does not enter his or her telephone number when prompted to by the VPS. In order to use this feature, the callback number entry code "X" must be added to the end of the subscriber's beeper number when stored in the VPS.

**Note**
- If "Beeper Callback No. Entry Mode" is set to any value other than "Disable" (see "Beeper Callback No. Entry Mode" in 2.1.4 Notification Parameters), the callback number entered by the caller will display on the destination beeper. However, if the caller fails to enter a callback number, the System Callback No. will display instead.

**Default**
None

**Value Range**
Max. 32 digits

**Programming Manual References**
2.1.4 Notification Parameters
2.5.4 Parameters

Feature Manual References

2.2.32  Message Waiting Notification—Device

2.5.4.8 External Message Delivery

Determines how essential External Message Delivery features are carried out.

<table>
<thead>
<tr>
<th>System Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>Time Setting</td>
</tr>
<tr>
<td>Prompt Setting</td>
</tr>
<tr>
<td>PBX Parameters</td>
</tr>
<tr>
<td>Dialling Parameters</td>
</tr>
<tr>
<td>Message Waiting Notification</td>
</tr>
<tr>
<td>External Message Delivery</td>
</tr>
<tr>
<td>Retry Times [0-9]</td>
</tr>
<tr>
<td>Busy Delay [0-60 min]</td>
</tr>
<tr>
<td>No Answer Delay [60-120 min]</td>
</tr>
<tr>
<td>Outgoing Call Ports [1-24]</td>
</tr>
<tr>
<td>Message Length [1-6 min]</td>
</tr>
<tr>
<td>Max. Messages for Mailboxes [1-100]</td>
</tr>
<tr>
<td>System External Message Delivery Duration [1-3 min]</td>
</tr>
<tr>
<td>Company Telephone No (Up to 32 digits)</td>
</tr>
<tr>
<td>Intercom Paging Parameters</td>
</tr>
<tr>
<td>Fax Management</td>
</tr>
<tr>
<td>Disconnect Parameters</td>
</tr>
<tr>
<td>Transfer to Outside</td>
</tr>
<tr>
<td>VM Menu</td>
</tr>
<tr>
<td>E-mail Integration</td>
</tr>
</tbody>
</table>

Retry Times

Specifies the number of times the VPS will attempt to deliver an external message when the destination is busy or does not answer.

Default

3

Value Range

0–9

Feature Manual References

2.3.11 External Message Delivery Service
Busy Delay
Specifies the length of time (in minutes) the VPS waits to try to deliver an external message again when the destination is busy.

**Default**
3 min

**Value Range**
1 min–60 min

**Feature Manual References**
2.3.11 External Message Delivery Service

No Answer Delay
Specifies the length of time (in minutes) the VPS waits to try to deliver an external message again when the destination is not answering.

**Default**
60 min

**Value Range**
60 min–120 min

**Feature Manual References**
2.3.11 External Message Delivery Service

Outgoing Call Ports
Specifies the VPS ports used for the External Message Delivery feature.

**Note**
- The maximum number of ports depends on the VPS model.

**Default**
1-6 (KX-TVA50), 1-24 (KX-TVA200)

**Value Range**
1–6 (KX-TVA50), 1–24 (KX-TVA200)

**Feature Manual References**
2.3.11 External Message Delivery Service

Message Length
Specifies the maximum length (in minutes) messages recorded for the External Delivery Message.

**Default**
3 min
**Value Range**
1 min–6 min

**Feature Manual References**
2.3.11 External Message Delivery Service

**Max. Messages for Mailboxes**
Specifies the maximum number of External Delivery Messages that can be stored in one mailbox.

**Default**
3

**Value Range**
1–100

**Feature Manual References**
2.3.11 External Message Delivery Service

**System External Message Delivery Duration Time**
Specifies the maximum length of External Message Delivery calls. The timer begins counting when the called party answers the call, and if the called party has not pressed the appropriate dial key to initiate message playback, the VPS terminates the call when this timer expires.

**Default**
3 min

**Value Range**
1 min–9 min

**Feature Manual References**
2.3.11 External Message Delivery Service

**Company Telephone No.**
Specifies the company’s telephone number. When the recipient has failed to retrieve the sender’s message because of he or she did not enter the correct password, the VPS announces the company’s telephone number to the caller. The caller can later call the company for assistance or to speak to the message sender.

**Default**
None

**Value Range**
Max. 32 digits
2.5.4.9 Intercom Paging Parameters

VPS Intercom Paging functions in conjunction with the Intercom Paging feature of the PBX. It allows the VPS to page the called party (announce the caller's name, line number, etc.) while the caller is placed on hold. To utilize this feature, Intercom Paging must be available for the PBX, and the VPS must be properly programmed. This feature is available for APT/DPT Integration only.

Intercom Paging Sequence

Specifies the intercom paging sequence used to activate the Intercom Paging feature of the PBX. The settings made here must match the settings of the PBX. The sequence can be a combination of 7 letters and 12 dial codes.

Default
FX,

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
;: Dial Pause for 1 s (default)
:: Dial Pause for 3 s (default)
X: Pager Dialing
0–9, *, #: Dial Codes
Feature Manual References

2.2.25 Intercom Paging (APT/DPT Integration Only)

Release for Intercom Paging

Specifies the intercom paging release sequence. The settings made here must match the settings of the PBX. The sequence can be a combination of 7 letters and 12 dial codes.

Default
F,

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,: Dial Pause for 1 s (default)
;; Dial Pause for 3 s (default)
X: Pager Dialing
0–9, *, #: Dial Codes

Feature Manual References

2.2.25 Intercom Paging (APT/DPT Integration Only)

No Answer Time for Intercom Paging

Specifies the length of time (in seconds) the VPS waits before concluding Intercom Paging when there is no answer. The VPS will return to the caller if the paged party does not respond before this timer expires.

Default
5 s

Value Range
1 s–30 s

Feature Manual References

2.2.25 Intercom Paging (APT/DPT Integration Only)

Announcement Repeat Cycle

Specifies the number of times the VPS announces the page.

Example:
"I have a call for (name)".

Default
1
Value Range
1–3 times

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Intercom Paging Retry
Specifies the number of times to retry paging when the called subscriber has set Incomplete Call Handling to "Intercom Paging" and the subscriber is busy or if there is no answer.

Note
• This setting applies only when the subscriber has set Incomplete Call Handling to "Intercom Paging".

Default
2

Value Range
1–10 times

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Caller Recorded Name Announcement Mode
Determines whether or not the VPS announces the caller's name during paging. (In order for the name to be announced, it must be recorded beforehand.)

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

Paging Code
Specifies the intercom paging code. The settings made here must match the settings of the PBX.

Note
• Each subscriber's Intercom Paging Group Number is determined based on his or her COS.

Default
All groups: None
Paging Code for Group 1-32: \( \times 33 \) + Group No.
Value Range
Max. 16 digits consisting of 0–9, *, #

Feature Manual References
2.2.25 Intercom Paging (APT/DPT Integration Only)

2.5.4.10 Fax Management

You can program the VPS to automatically detect incoming fax calls and forward those calls to a fax extension. You can specify a maximum of 2 fax extensions as the destination for faxes; if the main fax extension is not available to receive a fax, the VPS will forward the fax call to the alternate fax extension.

Automatic Transfer of Incoming Fax Call
Enables or disables the detection of incoming fax calls.

Note
• The VPS can detect incoming fax signals during the first 30 seconds after it answers incoming calls.

Default
Disable
Value Range
Disable, Enable

Feature Manual References
2.2.22 Fax Management

Main Fax Extension No.
Specifies the extension number of the main fax machine.

Default
None

Value Range
2–5 digits

Feature Manual References
2.2.22 Fax Management

Alternate Fax Extension No.
Specifies the extension number of the alternate fax machine. When the main fax extension is busy or does not answer within the time specified under "Fax No Answer Time", the VPS forwards the fax call to the alternate fax extension.

Default
None

Value Range
2–5 digits

Feature Manual References
2.2.22 Fax Management

Fax No Answer Time
Specifies the length of time (in seconds) that the VPS waits for the main or alternate fax extension to answer a fax call before taking other action, such as notifying the Fax Manager that the fax could not be received.

Default
10 s

Value Range
5 s–60 s

Feature Manual References
2.2.22 Fax Management
2.5.4 Parameters

Fax Manager Mailbox No.
Specifies the mailbox number of the Fax Manager. The VPS will notify the Fax Manager of the status of fax calls depending upon the settings of the "Fax No Answer Coverage Mode" and "Fax Notification Mode" parameters.

Default
None

Value Range
2–5 digits

Feature Manual References
2.2.22 Fax Management

Fax No Answer Coverage Mode
Determines what action the VPS takes when an incoming fax call could not be answered by the main or alternate fax extension. The VPS can announce to the Fax Manager the number of unanswered fax calls. The number announced is the number of unanswered fax calls since the last time the VPS notified the Fax Manager. This announcement is heard when the Fax Manager logs in to his or her mailbox.

Default
No

Value Range
No: The VPS will not notify the Fax Manager when fax calls were not answered.
Mbx: The VPS will announce the number of unanswered fax calls to the Fax Manager when the Fax Manager logs in to his or her mailbox.
Extn: The VPS will announce the number of unanswered fax calls to the Fax Manager by calling the Fax Manager’s extension.

Feature Manual References
2.2.22 Fax Management

Fax Notification Mode
Determines what action the VPS takes when an incoming fax call is successfully received by the main or alternate fax extension. The VPS can announce to the Fax Manager the number of received fax calls. The number announced is the number of received fax calls since the last time the VPS notified the Fax Manager.

Default
No

Value Range
No: The VPS will not notify the Fax Manager when fax calls are answered.
Mbx: The VPS will announce the number of successfully received fax calls to the Fax Manager when the Fax Manager logs in to his or her mailbox.
Extn: The VPS will announce the number of successfully received fax calls to the Fax Manager by calling the Fax Manager’s extension.
2.5.4 Parameters

2.5.4.11 Disconnect Parameters

Maximum Silence Time
Specifies the length of silence detected by the VPS before the VPS disconnects the call.

Default
10 s

Value Range
0 s–60 s

Maximum Continuous Tone Time
Specifies the length of time the VPS waits when a continuous tone is detected before it disconnects the call.

Default
6 s

Value Range
0 s–60 s
Maximum Cyclic Tone Time

Specifies the length of time the VPS waits when a cyclic tone is detected before it disconnects the call.

Default
6 s

Value Range
0 s–60 s

Maximum Call Duration

Specifies the maximum duration of calls. If the VPS detects no DTMF signals for the specified amount of time, it terminates the call. Calls will not be terminated while playing or recording messages. If this setting is set to "0", calls will not be terminated.

Default
10 min

Value Range
0 min–60 min

2.5.4.12 Transfer to Outside

These parameters determine how the VPS will transfer calls to trunk (CO line) via the following features: Call Transfer Service, Custom Service, Personal Custom Service, Caller ID Callback.
Outside Transfer Sequence

Call Transfer to Outside Sequence

Specifies the sequence the VPS uses to transfer calls to trunks (CO lines).

**Default**

FND

**Value Range**

Max. 16 digits consisting of 0–9, *, # and special codes

D: Disconnecting

F: Flash (Recall)

R: Ringback Tone Detection

T: Dial Tone Detection

;: Dial Pause for 1 s (default)

;;: Dial Pause for 3 s (default)

N: Telephone Number Dialing

0–9, *, #: Dial Codes

**Feature Manual References**

2.2.7 Call Transfer to Outside

Call Transfer to Outside Reconnect Sequence on Busy

Specifies the sequence the VPS uses to reconnect the line when the transferred party is busy.

**Default**

F

**Value Range**

Max. 16 digits consisting of 0–9, *, # and special codes

D: Disconnecting

F: Flash (Recall)

R: Ringback Tone Detection

T: Dial Tone Detection

;: Dial Pause for 1 s (default)

;;: Dial Pause for 3 s (default)

N: Telephone Number Dialing

0–9, *, #: Dial Codes

**Feature Manual References**

2.2.7 Call Transfer to Outside

Call Transfer to Outside Reconnect Sequence on No Answer

Specifies the sequence the VPS uses to reconnect the line when the transferred party does not answer.

**Default**

F
### 2.5.4 Parameters

**Value Range**
Max. 16 digits consisting of 0–9, *, # and special codes
- D: Disconnecting
- F: Flash (Recall)
- R: Ringback Tone Detection
- T: Dial Tone Detection
- ;: Dial Pause for 1 s (default)
- ;;: Dial Pause for 3 s (default)
- N: Telephone Number Dialing
- 0–9, *, #: Dial Codes

**Feature Manual References**
2.2.7 Call Transfer to Outside

**EFA Transfer Sequence**
Specifies the sequence the VPS uses to transfer calls to trunks (CO lines) using EFA (External Feature Access). This setting should match the settings of the PBX.

**Default**
F *60TN

**Value Range**
Max. 16 digits consisting of 0–9, *, # and special codes
- D: Disconnecting
- F: Flash (Recall)
- R: Ringback Tone Detection
- T: Dial Tone Detection
- ;: Dial Pause for 1 s (default)
- ;;: Dial Pause for 3 s (default)
- N: Telephone Number Dialing
- 0–9, *, #: Dial Codes

**EFA Transfer Reconnect Sequence on Busy**
Specifies the sequence the VPS uses to reconnect the line when the party transferred with EFA (External Feature Access) is busy. This setting should match the settings of the PBX.

**Default**
F *60TN

**Value Range**
Max. 16 digits consisting of 0–9, *, # and special codes
- D: Disconnecting
- F: Flash (Recall)
- R: Ringback Tone Detection
- T: Dial Tone Detection
- ;: Dial Pause for 1 s (default)
- ;;: Dial Pause for 3 s (default)
- N: Telephone Number Dialing
- 0–9, *, #: Dial Codes
EFA Transfer Reconnect Sequence on No Answer

Specifies the sequence the VPS uses to reconnect the line when the party transferred with EFA (External Feature Access) does not answer. This setting should match the settings of the PBX.

**Default**
F ✴60TN

**Value Range**
Max. 16 digits consisting of 0–9, ✴, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
;: Dial Pause for 1 s (default)
:: Dial Pause for 3 s (default)
N: Telephone Number Dialing
0–9, ✴, #: Dial Codes

Call Transfer to Outside Answer Mode

Specifies the answering method the VPS uses to detect whether the destination party has answered the transferred trunk (CO line) call.

**Default**
Guidance

**Value Range**

**Analyze**: the VPS monitors the status of the trunk (CO line), recognizes that the destination party goes off-hook, and connects the line.

**Guidance**: the VPS plays the following guidance before connecting the line to the destination party: "You have a call. To answer the call, press [1]. Otherwise, press [2] and hang up." If the destination party presses "1", he or she will be able to answer the transferred trunk (CO line) call. The VPS continues playing this guidance for the time specified in "Outgoing Call No Answer Time" in "Dialling Parameters". If the transferred party does not answer the call within this time, the VPS considers it as a No Answer call.

**Feature Manual References**
2.2.7 Call Transfer to Outside

Ignore Received First DTMF

If the PBX sends a DTMF signal to the VPS when the VPS attempts to transfer a call to an outside telephone, set this parameter to "Enable".

**Default**
Enable

**Value Range**
Disable, Enable
2.5.4 Parameters

Trunk Group
Specifies the parameters for each Trunk Group No.
Follow the steps below to edit a Trunk Group.
1. Click Click to edit...
2. Select the desired Trunk Group No. (1–64).
3. Edit each parameter in the Trunk Group dialog box.
4. Click OK.

EFA Transfer
Effective for DPT Integration only. Specifies whether or not the VPS uses EFA (External Feature Access) when transferring incoming trunk (CO line) calls to another trunk (CO line). If set to "Enable", the VPS transfers incoming trunk (CO line) calls to another trunk (CO line) according to "EFA Transfer Sequence" specified in "Transfer to Outside". If set to "Disable", the VPS transfers incoming trunk (CO line) calls to another trunk (CO line) according to “Call Transfer to Outside Sequence” specified in "Transfer to Outside".

Default
Disable

Value Range
Disable, Enable

Caller ID Callback
Specifies whether or not the VPS allows a subscriber to call back the party who left a message in his or her mailbox by using the caller ID information sent from the PBX. This setting applies to the trunk (CO line) number used when the message with Caller ID information was left in his or her mailbox.

Default
Disable

Value Range
Disable, Enable

Outside Line Access Sequence for Caller ID Callback
Specifies the sequence of trunk (CO line) access numbers for Caller ID Callback. This parameter is available when the VPS executes Caller ID Callback without using EFA.

Default
9T

Value Range
Max. 16 digits consisting of 0–9, *, # and special codes
D: Disconnecting
F: Flash (Recall)
R: Ringback Tone Detection
T: Dial Tone Detection
,,: Dial Pause for 1 s (default)
;,: Dial Pause for 3 s (default)
0–9, *, #: Dial Codes
2.5.4 Parameters

Use Caller-ID Modify Table No.
Specifies which Caller ID Modify Table is used when the VPS converts the Caller ID Number sent from the PBX to the VPS.

Default
1

Value Range
1–4

Number of Digits in Telephone Number
Specifies the number of digits for local area telephone numbers. According to this parameter, telephone numbers dialed by the VPS can be distinguished as either local calls or long distance calls.

Default
8

Value Range
1–20

Caller-ID Modify Table No.1–4
A maximum of 4 Caller ID Modify tables can be assigned.

Local Area / International Call Code
Specifies the parameters for each Local Area/International Call Code.
Follow the steps below to edit a Local Area/International Call Code.
1. Click Click to edit....
2. Select the desired Local Area/International Call Code No. (1–10).
3. Edit each parameter in the Local Area / International Call Code dialog box.
4. Click OK.

Local Area Code/International Code
Specifies the local area/international codes that are used when the VPS converts the Caller ID Number sent from the PBX to the VPS.

Default
None

Value Range
Max. 6 digits consisting of 0–9

Remove Digits
Specifies the number of digits to be deleted from the telephone number (sent from the PBX) to make up a telephone number for a local area/international call. Digits are removed from the beginning of the received digits.
2.5.4 Parameters

Default
0

Value Range
0–9

Additional Digits
Specifies the number to be added to the telephone number (sent from the PBX) to make up a telephone number for a local area/international call. The number is added to the beginning of the received digits.

Default
None

Value Range
Max. 4 digits consisting of 0–9, *, #

2.5.4.13 Long Distance Call

Remove Digit
Specifies the number of digits to be deleted from the telephone number (sent from the PBX) to make up a telephone number for a long distance call. Digits are removed from the beginning of the received digits.

Default
0

Value Range
0–9

Additional Digit
Specifies the number to be added to the telephone number (sent from the PBX) to make up a telephone number for a long distance call. The number is added to the beginning of the received digits.

Default
None

Value Range
Max. 4 digits consisting of 0–9, *, #
2.5.4.14 VM Menu

Number of ports for VM Menu Service

Specifies the total number of ports that can be used simultaneously to provide VM Menu service for subscribers.

Note

• If too many subscribers try to use VM Menu at the same time, it will not operate properly. If VM Menu does not operate properly, set this parameter to a lower value.

Default

12

Value Range

0–24

Feature Manual References

2.3.36 VM Menu (DPT Integration Only)
2.5.4.15 E-mail Integration

E-mail Integration allows the VPS to send new message notification or to send recorded voice messages as file attachments to subscribers via e-mail. The following settings must be made in order for the VPS to use E-mail Integration features. Consult the LAN administrator for the appropriate settings.

Follow the steps below to configure E-mail Integration.
1. Set **E-mail Integration** to **Enable**.
2. Enter an e-mail address next to **Mail Address**.

**Note**
- We recommend entering an administrator’s e-mail address here. If there are any errors when the VPS tries to send e-mail messages, error messages will be sent to this address.

3. Enter the name that will appear in e-mail messages sent from the VPS next to **Full Name**. This name should indicate that the message came from the VPS.
4. Enter the IP address or host name of the outgoing mail server next to **SMTP Server Address**.
Note
- If authentication is required when accessing the outgoing mail server (SMTP server), make the appropriate settings under Advanced Settings.
- When sending message notifications by e-mail, the sent date is stamped to each message either by the SMTP server used by the VPS, or by the receiver’s e-mail software.

E-mail Integration
If set to "Enable", subscribers are able to utilize E-mail Integration features.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.2.20 E-mail Integration

Mail Address
Specifies the mail address of VPS. We recommend entering an administrator’s e-mail address here. If there are any errors when the VPS tries to send e-mail messages, error messages will be sent to this address.

Default
None

Value Range
Max. 128 characters

Feature Manual References
2.2.20 E-mail Integration

Full Name
Specifies the full name that will appear in e-mail messages sent from the VPS.

Default
None

Value Range
Max. 64 characters

Feature Manual References
2.2.20 E-mail Integration

SMTP Server Address (Name)
Specifies the IP address or server name of the outgoing e-mail server used by the VPS.
2.5.4 Parameters

Default
None

Value Range
IP Address: X.X.X.X (X=0–255)
Server Name: Max. 127 characters

Feature Manual References
2.2.20 E-mail Integration

Maximum Message Length
Specifies the maximum length of voice messages sent as e-mail attachment.

Note
• If you attach a voice message that is longer than this setting, surplus parts of the message may be discarded when sending the e-mail.

Default
5 min

Value Range
1 min–30 min

Feature Manual References
2.2.20 E-mail Integration

2.5.4.16 Advanced Settings

SMTP Server
SMTP Server Port
Specifies the port number for the outgoing mail server.

Default
25

Value Range
1-65535

SMTP Authentication
If set to "Enable", SMTP Authentication is used for outgoing mail server. For authentication, username and password are required.

Default
Disable
2.5.4 Parameters

Value Range
Disable, Enable

SMTP Authentication Username
Specifies the username for SMTP Authentication.

Default
None

Value Range
Max. 64 characters

SMTP Authentication Password
Specifies the password for SMTP Authentication.

Default
None

Value Range
Max. 64 characters

SMTP Over SSL
Determines whether or not to use the SSL connection for encryption when sending e-mails. This parameter is effective when "SMTP Authentication" is set to "Enable".

Default
Disable

Value Range
Disable, Enable

Pop Server

POP Server Address (Name)
Specifies the IP address or server name of the incoming e-mail server used by the VPS. Must be set in order to use POP Before SMTP.

Default
None

Value Range
IP Address: X.X.X.X (X=0-255)
Server Name: Max. 127 characters

POP Server Port
Specifies the port number for the incoming mail server.
2.5.4 Parameters

**Value Range**
1-65535

**POP Before SMTP**
If set to "Enable", POP Before SMTP authentication is used for outgoing mail server. For authentication, username and password are required.

**Value Range**
Disable, Enable

**POP Before SMTP Username**
Specifies the username for POP Before SMTP authentication.

**Value Range**
Max. 64 characters

**POP Before SMTP Password**
Specifies the password for POP Before SMTP authentication.

**Value Range**
Max. 64 characters

**POP Over SSL**
Determines whether or not to use the SSL connection for encryption when receiving e-mails. This parameter is effective when "POP Before SMTP" is set to "Enable".

**Value Range**
Disable, Enable
2.6 Hardware (H/W) Settings

Global Parameters

Global parameters define the settings that affect integration with the PBX.

Flash Time

For Inband and No Integration only. Specifies the length of time the hook switch must be pressed before the PBX will recognize it as a hookflash signal. The settings made here should match the settings of the PBX.

Default
600 ms

Value Range
100 ms, 300 ms, 600 ms, and 900 ms

CPC Signal

For Inband and No Integration only. Specifies the minimum time necessary to detect an interruption in the CPC (Calling Party Control) signal received from the PBX. The VPS is able to determine that the line has been disconnected when it detects an interruption of the CPC signal. The settings made here should match the settings of the PBX.

Default
None

Value Range
None, 6.5 ms, 150 ms, 300 ms, 450 ms, 600 ms, and 900 ms
2.6 Hardware (H/W) Settings

Disconnect Time
Specifies the length of time the line will be unavailable after a call has ended.

Default
2 s

Value Range
1 s–8 s

Delay After Dialing Before Analysis
Specifies the length of time between the end of call and the start of Call Progress Tone detection when an outgoing call is dialed.

Default
0 ms

Value Range
0 ms–20000 ms, units 100 ms

Maximum Time to Wait for Dial Tone
Specifies the length of time that the VPS waits for dial tone detection.

Default
5000 ms

Value Range
500 ms–20000 ms, units 100 ms

Dial Start Mode
Specifies whether dialing starts after a dial tone is detected or after the time specified in "Offhook Delay" has passed.

Default
Delay Mode

Value Range
Dial Tone Mode, Delay Mode

Offhook Delay
Specifies the length of time that passes before dialing starts. This setting is only needed when "Dial Start Mode" is set to "Delay Mode".

Default
3000 ms

Value Range
500 ms–20000 ms, units 100 ms
Delay After Dialing Before On-hook

Specifies the length of time that the VPS waits for an answer when making an outside call. If no answer is detected, the VPS disconnects the call.

Default

60 s

Value Range

0 s–250 s

DTMF Cut Length

Specifies the length of time for DTMF to be deleted when it is detected while recording.

Default

110 ms

Value Range

0 ms–500 ms

Minimum Message Length

Specifies the minimum message recording length. Messages shorter than the specified minimum recording length are discarded from the mailbox.

Default

2 s

Value Range

0 s–9 s

Call Progress Tone Detection for Inband Mode

This setting determines whether the VPS detects Call Progress Tones during Inband Integration. If set to "Enable", Call Progress Tones are detected in addition to DTMF signals.

Default

Enable

Value Range

Disable, Enable
2.7 Reports

The System Administrator can generate various system reports in order to monitor VPS operations. Reports can be displayed on a PC, printed, or exported.

- Mailbox Information Report
- Call Account Report (Group calls by Port)
- Call Account Report (Group calls by Mailbox)
- Port Usage Report
- HDD Usage Report (KX-TVA200 only) or Memory Card Usage Report (KX-TVA50 only)
- Mailbox Usage Report
- Fax Call Report
- Call Handling Statistics Report
- Custom Service Report
- Message Status Report
- Subscriber Setup Report
- Security Information Report
- Hourly Statistics Report
- E-mail Report

Follow the steps below to use Reports.

[Viewing a Report]
1. Select the desired report in Reports screen.
2. Enter or select any additional information if needed.
3. Click View Report.

[Switching Between Graph and Table View]
Select either "Table" or "Graph" next to View As:
The following reports can be viewed as either of Table or Graph format:
a. Call Account Report (Group calls by Port)
b. Call Account Report (Group calls by Mailbox)
c. Port Usage Report
d. HDD Usage Report (KX-TVA200 only) or Memory Card Usage Report (KX-TVA50 only)
e. Mailbox Usage Report
f. Call Handling Statistics Report

[Printing a Report]
1. Click the print icon.
2. Navigate to the printer to print a report

[Exporting a Report]
1. Click the export icon.
2. Specify or navigate to the folder where to export a report.

Report Data Clear

For each report, all data can be cleared. Follow the steps below to clear all report data.
2. Select the desired report from Report Parameters.
3. Click Report Data Clear.
### 2.7.1 Mailbox Information Report

The mailbox information report displays configuration parameters (from owner’s extension to e-mail options) for a specified mailbox or a range of mailboxes.

<table>
<thead>
<tr>
<th>Mailbox Information Report</th>
<th>JUL-28-2004 11:30 AM</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Mailbox Range: 210 to 215</td>
<td></td>
</tr>
</tbody>
</table>

#### Mailbox 210

- **Extension:** 210
- **First Name:** JOHN
- **Last Name:** WILLIAMS
- **Password:** *****
- **Class of Service:** 1
- **Covering Extension:** 230
- **Interview Mailbox:** 777
- **Call Transfer Sequence:** FTXD
- **No Answer Time (sec):** 30
- **Call Transfer Status:** Call Screening
- **Transfer to specified number:** 0123456789

#### Incomplete Call Handling for No Answer:

- Leave a message: Disable
- Transfer to a covering extension: Disable
- Page the mailbox owner by intercom paging: Disable
- Notify the mailbox owner via a beeper: Enable
- Transfer to operator: Disable
- Return to top menu: Disable
- Transfer to specified custom service menu: Disable

#### Incomplete Call Handling for Busy:

- Leave a message: Disable
- Transfer to a covering extension: Disable
- Page the mailbox owner by intercom paging: Disable
- Notify the mailbox owner via a beeper: Enable
- Transfer to operator: Disable
- Return to top menu: Disable
- Transfer to specified custom service menu: Disable

#### Notification Parameters

- **Message Waiting Lamp:** Enable
- **Beeper Callback No. Entry Mode:** Before Message Recording
- **Device Notification for Unreceived Message:** Yes

#### Notification Schedule

- **Device 1**
  - **Notification Type:** Only Urgent Messages
  - **Dial Number:** 96127494
  - **Type of Device:** Telephone
  - **No. of Retries (times):** 3
  - **Busy Delay Time (min):** 2
  - **No Answer Delay Time (min):** 60
  - **Use Mode:** Continuously
### Auto Forwarding Status

- **Mailbox Number:** 120
- **Delay Time:** 00:30
- **Forward Mode:** Move

### External Message Delivery

<table>
<thead>
<tr>
<th>Day</th>
<th>Time Range</th>
<th>Time Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon</td>
<td>02:00AM-11:00AM</td>
<td>01:00PM-10:00PM</td>
</tr>
<tr>
<td>Tue</td>
<td>02:00AM-11:00AM</td>
<td>01:00PM-10:00PM</td>
</tr>
<tr>
<td>Wed</td>
<td>02:00AM-11:00AM</td>
<td>01:00PM-10:00PM</td>
</tr>
<tr>
<td>Thu</td>
<td>02:00AM-11:00AM</td>
<td>01:00PM-10:00PM</td>
</tr>
<tr>
<td>Fri</td>
<td>02:00AM-11:00AM</td>
<td>01:00PM-10:00PM</td>
</tr>
<tr>
<td>Sat</td>
<td>02:00AM-11:00AM</td>
<td>01:00PM-10:00PM</td>
</tr>
<tr>
<td>Sun</td>
<td>02:00AM-11:00AM</td>
<td></td>
</tr>
</tbody>
</table>

- **Usage:** Scheduled
- **Notified:** Only Urgent Messages

### Device Notification Timer

- **Device Start Delay Time (min):** 60
- **Device Interval Time between Device1 and Next Device (min):** 60
- **Device Interval Time between Device2 and Next Device (min):** 60
- **Device Interval Time between Device3 and Next Device (min):** 60

### Prompt Mode

- **Active:** Yes
- **Mode:** System

### Personal Distribution List

#### List 1
- **Description:** ABCDEFGHI
- **Members:**
  - 101 PAUL WILLER
  - 102 STEAVY PERRY

#### List 2
- **Description:**

---

### Programming Manual References

2.1 Mailbox Settings
Feature Manual References

2.4.8 System Reports
2.7.2 Call Account Report

The call account report displays information about outgoing call activity. Information can be shown by port or by mailbox. The report includes date, starting time, used port, connection time, called telephone number, call type, exit status of each callout, total callouts number and the connection time for local or long distance call, and total number of outgoing calls.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Port</th>
<th>Connect Time</th>
<th>Number</th>
<th>Type</th>
<th>Exit Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>JUL-01-02</td>
<td>06:04 PM</td>
<td>12</td>
<td>00:01:12</td>
<td>7893435678</td>
<td>Local</td>
<td>Called Out</td>
</tr>
<tr>
<td>JUL-06-02</td>
<td>11:45 PM</td>
<td>18</td>
<td>00:00:47</td>
<td>18007597243</td>
<td>Long</td>
<td>Called Out</td>
</tr>
<tr>
<td>JUL-12-02</td>
<td>09:32 AM</td>
<td>3</td>
<td>00:02:03</td>
<td>7039783232</td>
<td>Local</td>
<td>Transferred</td>
</tr>
</tbody>
</table>

Total Local Calls: 2 00:03:15
Total Long Distance Calls: 1 00:00:47
Total Calls From Mailbox 200: 3 00:04:02

Feature Manual References
2.4.8 System Reports
2.7.3 Port Usage Report

The port usage report displays information about each port, such as connection time and percentage of time which each port was busy.

<table>
<thead>
<tr>
<th>Port No.</th>
<th>External Message Delivery</th>
<th>Message Device Notification</th>
<th>Receive</th>
<th>Connect Time</th>
<th>Percentage of Connect Time (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8</td>
<td>4</td>
<td>84</td>
<td>00:05:19</td>
<td>47.20</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>1</td>
<td>21</td>
<td>00:01:35</td>
<td>14.05</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>0</td>
<td>13</td>
<td>00:03:02</td>
<td>26.92</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>00:01:20</td>
<td>11.83</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>28</td>
<td>42</td>
<td>359</td>
<td>00:11:16</td>
<td>100.00</td>
</tr>
<tr>
<td>Full-line Time</td>
<td>00:00:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Feature Manual References

2.4.8 System Reports
2.7.4  HDD Usage Report

The HDD (memory) usage report indicates the amount of disk storage used and the amount of available disk space. Disk space is expressed in minutes. The following statistics are also displayed:

– The number of messages that were recorded by callers and were copied since the last clearing of this report.
– The number of messages that were copied since the last clearing of this report.
– The number of messages that were deleted by subscribers since the last clearing of this report.
– The number of messages that expired and were removed by the VPS since the last clearing of this report.

<table>
<thead>
<tr>
<th>Drive Number</th>
<th>Available Recording Time (min)</th>
<th>Used Recording Time (min)</th>
<th>Percentage of Disk Usage (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>120</td>
<td>6</td>
<td>5.00</td>
</tr>
</tbody>
</table>

From: JUL-01-2004 10:00 AM

Total New Message | Total Copy Message | Total Delete Message | Total Expired Message
--- | --- | --- | ---
10 | 0 | 10 | 0

Feature Manual References

2.4.8  System Reports
### 2.7.5 Mailbox Usage Report

The mailbox usage report displays information for a specified mailbox or range of mailboxes, including the number of recorded messages, the total time of outgoing calls, external messages, message notification, and group message delivery.

**Note**

- Specify the mailboxes for which you want to display a report, then click View Report. You can select a single mailbox (e.g., from 200 to 200), a range of mailboxes (e.g., from 200 to 209), or all mailboxes by clicking Select all mailboxes.
- Current New Message Counts, Current Received Message Counts, and Current EMD Message Counts are current status indications. All else are accumulated indications since the last clearing of this report.

#### Mailbox Usage Report

<table>
<thead>
<tr>
<th>MAILBOX 200</th>
<th>JONE BLUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current New Message Counts</td>
<td>4</td>
</tr>
<tr>
<td>Current Received Message Counts</td>
<td>6</td>
</tr>
<tr>
<td>Current EMD Message Counts</td>
<td>0</td>
</tr>
</tbody>
</table>

From: JUL-01-2004 09:30 AM

<table>
<thead>
<tr>
<th>Subscriber Access Time</th>
<th>Time</th>
<th>Port No.</th>
<th>Connect Time</th>
<th>Exit Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>JUL-01-04 10:12 AM</td>
<td>12</td>
<td>00:00:08</td>
<td>Disconnect</td>
<td></td>
</tr>
<tr>
<td>JUL-05-04 04:32 PM</td>
<td>3</td>
<td>00:00:15</td>
<td>Logoff</td>
<td></td>
</tr>
<tr>
<td>JUL-09-04 01:23 PM</td>
<td>5</td>
<td>00:00:07</td>
<td>Logoff</td>
<td></td>
</tr>
<tr>
<td>JUL-10-04 07:03 PM</td>
<td>12</td>
<td>00:00:10</td>
<td>Cyclic Tone</td>
<td></td>
</tr>
</tbody>
</table>

MAILBOX Used Time 00:00:12 of 01:40:00 (0.2% Used)

<table>
<thead>
<tr>
<th>Feature Usage</th>
<th>External Message Delivery</th>
<th>Message Notification</th>
<th>Interview Message</th>
<th>Group Message</th>
<th>Auto Forward</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>11</td>
<td>31</td>
<td>20</td>
<td>14</td>
<td>22</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Outgoing Call (Time)</th>
<th>Long Distance</th>
<th>Local</th>
<th>Beeper</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>6</td>
<td>13</td>
<td>0</td>
<td>28</td>
</tr>
<tr>
<td>Received Message</td>
<td>00:05:10</td>
<td>00:10:45</td>
<td>00:00:00</td>
<td>00:31:21</td>
</tr>
<tr>
<td>Deleted Message</td>
<td>42</td>
<td>30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expired Message</td>
<td>11</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Feature Manual References

2.4.8 System Reports
2.7.6 Fax Call Report

The fax call report displays information about faxes received by the VPS and transferred to a fax extension. It includes the fax reception date, the port number used, and the fax transfer status for a maximum of 64 fax messages.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Port</th>
<th>Fax-1</th>
<th>Fax-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>JUL-01-04</td>
<td>11:15AM</td>
<td>1</td>
<td>Connect</td>
<td>-</td>
</tr>
<tr>
<td>JUL-04-04</td>
<td>07:58PM</td>
<td>12</td>
<td>Busy</td>
<td>No Answer</td>
</tr>
<tr>
<td>JUL-15-04</td>
<td>10:23AM</td>
<td>1</td>
<td>Busy</td>
<td>Connect</td>
</tr>
</tbody>
</table>

Feature Manual References

2.4.8 System Reports
2.7.7 Call Handling Statistics Report

The call handling statistic report displays both a summary of and details of VPS activity over a specified period of time for the Automated Attendant service. This report includes the total number of incoming calls, transferred calls, held calls, calls which left a message, the result of transferred calls, etc.

<table>
<thead>
<tr>
<th>Call Handling Statistics Report</th>
<th>JUL-28-2004 11:30 AM</th>
</tr>
</thead>
<tbody>
<tr>
<td>From: JUL-01-2004 09:30 AM</td>
<td></td>
</tr>
<tr>
<td><strong>Total Calls Answered:</strong></td>
<td>23083</td>
</tr>
<tr>
<td>Caller Dialled During Greeting</td>
<td>20797</td>
</tr>
<tr>
<td>Caller Hung Up During Greeting</td>
<td>1529</td>
</tr>
<tr>
<td>Greeting Complete</td>
<td>757</td>
</tr>
<tr>
<td><strong>Total Transfers:</strong></td>
<td>19047</td>
</tr>
<tr>
<td>Transfer by Timeout</td>
<td>168</td>
</tr>
<tr>
<td>&quot;0&quot; key for Operator</td>
<td>2106</td>
</tr>
<tr>
<td>Single Key Requests (except &quot;0&quot;)</td>
<td>1302</td>
</tr>
<tr>
<td>Full Extension Requests</td>
<td>10546</td>
</tr>
<tr>
<td>Left a Message for a Subscriber</td>
<td>0</td>
</tr>
<tr>
<td>Logon Sessions</td>
<td>4761</td>
</tr>
<tr>
<td>Fax Call Answering</td>
<td>164</td>
</tr>
<tr>
<td><strong>Result of Transfers:</strong></td>
<td>8943</td>
</tr>
<tr>
<td>Line Busy</td>
<td>631</td>
</tr>
<tr>
<td>Ring No Answer</td>
<td>2876</td>
</tr>
<tr>
<td>Call Blocking</td>
<td>443</td>
</tr>
<tr>
<td>Rejected</td>
<td>10</td>
</tr>
<tr>
<td>Illegal Number</td>
<td>91</td>
</tr>
<tr>
<td>Call Connected</td>
<td>4892</td>
</tr>
<tr>
<td><strong>Hold Initiated:</strong></td>
<td>77</td>
</tr>
<tr>
<td>Call Connected</td>
<td>69</td>
</tr>
<tr>
<td>Hold Abandoned</td>
<td>8</td>
</tr>
<tr>
<td><strong>Diverted Calls:</strong></td>
<td>8196</td>
</tr>
<tr>
<td>Message Taken</td>
<td>7287</td>
</tr>
<tr>
<td>External Transfer</td>
<td>156</td>
</tr>
<tr>
<td>Intercom Paging</td>
<td>23</td>
</tr>
<tr>
<td>Call a Beeper</td>
<td>4</td>
</tr>
<tr>
<td>Transfer to Custom Service</td>
<td>0</td>
</tr>
<tr>
<td>Disconnected</td>
<td>726</td>
</tr>
<tr>
<td><strong>Total Usage in Minutes</strong></td>
<td>59346</td>
</tr>
</tbody>
</table>

Feature Manual References

2.4.8 System Reports
### 2.7.8 Custom Service Report

The Custom Service report displays information such as Custom Service settings, message recording status, number of access, time of access, and number of access to each key.

<table>
<thead>
<tr>
<th>Custom Service Report</th>
<th>JUL-28-2004 11:30 AM</th>
</tr>
</thead>
<tbody>
<tr>
<td>From:</td>
<td>JUL-01-2004 09:30 AM</td>
</tr>
</tbody>
</table>

#### Custom 1

- **Description:**
- **Type:** Menu&Transfer
- **Prompt:** Recorded
- **Language:** English
- **Access:** 34
- **Abandon:** 6
- **Average:** 00:32:27

#### Access Counts

- [Key 1]: 8
- [Key 2]: 11
- [Key 3]: 0
- [Key 4]: 0
- [Key 5]: 0
- [Key 6]: 0
- [Key 7]: 0
- [Key 8]: 0
- [Key 9]: 0
- [Key #]: 0
- [Key 0]: 12
- [No Input]: 3

#### Custom 2
2.7.9 Message Status Report

The message status report provides the status of all messages of specified subscribers.

<table>
<thead>
<tr>
<th>Message Status Report</th>
<th>JUL-28-2004 11:30 AM</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Mailbox Range: 245 to 245</td>
<td></td>
</tr>
</tbody>
</table>

**MAILBOX 245 Lisa Ruiz**

### New Messages

<table>
<thead>
<tr>
<th>Message Recording Date</th>
<th>Message Recording Time</th>
<th>Caller ID Number or Mailbox Number</th>
<th>Caller ID Name or Mailbox Last name</th>
<th>Message Length (sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>JUL-27-04</td>
<td>11:15 AM</td>
<td>345</td>
<td></td>
<td>00:00:23</td>
</tr>
<tr>
<td>JUL-27-04</td>
<td>03:23 PM</td>
<td>4457896091</td>
<td>CHRIS JONES</td>
<td>00:01:09</td>
</tr>
</tbody>
</table>

**Total New Messages:** 2

### Saved Messages

<table>
<thead>
<tr>
<th>Message Recording Date</th>
<th>Message Recording Time</th>
<th>Caller ID Number or Mailbox Number</th>
<th>Caller ID Name or Mailbox Last name</th>
<th>Message Length (sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>JUL-12-04</td>
<td>09:42 AM</td>
<td>7986213456</td>
<td>JEFF CHIN</td>
<td>00:00:26</td>
</tr>
<tr>
<td>JUL-19-04</td>
<td>10:24 PM</td>
<td>211</td>
<td></td>
<td>00:00:15</td>
</tr>
</tbody>
</table>

**Total Saved Messages:** 2

### Feature Manual References

2.4.8 System Reports
2.7.10 Subscriber Setup Report

The subscriber setup report displays the basic settings (owner's name, password, personal greeting, etc.) for a specified mailbox or range of mailboxes.

<table>
<thead>
<tr>
<th>Mailbox</th>
<th>Name</th>
<th>Greetings</th>
<th>Owner Name</th>
<th>Password</th>
<th>Last Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>300</td>
<td>ANNE MINOR</td>
<td>---</td>
<td>Recorded</td>
<td>Default</td>
<td>JUL-23-04 10:10 AM</td>
</tr>
<tr>
<td>301</td>
<td>CHRIS JONES</td>
<td>---</td>
<td>-</td>
<td>Default</td>
<td>JUL-21-04 02:24 PM</td>
</tr>
<tr>
<td>302</td>
<td>LISA RUIZ</td>
<td>---</td>
<td>Recorded</td>
<td>Changed</td>
<td>JUL-28-04 08:00 AM</td>
</tr>
</tbody>
</table>

Feature Manual References

2.4.8 System Reports
## 2.7.11 Security Information Report

The security information report displays information about mailbox accesses. The report includes the date of the last change and last access, number of total accesses, login, and failed accesses.

### Security Information Report

For Mailbox Range: 300 to 310

<table>
<thead>
<tr>
<th>Mailbox</th>
<th>Last Change</th>
<th>Last Access</th>
<th>Total Access</th>
<th>Number of Login</th>
<th>Access Failure</th>
<th>Percentage of Failure (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>300</td>
<td>FEB-23-04</td>
<td>JUL-12-04</td>
<td>8</td>
<td>7</td>
<td>1</td>
<td>12.50</td>
</tr>
<tr>
<td>301</td>
<td>MAR-12-04</td>
<td>JUL-21-04</td>
<td>21</td>
<td>18</td>
<td>3</td>
<td>14.29</td>
</tr>
<tr>
<td>302</td>
<td>JUL-01-04</td>
<td>JUL-27-04</td>
<td>32</td>
<td>22</td>
<td>10</td>
<td>31.25</td>
</tr>
<tr>
<td>310</td>
<td>JUL-16-04</td>
<td>JUL-04-04</td>
<td>123</td>
<td>103</td>
<td>20</td>
<td>16.26</td>
</tr>
</tbody>
</table>

### Feature Manual References

2.4.8 System Reports
2.7.12 Hourly Statistics Report

The hourly statistics report displays information about the number of incoming or outgoing calls, the connected time per hour, etc.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time Periods</th>
<th>External Message Delivery</th>
<th>Message Notification Device</th>
<th>Receive</th>
<th>Connect Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>JUL-01-04</td>
<td>09:00 PM</td>
<td>0</td>
<td>1</td>
<td>23</td>
<td>02:10:19</td>
</tr>
<tr>
<td></td>
<td>10:00 PM</td>
<td>1</td>
<td>5</td>
<td>32</td>
<td>03:22:32</td>
</tr>
<tr>
<td></td>
<td>11:00 PM</td>
<td>0</td>
<td>13</td>
<td>28</td>
<td>02:40:03</td>
</tr>
<tr>
<td></td>
<td>12:00 AM</td>
<td>0</td>
<td>3</td>
<td>13</td>
<td>01:56:39</td>
</tr>
<tr>
<td></td>
<td>01:00 AM</td>
<td>1</td>
<td>9</td>
<td>24</td>
<td>02:19:26</td>
</tr>
<tr>
<td></td>
<td>02:00 AM</td>
<td>0</td>
<td>17</td>
<td>22</td>
<td>02:24:41</td>
</tr>
<tr>
<td>JUL-02-04</td>
<td>09:00 AM</td>
<td>0</td>
<td>1</td>
<td>23</td>
<td>02:10:19</td>
</tr>
<tr>
<td></td>
<td>10:00 AM</td>
<td>1</td>
<td>5</td>
<td>32</td>
<td>03:22:32</td>
</tr>
<tr>
<td></td>
<td>11:00 AM</td>
<td>0</td>
<td>13</td>
<td>28</td>
<td>02:40:03</td>
</tr>
</tbody>
</table>

Feature Manual References

2.4.8 System Reports
2.7.13 E-mail Report

The e-mail report displays mailbox numbers, dates, times, message status and addresses to which the VPS sent message waiting notification by e-mail.

<table>
<thead>
<tr>
<th>Mailbox</th>
<th>Date</th>
<th>Time</th>
<th>Message Status</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>310</td>
<td>JUL-01-04</td>
<td>11:15 AM</td>
<td>Move</td>
<td><a href="mailto:johnsmith@abcdefg.com">johnsmith@abcdefg.com</a></td>
</tr>
<tr>
<td>138</td>
<td>JUL-04-04</td>
<td>07:58 PM</td>
<td>Move</td>
<td><a href="mailto:paulparker@abcdefg.com">paulparker@abcdefg.com</a></td>
</tr>
<tr>
<td>120</td>
<td>JUL-15-04</td>
<td>10:23 AM</td>
<td>Copy</td>
<td><a href="mailto:sarah1205@12345.com">sarah1205@12345.com</a></td>
</tr>
</tbody>
</table>

Programming Manual References
2.1.11 E-mail Option

Feature Manual References
2.4.8 System Reports
2.8 System Security

System security settings are divided into the following categories:

- Administrator
- Subscriber

### 2.8.1 Administrator

**Password**

Assigns the password required when connecting to the VPS using KX-TVA Maintenance Console. Follow the steps below to change the password.

1. Click **Click to change password**.
2. Enter a new password in **Enter new password**.
3. Enter the new password in **Confirm new password**.
4. Click **OK**.

**Default**

1234

**Value Range**

Max. 16 digits.

**Feature Manual References**

2.4.9 System Security

**Login Failures before Disconnection**

Specifies the number of times an invalid password can be entered, when the System Manager or Message Manager tries to log in to the VPS using a telephone, before the call is disconnected.
System Manager Access from Telephone

Enables or disables access to the VPS from the System Manager's telephone.

**Note**
- The System Administrator will be asked to set the System Manager's password if both of the following conditions are met:
  a. The System Administrator changes this parameter from "Disable" to "Enable".
  b. The System Manager’s password has not been set previously.
- The password must be entered 2 times for verification.

**Default**
Disable

**Value Range**
Disable, Enable

**Feature Manual References**
2.4.9 System Security

Message Manager Access from Telephone

Enables or disables access to the VPS from the Message Manager’s telephone.
Note

- The System Administrator will be asked to set the Message Manager’s password if both of the following conditions are met:
  a. The System Administrator changes this parameter from "Disable" to "Enable".
  b. The Message Manager’s password has not been set previously.
- The password must be entered twice for verification.

Default
Disable

Value Range
Disable, Enable

Feature Manual References
2.4.9 System Security

Password for Message Manager
If "Enable" is selected in "Message Manager Access from Telephone", assign here a password for the Message Manager to login the VPS. A combination of numbers can be used.
Follow the steps below to change the password.
1. Click Click to change password....
2. Enter a new password in Enter new password:
3. Enter the new password in Confirm new password:
4. Click OK.

Default
None

Value Range
Max. 16 digits

Feature Manual References
2.4.9 System Security
2.8.2 Subscriber

Minimum Password Length

Specifies the minimum length (number of digits) of mailbox passwords.

Default

4

Value Range

0-16 digits

Enable Login Failure Disconnection

Specifies whether the VPS disconnects a call when the subscriber enters an invalid password n times. (n=the value specified under "Login Failures before Disconnection")

Default

Enable

Value Range

Disable, Enable

Login Failures before Disconnection

Specifies the number of times an invalid password can be entered before the VPS disconnects the call. In order to use this feature, "Enable Login Failure Disconnection" must be set to "Enable".

Default

3

Value Range

1–99 times

Default Password for New Mailboxes

Specifies whether the default password is assigned to new mailboxes automatically when they are created.

Default

Disable

Value Range

Disable, Enable

Feature Manual References

2.4.9 System Security
2.8.2.1 Default Password

Specifies the default password assigned to new mailboxes when "Default Password for New Mailboxes" is set to "Enable". There are 2 types of default passwords: select either "Fix digit" or "Prefix (1 or 2 digits) + Mailbox No."

Fix digit (which length is minimum password length)

Specifies the fixed password, which digit is minimum length. A combination of numbers can be used.

Default
1111

Value Range
Max. 16 digits

Prefix (1 or 2 digits) + Mailbox No.

Specifies the default password for new mailboxes as a combination of fixed digits (1 or 2 digits) and the mailbox number.

Default
55 + Mailbox No.

Value Range
1 digit: 0–9 + Mailbox No.
2 digits: 00–99 + Mailbox No.
Index
Symbols

"O'clock" Prompt 150
# Announcement Mode 150

A
Active 62, 64
Additional Digit 182
Additional Digits 182
Administrator 208
Advanced Settings 186
Afternoon Hours Start Time 146
All Calls Transfer to Mailbox 50
Alternate DNS Server 37
Alternate Extension 112
Alternate Extension Transfer Sequence 153
Alternate Fax Extension No. 173
Announce Message Transferred Information 90
Announce Option Menu After Erasing Messages 90
Announcement Repeat Cycle 170
Answer 158
Attach Voice File 77
Auto Forwarding 64
Auto Receipt 89
Automated Attendant 107
Automatic Login 73
Automatic Transfer of Incoming Fax Call 172
Autoplay New Message 89

B
Beeper Callback No. Entry Mode 55
Busy 158
Busy Coverage Mode 110
Busy Delay 167
Busy Delay Time 58

C
Call Account Report 196
Call Handling Statistics Report 201
Call Hold Mode 111
Call Progress Tone Detection for Inband Mode 191
Call Queuing Announcement Mode 111
Call Retrieval Announcement Timing 111
Call Service 94
Call Service for Day, Night, Lunch, and Break 94
Call Transfer Anytime 124
Call Transfer for Day, Night, Lunch, and Break service 101
Call Transfer No Answer Time 161
Call Transfer Sequence 51
Call Transfer Status 52
Call Transfer to Outside 91
Call Transfer to Outside Answer Mode 179
Call Transfer to Outside Reconnect Sequence on Busy 177
Call Transfer to Outside Reconnect Sequence on No Answer 177
Call Transfer to Outside Sequence 177
Call Waiting Sequence 156
Callback No. Entry Interdigit Time-out 165
Caller ID 1, Caller ID 2 73
Caller ID Callback 88, 180
Caller ID No./DID No./PIN No. 100
Caller ID Number Announcement 90
Caller ID Screen 88
Caller ID/DID Call Routing 96
Caller ID/DID/PIN Call Routing 97
Caller Recorded Name Announcement Mode 171
Caller-ID Modify Table No.1–4 181
Caller-ID No. 141
Changing the Mailbox No. Length Mode 34
Changing the Maximum Length of Mailbox Numbers 34
Class of Service 49, 79, 80
Class of Service Name 80
Company Greeting No. 94, 105
Company Telephone No. 168
Confirmation 159
Connect 17
Connect—Connection Profile 17
Connect—Dial-up (Modern) 17
Connect—Disconnect 18
Connect—LAN (TCP/IP) (Optional for KX-TVA50) 17
Connect—USB 17
Covering Extension 49
CPC Signal 189
Custom Service 117
Custom Service Builder 117
Custom Service Report 202

D
Daily Hours Setting 145
Date Control 127
Day Control 129
Daylight Saving Time 146
Default Gateway 37
Default Mailbox Template 45
Default Password 212
Default Password for New Mailboxes 211
Delay After Dialing Before Analysis 190
Delay After Dialing Before On-hook 191
Delay Time 65
Delay Time After Connected Received for Incoming 149
Delay Time After Connected Received for Outgoing 149
Delayed Answer Time 95
Delayed Answer Time for New Message 115
Delayed Answer Time for No New Messages 115
Delete Message Confirmation 87
Device Interval Time between Device1 and Next Device 60
Device Interval Time between Device2 and Next Device 60
Device Interval Time between Device3 and Next Device 60
Device Notification for Unreceived Message 55
Device Notification Timer 59
Device Start Delay Time 60
Dial Number 57
Dial Start Mode 190
Dialing Parameters 161
DID 74
Digit Translation Table 160
Directory Listing 68
Disconnect 159
Disconnect Parameters 175
Disconnect Time 190
DND 158
DTMF 148

214 Programming Manual Document Version 3.0 2010/06
DTMF Cut Length 191

E
Edit 19
Edit—Copy 19
Edit—Cut 19
Edit—Delete 20
Edit—Paste 19
Edit—Select All 19
Edit—Undo 19
EFA Transfer 180
EFA Transfer Reconnect Sequence on Busy 178
EFA Transfer Reconnect Sequence on No Answer 179
EFA Transfer Sequence 178
E-mail Address 77
E-mail Integration 184, 185
E-mail Option 76
E-mail Report 207
E-mail Schedule 77
Enable Login Failure Disconnection 211
End Date 104
End Time 104
Entry Failure 131
Evening Hours Start Time 146
Extension 47, 73
Extension Group 137
Extension Number of VPS Port 152
Extension Transfer Sequence 153
External Message Delivery 62, 166

F
Fax Call Report 200
Fax Management 172
Fax Manager Mailbox No. 174
Fax No Answer Coverage Mode 174
Fax No Answer Time 173
Fax Notification Mode 174
File 15
File—Close 15
File—Exit 16
File—New 15
File—Open... 15
File—Save 16
File—Save As... 16
First Name 47
First Playback Urgent Messages 90
Fix digit (which length is minimum password length) 212
Flash Time 189
Format 145
Forward to Other Extension 159
Forward to VM Busy 159
Forward to VM Ringing 159
Forwarding Mode 65
Full Name 185

G
Global Parameters 189
Go To 23
Go To—Class Of Service 23
Go To—H/W Settings 24
Go To—Mailbox Settings 23

Index

Go To—PORT/TRUNK Service 23
Go To—Reports 24
Go To—Service Settings 23
Go To—System Parameters 23
Go To—System Security 24
Group List No. 136, 139
Group Name 136, 139

H
Hardware (H/W) Settings 189
HDD Auto Stand-by Delay Time 32
HDD Auto Stand-by Mode 32
HDD Usage Report 198
Hold Recall Mode 112
Holiday Service No. 103
Holiday Settings 102
Hourly Statistics Report 206

I
Ignore Received First DTMF 179
Inband Signaling 157
Incoming Call Service 94
Incoming Call Service Prompt 95
Incomplete Call Handling for Busy 53
Incomplete Call Handling for No Answer 52
Input Digit/Output Digit 160
Installing KX-TVA Maintenance Console 10
Integration Mode 152
Intercom Paging Group 82
Intercom Paging Parameters 169
Intercom Paging Retry 171
Intercom Paging Sequence 169
Inter-Digit Timeout 160
Interview Mailbox 50
Introduction to System Administration 8
IP Address 36

K
Key Mode 115
Keypad Assignment 0–9, *, # 126
KX-TVA Maintenance Console Installation 9

L
Language 148
Language 1–5 (KX-TVA200), 1–3 (KX-TVA50) 148
Last Name 47
Light-Off Sequence for Message Waiting Lamp 155
Light-On Sequence for Message Waiting Lamp 155
List All Names 113
List Members 66
List Name 66
List No. 1–List No. 4 66
Local Area / International Call Code 181
Local Area Code/International Code 181
Login Failures before Disconnection 208, 211
Long Distance Call 182

M
Mail Address 185
Index

R
Receiving Caller ID    157
Reconnect Sequence on Busy    154
Reconnect Sequence on No Answer    154
Reconnect Sequence on Refuse Call    154
Redial Cancel Timing    112
Release for Intercom Paging    170
Release Sequence for Call Waiting    157
Remote Call Forward to CO    86
Remote Call FWD To CO    71
Remove Digit    182
Remove Digits    181
Reorder    158
Report Data Clear    192
Reports    192
Retain Holiday    105
Retry Times    166
Ringback    157
Rotary Telephone Call Coverage for Day, Night, Lunch, and Break service    114
Rotary Telephone Service    113

S
Saved Message Retention Time    82
Security Information Report    205
Select Language    150
Selection Menu Repeat Cycle    149
Selection Menu Wait Time    148
Send E-mail with New Messages    77
Service    105
Service Group    92
Service Mode    93
Service Settings    97
SMTP Authentication    186
SMTP Authentication Password    187
SMTP Authentication Username    187
SMTP Over SSL    187
SMTP Server Address (Name)    185
SMTP Server Port    186
Standard Buttons    14
Start Date    103
Start Time    104
Starting KX-TVA Maintenance Console    11
Subnet Mask    36
Subscriber    211
Subscriber Setup Report    204
Sunday–Saturday, Holiday    129
System Callback No.    165
System Caller Name Announcement    140
System Clock    144
System Date/Time    144
System External Message Delivery Duration Time    168
System Guidance    149
System Maintenance Mode    31
System Maintenance Start Time    31
System Manager Access from Telephone    209
System Parameters    133
System Requirements    9
System Security    208

T
Telephone Number 1, Telephone Number 2    71
Time Control    128
Time Frame    96
Time Frame 1, 2 (MON–SUN)    59
Time Setting    144
To connect using a Connection Profile    17
To connect using a LAN    17
To connect using a modem    18
To connect using USB    17
To copy    19
To create a new system data file    15
To cut    19
To delete    20
To disconnect    18
To exit KX-TVA Maintenance Console    16
To hide/show the menu bar    22
To hide/show the shortcut bar    21
To hide/show the status bar    21
To hide/show the toolbar    21
To hide/show the utility bar    21
To open a system data file    15
To paste    19
To save a system data file    16
To save a system data file with a new name    16
To select all    19
To undo    19
Toll Saver    75, 115
Total Number of Message Announcement    84
Transfer to Outside    176
Translation Table 1–8    160
Trunk    74
Trunk Affected    106
Trunk Group    180
Tutorial    89
TVA Device Port No.    37
Two-way Recording Save Mode    35
Type of Device    57

U
Use Call Waiting on Busy    86
Use Caller-ID Modify Table No.    181
Use Mode    59
Use the following DNS server addresses:    37
Use the following IP address:    36
Username    76
Utility    25
Utility—Commands    34
Utility—Default Parameters    38
Utility—Diagnostic    33
Utility—LAN Settings    35
Utility—Port Status    30
Utility—Profile Setup    38
Utility—Programmer Code    33
Utility—Quick Setup    25
Utility—Screen Customize    33
Utility—Software Version    35
Utility—System Back Up    26
Utility—System Initialize/Restart    32
Utility—System Maintenance    31
Utility—System Prompts Customization    28
Utility—System Trace    30

Document Version 3.0 2010/06
Index

V
View 21
View—Menu Bar 21
View—Shortcut Bar 21
View—Status Bar 21
View—Toolbar 21
View—Utility Bar 21
VM Menu 85, 183

W
Wait for First Digit 125, 130
Wait for Second Digit 125
Wait Time for First Digit 107
Waiting Time for Receiving Caller ID 157